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ΠΕΡΙΛΗΨΗ 

Αντικείμενο της παρούσας μεταπτυχιακής εργασίας είναι η διερεύνηση της αλληλεπίδρασης φυσικών 
παραγόντων στο παράκτιο σύστημα των εκβολών του ποταμού Αράχθου, η ροή του οποίου 
καθορίζεται από το υδροηλεκτρικό φράγμα που λειτουργεί στα ανάντη.  

Σε πρώτο στάδιο μελετήθηκε η μεταφοράς ιζημάτων κατά μήκος του ποταμού Αράχθου, από το 
υδροηλεκτρικό φράγμα Πουρνάρι ΙΙ έως και τις εκβολές του ποταμού στον Αμβρακικό κόλπο, για την 
οποία χρησιμοποιήθηκε το λογισμικό πακέτο λογισμικού το HEC RAS (Hydrologic Engineering Centers 
River Analysis System) του US Army Corps of Engineers. 

Για τον υπολογισμό της στερεομεταφοράς κατά μήκος του ποταμού, έπρεπε να οριστούν η γεωμετρία 
(άξονας και διατομές) του ποταμού, οι συνθήκες ροής στον ποταμό (εισήχθηκε η χρονοϊστορία 
παροχής ποταμού για το ημερολογιακό έτος 2009) και η κοκκομετρία του υλικού του πυθμένα του 
ποταμού. 

Το αποτέλεσμα της προσομοίωσης μεταφοράς ιζημάτων στις εκβολές του ποταμού χρησιμοποιήθηκε 
ως το βασικό δεδομένο εισόδου για την διερεύνηση της κίνησης των ιζημάτων της παράκτιας ζώνης, η 
οποία καθορίζεται τόσο από τη ροή του ποταμού όσο και από τις ανεμολογικές και κυματικές συνθήκες 
στην περιοχή. Για το δεύτερο στάδιο, την προσομοίωση της παράκτιας ζώνης και των φυσικών 
διεργασιών που τη χαρακτηρίζουν, χρησιμοποιήθηκε το ΜΙΚΕ software της DHI. 

Για την εκτίμηση της παράκτιας ιζηματομεταφοράς στην εγγύτερη περιοχή των εκβολών του 
Αμβρακικού κόλπου ορίστηκε η βυθομετρία της περιοχής και οι ανεμογενείς κυματισμοί που δρουν 
στην περιοχή, ενώ λήφθηκε υπόψη και η παροχή του ποταμού στις εκβολές του.  

Λόγω των χρονικών περιορισμών που εισάγει η υπολογιστική ταχύτητα του προγράμματος MIKE21, 
αντί του ενός ημερολογιακού έτους, προσομοιώθηκαν κυματικά γεγονότα των οποίων η δράση ανά 
διεύθυνση προώθησης αντιστοιχεί στη συνολική δράση μέσα σε ένα έτος.  

Τα αποτελέσματα από τα δυο στάδια παρουσιάζονται σε μορφή Γραφημάτων και Πινάκων ενώ 
ακολουθεί σχολιασμός τους ώστε να αποτιμηθεί τελικά η ολική συνεισφορά του ποταμού Αράχθου 
στην παράκτια στερεομεταφορά στα παράλια του Δέλτα στον Αμβρακικό Κόλπο.  
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ABSTRACT 

Scope 

The scope of this thesis is to investigate the interaction of natural and anthropogenic factors on the 
coastal system estuary of Arachtos river, located in Epiros, Greece, the flow of which is determined by 
the hydroelectric dam operating upstream of the river. 

Arachtos river 

Arachtos river is the greatest river of Epiros with a total length of 105km and a basin covering a total 
area of 1850km2. The river axis is oriented from North to South, discharging at the northern coast of 
Amvrakikos Gulf. Before the esturay, the river runs through farmlands, thus the water is used for 
irrigation and hydroelectric power production through an artificial lake and two dams, Pournari I (1981) 
and Pournari II (1998/9). The average discharge flow of Arachtos is estimated around 70-60 m3 / s, but 
the flow fluctuations are enormous, varying from flow absence to torrential flow, due to the operation 
of the dam. 

Study Approach 

The course of the present study follows two main steps: 

• Investigation of the sediment transport along the river Arachthos from Pournari II hydroelectric 
dam up the estuary of the river in Abvrakikos gulf. 

• Investigating the coastal sediment transport offered through the river flow and sediment 
bottoms of the coastal zone, which is determined both by the flow of the river and the wind and 
wave conditions in the region. 

Sediment Transport along Arachtos river – Application of HEC RAS software 

The first stage is the estimation of the total sediment transport along the river Arachtos from the 
Hydroelectricdam located upstream of the river up to the estuary of the river, formed at the northern 
coast of Amvrakikos gulf. The package software HEC RAS (Hydrologic Engineering Centers River Analysis 
System) of US Army Corps of Engineers was used in order to assess the hydrological and sediment flow 
conditions along the river. 

To calculate the sediment transport along the river, with total simulated length of 105km, the following 
properties had to be defined: geometric properties (longitudinal axis and cross sections) of the river, the 
flow properties (the river discharge flow rates were provide for the calendar year 2009) and the 
sediment properties (namely the grain size of the material of the river bed). 
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Coastal Sediment Transport – Application of MIKE software by DHI 

The result of the simulation of sediment transport at a cross section by the river estuary was used as the 
basic input data for the investigation of sediment transport at the coastal zone. Coastal sediment 
transport is determined both by the flow of the river and the wind generated waves. The simulation of 
the coastal zone hydrodynamic processes is carried out using the MIKE software by DHI. 

In order to assess the coastal sediment transport in the vicinity of the estuary of river Arachtos, at the 
Amvrakikos Gulf, the following model properties had to be defined: the bathymetry of the selected area 
to be simulated, the wind generated waves developed within that area and the seabed material 
properties (mean grain size). The inflow of river Arachtos was also incorporated in the model simulation. 

Results and Conclusions 

The results of the two different simulations are presented in the form of graphs and tables. Furthermore 
the results are evaluated and compared to relevant references in order to estimate the total 
contribution of the Arachtos river to the estuary at the coast of Amvrakikos gulf.  

The results of the present thesis comply with the references found in various sources: the turn of the 
river estuary to the East, due to the high-energy West waves, and the minimized sediment offer of the 
river, due to the consruction of the dam. 
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1. ΕΙΣΑΓΩΓΗ 

1.1 Γενικά 

Η ακτή και η παράκτια ζώνη αποτελούν ένα πολύπλοκο φυσικό σύστημα που δέχεται τις 
αλληλεπιδράσεις των παραγόντων και των φυσικών διεργασιών της ξηράς, της θάλασσας και της 
ατμόσφαιρας.  

Χαρακτηριστικό παράδειγμα αλληλεπίδρασης φυσικών αλλά και ανθρωπογενών παραγόντων στην 
φυσική διαδικασία μετακίνησης των ιζημάτων και σχηματισμού/ μετασχηματισμού των ακτών 
αποτελούν οι εκβολές υδατορεμάτων στη θάλασσα. Η αλληλεπίδραση, ειδικά όταν υπεισέρχεται και ο 
ανθρώπινος παράγοντας, με τη μορφή της ρύθμισης μιας βασικής παραμέτρου όπως η παροχή του 
υδατορέματος (με τη κατασκευή και λειτουργία ενός φράγματος), γίνεται ακόμα πιο πολύπλοκη. 

1.2 Αντικείμενο Εργασίας 

Αντικείμενο της παρούσας μεταπτυχιακής εργασίας είναι ακριβώς η διερεύνηση της αλληλεπίδρασης 
φυσικών και ανθρωπογενών παραγόντων στο παράκτιο σύστημα των εκβολών του ποταμού Αράχθου, 
η ροή του οποίου καθορίζεται από το υδροηλεκτρικό φράγμα που λειτουργεί στα ανάντη.  

Η πορεία εξέλιξης της παρούσης εργασίας ακολουθεί δυο βασικά στάδια: 

 Τη διερεύνηση της μεταφοράς ιζημάτων κατά μήκος του ποταμού Αράχθου, από το 
υδροηλεκτρικό φράγμα Πουρνάρι ΙΙ έως και τις εκβολές του ποταμού στον Αμβρακικό κόλπο. 

 Τη διερεύνηση τη παράκτιας μεταφοράς των ιζημάτων που προσφέρονται διαμέσου της ροής 
του ποταμού αλλά και των ιζημάτων του πυθμένα της παράκτιας ζώνης, η οποία καθορίζεται 
τόσο από τη ροή του ποταμού όσο και από τις ανεμολογικές και κυματικές συνθήκες στην 
περιοχή. 

Για την εκπόνηση της παρούσης μεταπτυχιακής εργασίας χρησιμοποιήθηκαν δυο σύγχρονα 
υπολογιστικά εργαλεία της υδραυλικής και θαλάσσιας υδροδυναμικής μηχανικής, το HEC RAS 
(Hydrologic Engineering Centers River Analysis System) του US Army Corps of Engineers για το πρώτο 
στάδιο διερεύνησης και το ΜΙΚΕ software της DHI, για το δεύτερο στάδιο, την προσομοίωση της 
παράκτιας ζώνης.  
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2. Ο ΠΟΤΑΜΟΣ ΆΡΑΧΘΟΣ 

2.1 Γενικά 

Ο ποταμός Άραχθος είναι ο μεγαλύτερος ποταμός της Ηπείρου και αποτελεί σημαντικότατο κομμάτι 
του αντίστοιχου υδρολογικού διαμερίσματος. Πηγάζει από τη Βόρεια Πίνδο, σε υψόμετρο περί τα 
1700m και η κοίτη του διαμορφώνεται με προσανατολισμό από Βορράν προς Νότο εκβάλλοντας τελικά 
στα βόρεια παράλια του Αμβρακικού κόλπου. Η λεκάνη απορροής του Αράχθου έχει έκταση 1850km2 
και η κύρια κοίτη του μήκος περί τα 105km. Πριν την εκβολή του διατρέχει πεδινές καλλιεργήσιμες 
εκτάσεις, ενώ τα νερά του χρησιμοποιούνται για άρδευση και για παραγωγή υδροηλεκτρική ενέργειας 
μέσω της τεχνητής Λίμνης Πουρναρίου και των φραγμάτων Πουρνάρι Ι και ΙΙ. 

Η μέση ετήσια παροχή του Άραχθου 
εκτιμάται περί τα 70-60 m3/s αλλά οι 
διακυμάνσεις στην παροχή του είναι 
τεράστιες από απουσία ροής μέχρι 
χειμαρρώδη ροή. Ειδικότερα στο τμήμα 
του κατάντη του φράγματος στο Πουρνάρι, 
έχουμε συνήθως ασυνέχεια στη ροή του 
ποταμού, καθότι αυτή καθορίζεται από τη 
λειτουργία του φράγματος. Όταν το νερό 
ρέει από το φράγμα, είτε λόγω της 
λειτουργίας του υδροηλεκτρικού σταθμού 
είτε λόγω της άρδευσης των καλλιεργειών, 
έχουμε σημαντική αύξηση της ροής, ενώ 
αντίθετα όταν η παροχή διακόπτεται, 
έχουμε σημαντική πτώση ή απουσία ροής 
με αποτέλεσμα την εισροή θαλασσινού 
νερού βαθειά στην κοίτη του ποταμού. 

2.2 Θέση 

Ο Άραχθος στην αρχή διερχόμενος νότια 
του Μετσόβου ονομάζεται Μετσοβίτικος, 
ενώ το όνομα Άραχθος το παίρνει μετά 
από τη συνάντησή του με τον ποταμό 
Διπόταμο. Τροφοδοτείται από τους 
παραπόταμους Καλεντίνη, Λοζίτσι, 
Μετσοβίτικο, Διπόταμο ή Ζαγορίσιο και 
Καλλαρίτικο.  

 

 
Εικόνα 2-1: Χάρτης των λεκάνων απορροής και των 

παραπόταμων Λούρου και Αράχθου 

 

   10 από 128 



Εκτίμηση της Στερεοπαροχής Κατά Μήκος του Ποταμού Αράχθου και των Επιπτώσεων στην Παράκτια Ζώνη 
 
Από τις πηγές του στην Πίνδο έως την εκβολή του στον Αμβρακικό κόλπο, ρέει διαμέσου περιοχών με 
έντονα διαφορετικά γεωμορφολογικά χαρακτηριστικά, βάση των οποίων μπορεί να διαχωριστεί σε 
τρια τμήματα: το άνω, από τις πηγές του έως τη συμβολή με τον Καλλαρίτικο (υψόμετρα από 1700m 
έως 1000m) με απότομες κλίσεις πρανών και στενή κοίτη ποταμού, το μεσαίο, έως και την τεχνητή 
Λίμνη Πουρναρίου στην Άρτα (υψόμετρα από 1000m έως 100m στο φράγμα) με ηπιότερες πλευρικές 
κλίσεις και μεγαλύτερο πλάτος πυθμένα και το κατώτερο πεδινό τμήμα του, από την Άρτα έως και τις 
εκβολές του στον Αμβρακικό κόλπο, όπου και διέρχεται από την πεδιάδα της Άρτας.  

Το τρίτο, πεδινό, τμήμα του είναι και που ενδιαφέρει για την εκτίμηση της ποσότητας μεταφερόμενων 
ιζημάτων από τον ποταμό στον Αμβρακικό κόλπο, καθότι η στερεοπαροχή των ανάντη τμημάτων 
συγκρατείται στη τεχνητή Λίμνη Πουρναρίου. 

2.3 Υδροηλεκτρικά Έργα 

Όπως προαναφέρθηκε, τα ύδατα του ποταμού Αράχθου χρησιμοποιούνται για την παραγωγή 
ηλεκτρικής ενέργειας από δυο υδροηλεκτρικούς σταθμούς - φράγματα της ΔΕΗ, το Πουρνάρι Ι και το 
Πουρνάρι ΙΙ, τα οποία χωροθετούνται εν συνεχεία κατάντη της τεχνητής λίμνης (ταμιευτήρας) του 
Πουρναρίου που έχει σχηματιστεί βόρεια της πόλης της Άρτας. 

Χαρακτηριστικά Φράγματος 
Πουρνάρι Ι  

 

Θέση: Ήπειρος, Ν. 
Άρτας 

Σκοπός: Y/H, άρδευση, 
αντιπλημμυρική 
προστασία 

Έναρξη εμπ. 
λειτ.: 

1981 

Εγκατ. Ισχύς: 300 ΜW (3x100)  
Μέση ετ. 
παρ.: 

235 GWH 

Φράγμα: Χωμάτινο h=87m 
Ωφ. χωρ. 
ταμ.: 

303m.c.m. 

Πίνακας 2-1: Χαρακτηριστικά Υ/Η σταθμού Πουρνάρι Ι (Αργυράκης Ι., φωτογραφία από panoramio.com) 

Το Υ/Η φράγμα Πουρνάρι Ι δημιουργήθηκε το 1981, 4.5km βορειοανατολικά της Άρτας, έχοντας 
πολλαπλή σκοπιμότητας καθώς πέραν της παραγωγής ηλεκτρικής ενέργειας αξιοποιείται και αρδευτικά 
και υδρευτικά ενώ παρέχει και αντιπλημμυρική προστασία.  

Η κατασκευή και η λειτουργία του έχει μεταβάλλει τη φυσιογνωμία και την εξέλιξη των 
υδρογεωμορφολογικών διεργασιών της λεκάνης του ποταμού Αράχθου, ιδιαίτερα στην περιοχή 
κατάντη του φράγματος, στο δέλτα και τις εκβολές του ποταμού. Οι μεταβολές και οι αλλοιώσεις που 
παρατηρούνται στη μορφολογία του ποταμού και του Δέλτα αποδίδονται κατά κύριο λόγο στη 
συγκράτηση των νερών και των φερτών υλών στο ταμιευτήρα Πουρνάρι Ι.  
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Χαρακτηριστικά Φράγματος 
Πουρνάρι ΙI  

 

 
Θέση: 

 
Ήπειρος, Ν. 
Άρτας 

Σκοπός: Y/H, άρδευση  
Έναρξη εμπ. 
λειτ.: 

1998/9 

Εγκατ. Ισχύς: 33.6 ΜW  
Μέση ετ. 
παρ.: 

45 GWH 

Φράγμα: Χωμάτινο h=15m 
Ωφ. χωρ. 
ταμ.: 

4m.c.m. 

Πίνακας 2-2: Χαρακτηριστικά Υ/Η σταθμού Πουρνάρι ΙΙ (φωτογραφία από προσωπικό αρχείο) 

Το Πουρνάρι ΙΙ κατασκευάστηκε κατάντη του Υ/Σ Πουρνάρι Ι ως αναρρυθμιστικό φράγμα, και τέθηκε σε 
λειτουργία το 1998/9. Το μέγεθός του είναι κατά πολύ μικρότερο του Πουρναρίου ΙΙ και σαν κατασκευή 
και σε μονάδες παραγόμενης ισχύς, όπως φαίνεται και από σύγκριση των χαρακτηριστικών που 
παρουσιάζονται στους Πίνακας 2-1 και Πίνακας 2-2. Χαρακτηριστικό του σταθμού είναι ότι τα τρία 
θυροφράγματα του εκχειλιστή του έχουν δυνατότητα εκφόρτισης 6000m3/sec (Λέρης Γ.). 

2.4 Προσχωματική ικανότητα  

Στην ευρύτερη περιοχή του Αμβρακικού κόλπου δεν υπάρχουν, με εξαίρεση τον Άραχθο και τον Λούρο 
που εκφορτίζουν στον Αμβρακικό 2500x106 m3 ύδατος ετησίως, υδατορεύματα συνεχούς ροής αλλά 
μόνο υδατορεύματα που λειτουργούν περιστασιακά κατά τους ομβροφόρους μήνες (Ειδική 
περιβαλλοντική μελέτη της προστατευόμενης περιοχής του Αμβρακικού- ΥΠΕΧΩΔΕ 2004). Όπως 
αναφέρθηκε η λεκάνη απορροής του Αράχθου έχει έκταση 1.850 km2 και η κύρια κοίτη του έχει μήκος 
105 km, ενώ η λεκάνη απορροής του Λούρου καταλαμβάνει έκταση 685 km2 και το μήκος της κύριας 
κοίτης του είναι 73 km.  

Η προσχωματική ικανότητα του Αράχθου είναι πολύ μεγαλύτερη αυτής του Λούρου, καθώς η λεκάνη 
απορροής του είναι μεγαλύτερη και αποτελείται κατά το μεγαλύτερο μέρος από αδιαπέρατο από τα 
νερά της βροχής ψαμμιτικό φλύσχη και εύκολα διαβρούμενο, ενώ αυτή του Λούρου είναι 
ασβεστολιθική, ενώ και τα νερά του δεύτερου ρέουν με μεγαλύτερες ταχύτητες, επιτρέποντας στον 
ποταμό να μεταφέρει μεγαλύτερων διαστάσεων ιζηματογενές υλικό και να το αποθέτει βαθύτερα στον 
Αμβρακικό κόλπο. Διαβρωσιγενείς είναι και οι όχθες του ποταμού στο κάτω τμήμα του μετά το φράγμα 
στο Πουρνάρι, στην πεδιάδα της Άρτας (Βρυνιώτης Δ. & Παπαδόπουλος Κ. 2004). 

Αποτέλεσμα αυτών είναι ο Άραχθος να έχει αναπτυγμένο δελταϊκό πεδίο σε αντίθεση με αυτό του 
Λούρου και να είναι ο κύριος υπεύθυνος της δημιουργίας της πεδιάδας της Άρτας (Ε.Κ.Θ.Ε., 1989) και 
να αποτελεί αναπόσπαστο κομμάτι του οικοσυστήματος του Αμβρακικού κόλπου. 
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2.5 Το Δέλτα 

Το δέλτα σχηματίζεται από συσσώρευση ιζημάτων εκεί όπου ο ποταμός συναντάει τη θάλασσα. Ο 
όγκος των ιζημάτων που δημιουργούν το δέλτα και η έκταση που αυτό καταλαμβάνει εξαρτώνται από 
τη δυνατότητα του ποταμού να διαθέσει ίζημα (προσχωσιματική ικανότητα) και από την ικανότητα των 
παράκτιων διεργασιών (ρεύματα, κύματα) να μεταφέρουν το ίζημα.  

 

Εικόνα 2-2: Αεροφωτογραφία της περιοχής του Δέλτα του ποταμού Αράχθου (Πηγή: airphotos.gr) 

Το Δέλτα του ποταμού Αράχθου έχει σχήμα επίμηκες, χαρακτηριστικό της ποτάμιας δράσης. Η 
παλίρροια και η κυματική δράση (λόγω του κλειστού κόλπου) έχουν μικρή επιρροή στη διαμόρφωσή 
του, δεδομένης και της μεγάλης προσχωματικής ικανότητας του Αράχθου. Οι νότιοι και 
νοτιοανατολικοί άνεμοι που πνέουν στην περιοχή δεν φαίνονται ικανοί να αναχαιτίσουν την ανάπτυξη 
του δέλτα, ενώ οι νοτιοδυτικοί το αναγκάζουν να στραφεί προς τα ανατολικά (Τζιαβός 1996). 

Λιθολογία της Λεκάνης Απορροής 
Κλαστικά ιζήματα (φλύσχης, αλλούβια)  78.2 % 
Ανθρακικά πετρώματα 19.3 % 
Μεταμορφωμένα πετρώματα 0.7 % 
Πυριγενή πετρώματα 1.8 % 
Πίνακας 2-3: Λιθολογία της λεκάνης απορροής του Άραχθου ποταμού (Poulos S. 2005) 

2.6 Σύγχρονη ιζηματογένεση 

Στα τέλη της δεκαετίας του 1930, όταν έγινε διευθέτηση και ευθυγράμμιση της κατώτερης κοίτης του 
Άραχθου ποταμού, ο σημερινός δελταικός λοβός άρχισε να αναπτύσσεται προς τα νοτιοανατολικά με 
ταχύ ρυθμό. Η παλιά εκβολή βρισκόταν 1 περίπου χιλιόμετρο νοτιοδυτικά της σημερινής, όπως 
μαρτυρούν οι εγκαταλελειμμένοι μαίανδροι. Από τη διάνοιξη του νέου διαύλου μέχρι το 1945, το δέλτα 
εισχώρησε ταχύτατα στη θάλασσα, κατά 2km τουλάχιστον. 

Από το 1945 έως και το 1960, οι προσχώσεις επεκτάθηκαν περαιτέρω, ενώ κοντά στον παλιό δίαυλο η 
ακτογραμμή υποχωρεί περί τα 2km. 
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Οι μεταβολές στην ακτογραμμή (διάβρωση ή απόθεση) είναι πολύ σημαντικές κατά την περίοδο 1945-
1971, ενώ είναι σαφώς μικρότερες την περίοδο 1971-1981.Παραδειγματικά αναφέρεται ότι η νέα 
εκβολή του Αράχθου προελαύνει κατά 2km την περίοδο 1945-1981 και μόνο 200m την δεκαετία 1971-
1981 (Τσαρμός 1995). 

Ο Άραχθος σήμερα έχει αλλάξει πορεία προς τα ανατολικά και οι εκβολές του βρίσκονται ανατολικά 
του Φιδόκαστρου. Το τελευταίο διάστημα (1987-1999) χαρακτηρίζεται από καθολική υποχώρηση της 
ακτογραμμής στην περιοχή γύρω από τον παλαιό και νέο δίαυλο, λόγω έλλειψης παροχών ιζήματος και 
επικράτησης των θαλάσσιων διεργασιών (Καψιμάλης et al. 2003). Με τη στροφή του δέλτα προς τα 
ανατολικά, η ακτή λόγω αποστέρησης ιζήματος άρχισε να παρουσιάζει διαβρωτικά φαινόμενα 
(υποχώρηση των νησίδων άμμου και σπάσιμο αυτών σε ασθενή σημεία, αύξηση βάθους 
λιμνοθαλασσών).  

 

Εικόνα 2-3: Σύγκριση ακτογραμμής για τρεις διαφορετικές χρονικές περιόδους (κόκκινη γραμμή – ακτογραμμή 
το 1960, μπλε γραμμή – ακτογραμμή το 1985, κίτρινη γραμμή – ακτογραμμή το 1996) (Μιμίκου 2005) 

2.7 Στοιχεία περιοχής μελέτης  

Για την ορθότερη αποτίμηση της αλληλεπίδρασης των μηχανισμών πρόσχωσης λόγω του ποταμού 
Αράχθου και των περιβαλλοντικών μηχανισμών (ρεύματα – κύματα) στην παρούσα εργασία λήφθηκαν 
υπόψη: 

• Τοπογραφική αποτύπωση της περιοχής όδευσης του κατώτερου τμήματος του ποταμού 
Αράχθου καθώς και εγκάρσιες τομές στην κοίτη του ποταμού (από τα σχέδια του έργου 
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«Οριστική μελέτη αντιπλημμυρικών έργων του π. Αράχθου κατάντη των έργων αναρρυθμίσεως 
των παροχών του ΥΗΣ Πουρναρίου 1984) 

• Βυθομετρία του ευρύτερου Αμβρακικού κόλπου, όπως αυτή παρουσιάζεται στην ακόλουθη 
εικόνα (πηγή: garmin)  

• Μετεωρολογικά στοιχεία & παλιρροϊκά στοιχεία που ελήφθησαν από τον πλησιέστερο σταθμό 
της Εθνικής Μετεωρολογικής Υπηρεσίας και το σταθμό Πρεβέζης αντίστοιχα 

• Κοκκομετρία των ιζημάτων του ποταμού, κατάντη του φράγματος Πουρναρίου. 

Τα στοιχεία που χρησιμοποιήθηκαν παρουσιάζονται ακολούθως.  

2.7.1 Βαθυμετρία Αμβρακικού Κόλπου 

Για την βυθομετρία του Αμβρακικού κόλπου ευρέθησαν δυο χάρτες, από την Υδρογραφική υπηρεσία 
Ελληνικού Ναυτικού και το σύστημα Garmin MapSource, το οποία παρέχει στοιχεία βυθομετρίας σε 
παγκόσμια κλίμακα. 

 
Εικόνα 2-4: Ευρύτερη περιοχή – Αμβρακικός Κόλπος (Πηγή: Υδρογραφική υπηρεσία Ελληνικού Ναυτικού) 
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Εικόνα 2-5: Βυθομετρία Αμβρακικού Κόλπου (Πηγή: Garmin MapSource) 

 

Εικόνα 2-6: Βυθομετρία στην περιοχή εκβολής του ποταμού Αράχθου στον Αμβρακικό Κόλπο (Πηγή: Garmin 
MapSource) 

   16 από 128 



Εκτίμηση της Στερεοπαροχής Κατά Μήκος του Ποταμού Αράχθου και των Επιπτώσεων στην Παράκτια Ζώνη 
 
Λόγω της μεγαλύτερης ακρίβειας των βυθομετρικών στοιχείων στους χάρτες του Garmin, επιλέχθηκαν 
αυτοί για την εξαγωγή στοιχείων για τη βυθομετρία της περιοχής.  

2.7.2 Μετεωρολογικά στοιχεία.  

Τα μετεωρολογικά στοιχεία (ταχύτητα και διεύθυνση ανέμου), που χρησιμοποιήθηκαν στην παρούσα 
διπλωματική εργασία, προέρχονται από τις καταγραφές του μετεωρολογικού σταθμού Πρέβεζας 
εγκατεστημένος από την Εθνική Μετεωρολογική Υπηρεσία.  

Τα μετεωρολογικά στοιχεία (ταχύτητα και διεύθυνση ανέμου), που χρησιμοποιήθηκαν στην παρούσα 
διπλωματική εργασία, προέρχονται από τις καταγραφές του μετεωρολογικού σταθμού Πρέβεζας που 
είναι εγκατεστημένος από την Εθνική Μετεωρολογική Υπηρεσία (ΕΜΥ).  

Τα στοιχεία αυτά αφορούν ετήσιες καταγραφές εντάσεων και διευθύνσεων ανέμων. Επισημαίνεται ότι 
σε κάθε μετεωρολογικό σταθμό γίνονται τρεις (3) μετρήσεις ανά ημέρα, δηλαδή υπάρχει ένα σύνολο 
3x365 = 1095 παρατηρήσεων ανά έτος. 

Τα ανεμολογικά στοιχεία του σταθμού της Πρεβέζης είναι καταγραφές 28 ετών, μεταξύ της περιόδου 
1971 – 1996. Οι άνεμοι του ευρύτερου ΝΔ τομέα, έχουν συνολική ετήσια συχνότητα εμφάνισης 36%. 
Αναλυτικά, οι ΒΑ άνεμοι είναι οι επικρατέστεροι με ποσοστό ετήσιας εμφάνισης 21%, και ακολουθούν 
οι Δ με ποσοστό 19% και οι ΝΔ με ποσοστό 14%. Οι υπόλοιπες διευθύνσεις εμφανίζονται με ετήσιες 
συχνότητες κάτω του 10%. 

Ένταση(Bf)/ 
Κατεύθυνση B BA A NA N NΔ Δ ΒΔ Νηνεμία Σύνολο 

0         22.158 22.158 
1 0.088 0.153 0.066 0.055 0.033 0.022 0.066 0.044  0.527 
2 2.598 8.078 2.093 1.217 0.964 2.356 3.211 1.118  21.635 
3 2.729 8.538 1.622 0.943 1.184 5.129 7.036 1.315  28.496 
4 0.997 3.233 1.063 0.833 0.921 4.811 7.025 1.140  20.023 
5 0.274 0.921 0.493 0.241 0.296 0.932 1.370 0.351  4.878 
6 0.121 0.351 0.208 0.121 0.099 0.186 0.329 0.153  1.568 
7 0.011 0.099 0.066 0.066 0.055 0.066 0.099 0.044  0.506 
8 0.011 0.022 0.022 0.022 0.011 0.022 0.011 0.011  0.132 
9 0.000 0.011 0.011 0.011 0.011 0.000 0.011 0.011  0.066 

10 0.000 0.000 0.000 0.000 0.000 0.000 0.011 0.000  0.011 
>=11 0.000 0.000 0.000 0.000 0.000 0.000 0.000 0.000  0.000 

Σύνολο 6.829 21.406 5.644 3.509 3.574 13.524 19.169 4.187 22.158 100.000 
Πίνακας 2-4: Μέση ετήσια συχνότητα εμφάνισης συνδυασμών διεύθυνσης/ έντασης ανέμου βάση των μετρήσεων του 

Μετεωρολογικού Σταθμού Πρεβέζης (1971-1996)  
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Οι ετήσιες συχνότητες εμφάνισης διεύθυνσης και έντασης ανέμου όπως καταγράφηκαν στο σταθμό της 
Πρεβέζης παρουσιάζονται στον Πίνακας 2-4. Η συχνότητα εμφάνισης των προερχόμενων από τις οκτώ 
κύριες διευθύνσεις ανέμων παρουσιάζεται και γραφικά στο ιστόγραμμα συχνοτήτων του Σχήμα 2-1. 
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Σχήμα 2-1: Ιστόγραμμα συχνότητας εμφάνισης συνδυασμών διεύθυνσης ανέμου βάση των μετρήσεων του 

Μετεωρολογικού Σταθμού Πρεβέζης (1971-1996) 

Η μέγιστη καταγεγραμμένη ανεμοπνοή είναι 10Bf προερχόμενη από τη Δ διεύθυνση, ενώ ανεμοπνοές 
έντασης 9Β καταγράφονται προερχόμενες από τις ΒΑ, Α, ΝΑ και ΒΔ διευθύνσεις καθώς και την Ν 
διεύθυνση. Η ΝΔ και η Β διεύθυνση παρουσιάζουν καταγραφές ανεμοπνοής εντάσεως έως και 8Β. 

2.7.3 Παλιρροιακά στοιχεία 
 

2.7.4 Κοκκομετρία 

Βάση των πετρωμάτων που συναντά ο ποταμός, προσφέρει χονδρόκοκκο υλικό, κατά κύριο λόγω 
χαλαζιακό, αλλά και σημαντικές ποσότητες λεπτόκοκκου υλικού ιλύος, που εν μέρει προέρχονται, εκτός 
του φλύσχη, από τα υπερβασικά πετρώματα που βρίσκονται στον άνω ρου της λεκάνης του ποταμού.  

Για τις ανάγκες της παρούσης εργασίας απαιτούνταν η συγκεκριμένη εκτίμηση των κοκκομετρικών 
χαρακτηριστικών των υλικών της κοίτης του ποταμού.  

Για την προσέγγιση της κοκκομετρίας των ιζημάτων του ποταμού, χρησιμοποιήθηκαν τα αποτελέσματα 
της μεταπτυχιακής εργασίας της κ. Χαλκιάς Χ. (Χαλκιά Χ. 21012). Η δειγματοληψία περιλαμβάνει 6 
δείγματα έγινε από επιφανειακά ιζήματα στις εκβολές του ποταμού Αράχθου (βλ. Εικόνα 2-1). 
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Εικόνα 2-7: Θέση λήψη δειγμάτων επιφανειακών ιζημάτων στις εκβολές του Άραχθου ποταμού (Χαλκιά Χ. 
2012) 

 

Εικόνα 2-8: Αποτελέσματα ιζηματολογικής ανάλυσης για το Δείγμα 1 (Χαλκιά Χ. 2012) 
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Εικόνα 2-9: Αποτελέσματα ιζηματολογικής ανάλυσης για το Δείγμα 2 (Χαλκιά Χ. 2012) 

 

Εικόνα 2-10: Αποτελέσματα ιζηματολογικής ανάλυσης για το Δείγμα 3 (Χαλκιά Χ. 2012) 
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Εικόνα 2-11: Αποτελέσματα ιζηματολογικής ανάλυσης για το Δείγμα 4 (Χαλκιά Χ. 2012) 

 

Εικόνα 2-12: Αποτελέσματα ιζηματολογικής ανάλυσης για το Δείγμα 5 (Χαλκιά Χ. 2012) 
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Εικόνα 2-13: Αποτελέσματα ιζηματολογικής ανάλυσης για το Δείγμα 6 (Χαλκιά Χ. 2012) 

Τα αποτελέσματα της ιζηματολογικής ανάλυσης για τα έξι δείγματα δίνονται σε κλίμακα Wentworth ή 
κλίμακα φ, όπου 2logϕ = −  

Στον Πίνακα που ακολουθεί δίνεται η αντιστοίχιση των μεγεθών των κόκκων ιζημάτων μεταξύ mm και 
φ, καθώς και η κατάταξη του ιζήματος βάση της διαμέτρου των κόκκων.  

Δεδομένης και της γεωμορφολογίας του ποταμού στο κατώτερο τμήμα του (κατάντη της τεχνητής 
λίμνης Πουρναρίου) αλλά και των αποτελεσμάτων της κοκκομετρικής ανάλυσης των δειγμάτων, η 
κοκκομετρία που προέκυψε κρίνεται ότι προσεγγίζει ικανοποιητικά την κοκκομετρία των ιζημάτων και 
ανάντη των εκβολών.  
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 Class diam 
(mm) Φ 

1 Clay 0.004 8 
2 VFM 0.008 7 
3 FM 0.016 6 
4 MM 0.032 5 
5 CM 0.0625 4 
6 VFS 0.125 3 
7 FS 0.25 2 
8 MS 0.5 1 
9 CS 1 0 

10 VCS 2 -1 
11 VFG 4 -2 
12 VF 8 -3 
13 MG 16 -4 

14 CG 32 -5 
15 VCG 64 -6 
16 SC 128 -7 
17 LC 256 -8 
18 SB 512 -9 
19 MB 1024 -10 
20 LB 2048 -11 

Πίνακας 2-5: Κατάταξη ιζημάτων βάση της διαμέτρου των κόκκων 

Η κοκκομετρία των δειγμάτων ιζήματος που συλλέχθηκαν ήταν ίδια, χωρίς να παρατηρηθεί κάποια 
ιδιαίτερη διαφοροποίηση ενώ η κοκκομετρική ανάλυση των δειγμάτων έδειξε ότι πρόκειται για 
πολαιοαμμώδη (Ms). Οι συνθήκες χαμηλής ενέργειας που ισχύουν στην περιοχή της έχουν ως 
αποτέλεσμα την απόθεση ενός υψηλού ποσοστού αργίλου στα ιζήματα όπως αποδεικνύεται και από 
τις κοκκομετρικές αναλύσεις (Χαλκιά Χ. 21012). 
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3. ΒΑΣΙΚΕΣ ΕΝΝΟΙΕΣ ΥΔΡΑΥΛΙΚΗΣ ΘΑΛΑΣΣΙΑΣ ΥΔΡΟΔΥΝΑΜΙΚΗΣ & 
ΣΤΕΡΕΟΠΑΡΟΧΗΣ 

3.1 Γενικά 

Για την προσέγγιση των φυσικών διεργασιών που δρουν σε ένα σύνθετο φυσικό σύστημα όπως είναι οι 
εκβολές ενός ποταμού θα εφαρμοστούν οι αρχές της υδραυλικής των ανοικτών αγωγών (ώστε να 
προσομοιωθεί η επίδραση του υδατορέματος), της θαλάσσιας υδροδυναμικής (για την προσέγγιση των 
μεγεθών των θαλάσσιων δυνάμεων –κυματισμών - που δρουν στην παράκτια ζώνη) αλλά και μέθοδοι 
υπολογισμού της στερεοπαροχής, ώστε να αποτιμηθεί και ποσοτικά η επίδραση των ανωτέρω φυσικών 
διεργασιών. 

Στο παρών κεφάλαιο θα περιγραφούν οι βασικές έννοιες υδραυλικής και θαλάσσιας υδροδυναμικής 
καθώς και οι μέθοδοι υπολογισμού στερεοπαροχής που θα εφαρμοστούν.  

3.2 Βασικές Έννοιες Υδραυλικής 
Οι έννοιες της Υδραυλικής που θα μας απασχολήσουν αφορούν σε ανοικτούς αγωγούς, οι οποίοι 
προσομοιάζουν την φυσική ροή σε υδατόρεμα και οι κατηγορίες ροής με ελεύθερη επιφάνεια.  

3.2.1 Ανοικτοί αγωγοί 

 Ορισμός 

Ως ανοικτοί αγωγοί ονομάζονται αυτοί στους οποίους το ρευστό (νερό) ρέει με ελεύθερη επιφάνεια. 
Ροή με ελεύθερη επιφάνεια εμφανίζεται στους αγωγούς ομβρίων και ακαθάρτων, σε οχετούς, 
διώρυγες, κανάλια ναυσιπλοΐας, υδατορέματα, κλπ. Η βασική οριακή συνθήκη είναι ότι πίεση στην 
ελεύθερη επιφάνεια είναι ατμοσφαιρική.  

Στη ροή σε αγωγό με ελεύθερη επιφάνεια η παροχή ορίζεται ως: 

Q AV=  

όπου Α είναι το εμβαδόν της υγρής διατομής και V η μέση ταχύτητα ροής της υγρής διατομής. Το 
εμβαδόν της υγρής διατομής Α είναι συνάρτηση της γεωμετρίας της διατομής και της θέσης της 
ελεύθερης επιφάνειας A = A(γεωμετρία, y), όπου ως y ορίζουμε το βάθος ροής.  

Σε περίπτωση διάβασης πλημμύρας σε κάποιο ποτάμι ή υδατόρεμα, η υγρή διατομή μεταβάλλεται 
χρονικά κατά τη διάρκεια του πλημμυρικού φαινομένου με αποτέλεσμα το εμβαδόν της υγρής 
διατομής να εξαρτάται και από το χρόνο, δηλαδή A = A(γεωμετρία, y, χρόνος). 
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 Φυσικά & Γεωμετρικά Χαρακτηριστικά 

Τα φυσικά χαρακτηριστικά των ανοικτών αγωγών είναι η κατά μήκος κλίση του πυθμένα Jo, η εγκάρσια 
(κάθετη) στον πυθμένα διατομή, η κατακόρυφη διατομή, η υγρή διατομή και η στάθμη της ροής σε 
σχέση με κάποιο επίπεδο αναφοράς. 

Ως διατομή (section) ενός ανοικτού αγωγού ορίζεται η εγκάρσια τομή του στην κύρια διεύθυνση ροής, 
ενώ κατακόρυφη διατομή ονομάζουμε αυτή που προκύπτει από ένα κατακόρυφο επίπεδο, κάθετο 
οριζοντιογραφικά στον άξονα του αγωγού. 

Τα κυριότερα χαρακτηριστικά γεωμετρικά μεγέθη της διατομής ενός ανοικτού αγωγού είναι το 
εγκάρσιο βάθος ροής t από την ελεύθερη επιφάνεια ως το χαμηλότερο σημείο (πόδι) της διατομής, το 
κατακόρυφο βάθος ροής y, το εμβαδόν της υγρής διατομής A, το πλάτος της ελεύθερης επιφάνειας Τ, η 
βρεχόμενη περίμετρος P, η υδραυλική ακτίνα R=A/P και το υδραυλικό βάθος D=A/Τ της διατομής που 
ορίζεται ως το βάθος της ισοδύναμης ορθογωνικής διατομής πλάτους Τ. 

3.2.2 Κατηγορίες ροής με ελεύθερη επιφάνεια 

Η ροή με ελεύθερη επιφάνεια χωρίζεται σε κατηγορίες ανάλογα με χαρακτηριστικά που βασίζονται σε 
κινηματικά ή δυναμικά κριτήρια: 

Μόνιμη (steady) ονομάζουμε τη ροή στην οποία το βάθος t παραμένει αμετάβλητο στο χρόνο ή 
αντίθετα Μη μόνιμη - unsteady ή χρονικά μεταβαλλόμενη. 

Ομοιόμορφη (uniform) ονομάζεται η ροή όπου το βάθος t είναι σταθερό καθ' όλο το μήκος του 
αγωγού, αλλιώς η ροή ονομάζεται ανομοιόμορφη (non-uniform). Στη φύση οι ροές που 
παρουσιάζονται είναι σαφώς μή μόνιμες με χωρική και χρονική μεταβλητότητα. 

Η ροή για την οποία η παροχή δεν είναι ίδια κατά μήκος του αγωγού, όπως για παράδειγμα η ροή ενός 
ποταμού, οι συλλεκτήρες στις μονάδες επεξεργασίας νερού, το κανάλι ενός πλευρικού υπερχειλιστή 
κλπ, ονομάζεται χωρικά μεταβαλλόμενη ροή (spatially varied flow), μπορεί δε να είναι είτε μόνιμη είτε 
μη μόνιμη. 

Από κινηματική άποψη η ροή χωρίζεται στις παρακάτω κατηγορίες: 

(1) Μόνιμη ομοιόμορφη ροή είναι αυτή στην οποία το βάθος είναι σταθερό στο χρόνο και καθ’ όλο 
το μήκος του αγωγού. 

(2) Μόνιμη ανομοιόμορφη ροή είναι αυτή στην οποία το βάθος ροής μεταβάλλεται χωρικά αλλά 
όχι και χρονικά Είναι και το περισσότερο συνηθισμένο είδος ροής που παρουσιάζεται κυρίως 
στους πρισματικούς αγωγούς. 

(3) Μη μόνιμη ομοιόμορφη ροή, κατάσταση η οποία είναι πρακτικά αδύνατη, και 
(4) Μη μόνιμη ανομοιόμορφη ροή είναι η ροή όπου το βάθος μεταβάλλεται στο χώρο και το 

χρόνο. 
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Από δυναμική άποψη η ροή χωρίζεται σε κατηγορίες με βάση τη σχέση των δυνάμεων αδρανείας και 
βαρύτητας που την επηρεάζουν, χρησιμοποιώντας δυο αδιάστατα μεγέθη: 

Το πρώτο μέγεθος, είναι ο λόγος των δυνάμεων αδράνειας προς τις δυνάμεις τριβής (λόγω μή 
μηδενικού ιξώδους) και ονομάζεται αριθμός Reynolds (Re) της ροής 

Re VL
v

=  

όπου V είναι η μέση ταχύτητα ροής,  = μ/ρ είναι το κινηματικό ιξώδες και L κάποιο χαρακτηριστικό 
μήκος (όπως π.χ. η υδραυλική ακτίνα της διατομής). Εάν ο αριθμός Reynolds της ροής υπερβεί κάποια 
κρίσιμη τιμή Rec, η ροή από στρωτή γίνεται τυρβώδης. Συγκεκριμένα εάν: 

<500 (L=R=A/Ρ η υδραυλική ακτίνα της διατομής), η ροή θεωρούμε ότι είναι στρωτή,  

Re > 4000 (ο French, 1985, προτείνει 12500) είναι τυρβώδης και  

500<Re<4000 (ή 12500) βρίσκεται σε μια μεταβατική κατάσταση. 

Το δεύτερο αδιάστατο μέγεθος είναι ο λόγος των δυνάμεων αδράνειας προς τις δυνάμεις βαρύτητας 
και ονομάζεται αριθμός Froude (Fr) της ροής 

VFr
gL

=  

όπου V είναι η μέση ταχύτητα ροής, ενώ το χαρακτηριστικό μήκος L=A/T=D ονομάζεται το υδραυλικό 
βάθος της διατομής. Βάση του αριθμού Froude η ροή χαρακτηρίζεται ως ακολούθως: 

<1, οι δυνάμεις βαρύτητας (κύματα) υπερισχύουν των δυνάμεων αδράνειας (ταχύτητα ρευστού 
και η ροή ονομάζεται υποκρίσιμη ή ποτάμια, 

Fr >1, οι δυνάμεις αδράνειας (ταχύτητα ρευστού) υπερισχύουν των δυνάμεων βαρύτητας 
(κύματα) και η ροή ονομάζεται υπερκρίσιμη (χειμαρρώδης), 

=1, οι δυνάμεις αδράνειας και δυνάμεις βαρύτητας είναι ισοδύναμες και η ροή ονομάζεται 
κρίσιμη. 

3.2.3 Εμπειρικές Σχέσεις 

Για αγωγούς μεγαλύτερων διαστάσεων και φυσικά για υδατορρεύματα, οι εμπειρικές σχέσεις δίνουν 
καλύτερα αποτελέσματα από τον προσδιορισμό των απωλειών με βάση τη σχέση των Darcy – 
Weisbach (που προκύπτει από  την εξίσωση συνέχειας και την εξίσωση ορμής) και την εξίσωση 
προσδιορισμού του συντελεστή τραχύτητας σε σωλήνες (διάγραμμα Moody) [Παπανικολάου 2012-13]. 
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Οι συνηθέστερα χρησιμοποιούμενες εμπειρικές σχέσεις είναι ο τύπος του Chezy και ο τύπος του 
Manning, ο οποίος αποτελεί την ευρύτερα χρησιμοποιούμενη σχέση σε ανοικτούς αγωγούς σήμερα. 

1. Τύπος Chèzy 

V C RJ=  

Όπου 

J = κλίση πυθμένα 

R = υδραυλική ακτίνα (m) 

C = συντελεστής τραχύτητας της επιφάνειας 

V = μέση ταχύτητα ροής (m/s) 

2. Τύπος Manning 

Από τη σχέση του Chèzy προκύπτει ότι ο συντελεστής C παραμένει ίδιος, ανεξάρτητα του 
βάθους ροής (και κατ’ επέκταση της υδραυλικής ακτίνας R). Όμως, για έναν αγωγό με 
συγκεκριμένη ισοδύναμη τραχύτητα ks ο συντελεστής C θα έπρεπε να αυξάνει με το βάθος 
ροής, πράγμα που είχαν παρατηρήσει ότι ισχύει στην πράξη, οι μηχανικοί που 
χρησιμοποιούσαν την εν λόγω σχέση.  

Οι Manning (1885) και Strickler δουλεύοντας ανεξάρτητα, κατέληξαν στο συμπέρασμα ότι ο 
συντελεστής C δεν είναι δυνατόν να είναι ανεξάρτητος του βάθους ροής και συγκεκριμένα 
πρότειναν τη σχέση μεταβολής του C σαν συνάρτηση της υδραυλικής ακτίνας C=R1/6/n, όπου n 
είναι μια σταθερά που εκφράζει την τραχύτητα της διατομής. Αντικαθιστώντας την παραπάνω 
εξίσωση στη σχέση του Chèzy η μέση ταχύτητα ροής στη διατομή δίδεται από τη σχέση: 

2/3 1/21V R J
n

=  

Η παραπάνω σχέση (που ονομάζεται εξίσωση του Manning και ο συντελεστής n συντελεστής 
Manning). Ο Ven Te Chow έχει κατηγοριοποιήσει το συντελεστή τραχύτητας n – Manning για 
αγωγούς από διάφορα υλικά (βλ. Παράρτημα).  

Για να ισχύει η παραπάνω σχέση, η υδραυλική ακτίνα R πρέπει δίδεται σε m, η δε ταχύτητα 
ροής που προκύπτει είναι σε m/s. 
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3.3 Βασικές Έννοιες Θαλάσσιας Υδροδυναμικής 

3.3.1 Γενικά 

Για την διερεύνηση της αλληλεπίδρασης των ανεμογενών δυνάμεων στην παράκτια ζώνη, θα πρέπει να 
προσδιοριστούν τα χαρακτηριστικά των ανέμων και των κυματισμών που δρουν στην ευρύτερη και 
εγγύτερη περιοχή του Αμβρακικού κόλπου.  

Συνήθως ανεμολογικά στοιχεία είναι διαθέσιμα από σταθμούς καταγραφής ανέμων οι οποίοι είναι 
εγκατεστημένοι σε διάφορες περιοχές ανά την Ελλάδα.  

Αντίθετα κυματικά στοιχεία δεν είναι διαθέσιμα και για το λόγο αυτό, για την ποσοτική εκτίμηση των 
κυματικών μεγεθών γίνεται θεώρηση ανεμογενών κυματισμών.  

3.3.2 Γένεση κυματισμών 

Για την εκτίμηση των κυματισμών σε βαθιά νερά χρησιμοποιήθηκε η φασματική ανάλυση η οποία 
προσεγγίζει την γένεση των κυματισμών από τον άνεμο ως φασματικό φαινόμενο, συναρτήσει του 
μήκους του αναπτύγματος πελάγους, της έντασης του ανέμου και της διάρκειας πνοής του ανέμου και 
συγκεκριμένα το αριθμητικό ομοίωμα κατά Sverdrup - Munk - Bretshneider (S.M.B.), όπως αυτό 
περιγράφεται στο Shore Protection Manual (C.E.R.C, 1977). Σύμφωνα με τη μέθοδο αυτή, τα μεγέθη 
του χαρακτηριστικού κύματος (μέση τιμή των υψηλότερων 1/3 των καταγραφών) υπολογίζονται σε 
συνάρτηση με το ενεργό ανάπτυγμα πελάγους, την ταχύτητα και την διάρκεια πνοής του ανέμου που 
δημιουργεί τον κυματισμό. 

Παλαιότερα για τον υπολογισμό του αναπτύγματος πελάγους εφαρμοζόταν η μέθοδος του “ενεργού 
αναπτύγματος” (“effective fetch”). Στην πιο πρόσφατη έκδοση του Coastal Engineering Manual (C.E.M. 
2006) καθώς και στο πλέον πρόσφατο British Standard 6349.1/2001 προτείνεται ο υπολογισμός του 
αναπτύγματος από μια ακτίνα, σε αντίθεση με τις προηγούμενες εκδόσεις του (C.E.R.C., 1984 και S.P.M. 
1977) όπου ο υπολογισμός του ενεργού αναπτύγματος προτείνεται να γίνεται από 9 και 15 ακτίνες 
αντίστοιχα.  

Λόγω των μικρών αναπτυγμάτων πελάγους που εμφανίζονται στην συγκεκριμένη περίπτωση οι 
απαιτούμενοι χρόνοι για την ανάπτυξη fetch-limited κυματισμών είναι πολύ μικροί. Συνεπώς η 
ανάπτυξη των κυματισμών περιορίζεται από το μήκος του αναπτύγματος πελάγους (fetch limited 
conditions) και όχι από τη διάρκεια πνοής (duration limited conditions). 

Ο χρόνος διάρκειας πνοής που απαιτείται για κύματα που διασχίζουν ένα ανάπτυγμα πελάγους μήκους 
Χ και με πνοή ανέμου ταχύτητας u για να γίνουν fetch-limited, ήτοι η ανάπτυξή τους να περιορίζεται 
από το μήκος του αναπτύγματος πελάγους και όχι από τη χρονική διάρκεια πνοής, είναι: 

0.67

, 0.34 0.3377.23x u
Xt

u g
=  
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Οι σχέσεις που συνδέουν την ανάπτυξη των κυματισμών σε συνάρτηση με το ανάπτυγμα πελάγους 
είναι οι: 

1
220

2 2
* *

4.13 10mgH gXx x
u u

−  
=   

 
 και 

1
3

2
* *

0.651PgT gX
u u

 
=   

 
 

2
*
2
10

D
uC

U
=  

100.001(1.1 0.035 )DC U= +  
 

όπου: X ανάπτυγμα πελάγους υπολογισμένο με μία ακτίνα κατά την διεύθυνση πνοής του 
ανέμου. 

Ηm0 το φασματικό σημαντικό ύψος κύματος 

CD συρτικός συντελεστής 

U10 ταχύτητα ανέμου στα 10 μ από την στάθμη της θάλασσας. 
U* ταχύτητα τριβής 

Σε συνθήκες πλήρως ανεπτυγμένων κυματισμών (θεωρητικά άπειρο ανάπτυγμα και διάρκεια πνοής) οι 
σχέσεις γίνονται: 

2
2
*

2.115 10mgH x
u

=  και 2

*
2.398 10pgT

x
u

=  

Στις περιπτώσεις όπου η ανάπτυξη των κυματισμών περιορίζεται (όχι η εξεταζόμενη περίπτωση) από 
την διάρκεια πνοής του ανέμου (duration limited), το προκύπτον ενεργειακό φάσμα λαμβάνεται 
μετατρέποντας το μήκος του ενεργού αναπτύγματος  συναρτήσει του χρόνου από τον τύπο: 

3
23

2
**

5.23 10gX gtx
uu

−  
=  

 
 

όπου:  t είναι η διάρκεια πνοής του ανέμου. 

Τέλος η σχέση μεταξύ του χαρακτηριστικού ύψους και της μέγιστης περιόδου του κύματος λαμβάνεται 
βάσει και των συστάσεων του Goda (1985, 2000) ίση με: 

4.5p sT H=  

Η περίοδος του χαρακτηριστικού σημαντικού κύματος Ts λαμβάνεται από τη σχέση 0.95s pT T= . 
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3.4 Μέθοδοι Υπολογισμού Στερεοπαροχής 

3.4.1 Γενικά 

Το φορτίο των ιζημάτων σε ένα υδατόρεμα, ήτοι η ποσότητα των ιζημάτων που κινούνται ως προς την 
παροχή του νερού, αποτελεί μια από τις βασικές μεταβλητές που υπεισέρχονται στις δυναμικές 
μηχανικές διεργασίες που καθορίζουν τη σχήμα του ποταμού, τη μορφολογία του και φυσικά το 
ποσοστό διάβρωσης/ απόθεσης και μεταφοράς ιζημάτων κατά μήκος του υδατορέματος. 

Ειδικότερα όσον αφορά σε θέματα στερεομεταφοράς, η ορθή ποιοτική και ποσοτική γνώση των 
ιζημάτων που μεταφέρονται σε ένα υδατόρεμα είναι κρίσιμη.  

3.4.2 Μορφές Στερεομεταφοράς  

Σε έναν ποταμό αλλά και στο θαλάσσιο περιβάλλον, παρουσιάζονται δυο διακριτές μορφές κίνησης 
των ιζημάτων: 

1. Σε επαφή με τον πυθμένα (Φορτίο πυθμένα - Bedload transport): 

Το φορτίο πυθμένα περιγράφει τα ιζήματα που κινούνται με σύρση, στροφή ή αναπήδηση σε 
μήκος όχι μεγαλύτερο από μερικές διαμέτρους κόκκων (saltation) και βρίσκονται σε συχνή 
επαφή με τον πυθμένα.  

2. Σε αιώρηση (Φορτίο Αιωρήσεως - Suspended load transport): 

Το φορτίο σε αιώρηση αφορά στα ιζήματα που το βάρος τους υπερνικείται από τις τυρβώδεις 
δυνάμεις που σχηματίζονται λόγω ροής και οι οποίες επιτρέπουν στα ιζήματα να ταξιδεύουν 
σημαντικές αποστάσεις χωρίς να έρχεται σε άμεση επαφή με τον πυθμένα.  

 

Εικόνα 3-1: Σχηματικός ορισμός φορτίου αιωρήσεως, φορτίου πυθμένα και ολικού φορτίου 
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Η εμφάνιση της πρώτης ή της δεύτερης μορφής κίνησης εξαρτάται από το μέγεθος των σωματιδίων, το 
βάρος και το σχήμα τους αλλά και από τις υδραυλικές συνθήκες ροής. Εν γένει για μεγαλύτερες 
ταχύτητες και/ ή μικρότερο μέγεθος κόκκων το φορτίων τείνει να τεθεί σε αιώρηση.  

Το διαλυμένο στο υγρό μέσο (νερό) φορτίο αγνοείται συνήθως (παρότι μπορεί να είναι σημαντικό 
ποσοτικά), καθώς το στερεό φορτίο είναι πιο σημαντικό για τις μηχανικές διεργασίες και τους 
μηχανισμούς στερεομεταφοράς αλλά και επειδή δεν είναι εύκολο να ποσοτικοποιηθεί (σε σχέση και με 
τις προαναφερθείσες μορφές στερεομεταφοράς). 

Κατά συνέπεια, το Ολικό Φορτίο (Total Load) υπολογίζεται ως το άθροισμα του Φορτίου πυθμένα και 
του Φορτίου αιωρήσεως.  

Σημειώνεται ότι στο θαλάσσιο περιβάλλον το μεγαλύτερο μέρος του Ολικού φορτίου είναι Φορτίο 
πυθμένα. 

3.4.3 Εξισώσεις Στερεομεταφοράς 

Υπάρχει πλήθος εξισώσεων που περιγράφουν τη μεταφορά ιζημάτων στη διεθνή βιβλιογραφία. Καθώς 
όμως πρόκειται για εμπειρικές σχέσεις, κάθε μια από τις οποίες έχει αναπτυχθεί για να περιγράψει ένα 
συγκεκριμένο εύρος περιπτώσεων (συνδυασμού υδραυλικών συνθηκών και κοκκομετρίας ιζημάτων), 
τα αποτελέσματα από την εφαρμογή των διαφόρων εξισώσεων μπορεί να διαφέρουν σημαντικά 
μεταξύ τους.  

Ελλείψει μιας σχέσης η οποία μπορεί να βρει ακριβή εφαρμογή σε κάθε περίπτωση, η επιλογή της 
καταλληλότερης των εμπειρικών εξισώσεων πρέπει σε κάθε περίπτωση να γίνεται μετά από σύγκριση 
των αποτελεσμάτων με μετρήσεις ή άλλα ποσοτικά στοιχεία που μπορεί να υπάρχουν διαθέσιμα στην 
περιοχή μελέτης.  

Εν συνεχεία αναφέρουμε ορισμένες από τις συνηθέστερα χρησιμοποιούμενες εξισώσεις 
στερεομεταφοράς (οι οποίες χρησιμοποιούνται και από τα λογισμικά πακέτα HEC-Ras και MIKE21 που 
θα εφαρμοστούν στην παρούσα μεταπτυχιακή εργασία): 

 Engelund – Hansen 

Οι Engelund και Hansen (1972) πρότειναν την ακόλουθη εξίσωση στερεομεταφοράς, με εφαρμογή 
κυρίως σε υδατορέματα με αμμώδη πυθμένα. Η σχέση των Engelund και Hansen βασίζεται στη θεωρία 
stream power approach και συσχετίζει το ρυθμό της ενέργειας που καταναλώνεται για την κίνηση των 
κόκκων με το ρυθμό μεταφοράς των σωματιδίων. [Edom 2010]: 
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όπου 
g η επιτάχυνση της βαρύτητας 
S η κλίση της γραμμής ενέργειας  
V η μέση ταχύτητα ροής 
qt το Ολικό φορτίο σε όγκο ανά μέτρο πλάτους 
s το ειδικό βάρος του ιζήματος (σε ton) 
γs & γ το ειδικό βάρος του ιζήματος και του νερού αντίστοιχα  
d η μέση διάμετρος κόκκων 
D το μέσο βάθος του νερού και 
τb η διατμητική τάση πυθμένα. 

 Meyer – Peter και Müller  

Η εξίσωση των Meyer-Peter και Müller έχει παραχθεί για χαλικκώδη υλικά και φυσικά υδατορέματα 
[Edom 2010]. Η αρχική εξίσωση (1948) είχε την ακόλουθη μορφή : 

( )
( )

( )

1.53/2

3
8 0.047

1
s rbi

s

K K RSq
dg s d

γ
γ γ

 
 = −
 −−  

 

Όπου 
γs & γ το ειδικό βάρος του ιζήματος και του νερού αντίστοιχα  
R η υδραυλική ακτίνα 
S η κλίση της γραμμής ενέργειας  
d η μέση διάμετρος κόκκων 
s το ειδικό βάρος του ιζήματος (σε ton) 
qb το Πυθμενικό φορτίο ανά μέτρο πλάτους 
(Ks/Kr)S η τροποποιημένη κλίση της γραμμής ενέργειας, στην οποία οφείλεται η κίνηση του 

πυθμενικού φορτίου. 

Οι τιμές των Ks και Kr υπολογίζονται από τις ακόλουθες σχέσεις: 

2/3 1/2 1/6
90

26,       s r
m

VK K
C R S d

= =  

Όπου 
d90 το μέγεθος των κόκκων για το οποίο το 90% του υλικού είναι μικρότερης διαμέτρου (m) 
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Οι Wong και Parker (2006) επανεξέτασαν τα δεδομένου που είχαν χρησιμοποιήσει οι Meyer-Peter και 
Müller και κατέληξαν ότι η διόρθωση της κλίσης της γραμμής ενέργειας είναι περιττή. Η 
τροποποιημένη κατά Wong και Parker (2006) σχέση είναι: 

( )

1.5

3
3.97 0.0495

( 1)1
biq RS

s dg s d

 
= − − −

 

 Ackers και White 

Οι Ackers και White εφάρμοσαν δισδιάστατη ανάλυση για να εκφράσουν το ρυθμό κίνησης και 
μεταφοράς των ιζημάτων συναρτήσει αδιάστατων παραμέτρων. Η εξίσωση που προτείνουν υπολογίζει 
το Ολικό φορτίο ιζήματομεταφοράς [Van der Scheer, Ribberink, Blom 2002].  

Ο αδιάστατος ρυθμός στερεομεταφοράς κατά Ackers & White define ορίζεται ως: 

* n

gr
X h uG
s D u

 ⋅
=   ⋅  

 

,
1

m
gr

gr
gr cr

F
G K

F

 
= −  

 
 

Όπου 

ss ρ
ρ=  

t sqX
q
ρ
ρ
⋅

=
⋅

 (μέγιστη ροή ανά ροή μάζας – mass flux per unit mass flow rate) 

Συνδυάζοντας τις ανωτέρω εξισώσεις προκύπτει η ακόλουθη σχέση, από την οποία υπολογίζεται ο 
μεταφερόμενος όγκος ιζημάτων (χωρίς τον όγκο των κενών): 

* ,
1

mn
gr

t
gr cr

Fuq u D
u F

  
= Κ ⋅ ⋅ ⋅ ⋅ −        

(m2/s) 

Όπου: 

u      μέση ταχύτητα ανηγμένη καθ’ ύψος (depth average) (m/s) 

* wu g h i= ⋅ ⋅     διατμητική ταχύτητα (m/s) 
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n
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hg D D

−
 
 = ⋅  ∆ ⋅ ⋅ 
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 αριθμός κίνησης ιζημάτων (sediment mobility number) (-) 

sρ ρ
ρ
−

∆ =     σχετική πυκνότητα ιζήματος (-) 

sρ      ειδικό βάρος ιζήματος (kg/m3) 

ρ      ειδικό βάρος νερού (kg/m3) 

D      διάμετρος κόκκων υλικού πυθμένα (m) 

1/3

* 2
gD D

v
∆ = ⋅  

 
   αδιάστατο μέγεθος κόκκων (-) 

( ) ( )( )2 61.14 0.03 15 0.00066 15 10v Te Te −= − − + − ⋅  κινηματικό ιξώδες (-) 

Te      θερμοκρασία (οC) 

Σύμφωνα με τους Ackers & White [1973], η καλύτερη απόδοση του υλικού του πυθμένα γίνεται με τη 
χρήση της διαμέτρους κόκκων D35. Οι συντελεστές n, m, K and Fgr,cr (κρίσιμος αριθμός κίνησης ιζήματος 
- critical sediment mobility number) είναι αδιάστατοι και εξαρτώνται από το αδιάστατο μέγεθος των 
κόκκων.  

Οι Ackers & White κάνουν διαχωρισμό των ιζημάτων βάση του άδιαστατου μεγέθους κόκκων σε 
ιζήματα με 1 < D* < 60 και ιζήματα με D* ≥ 60.  

Συντελεστές  1 < D* < 60 D* ≥ 60 

n *1 0.56log( )D−  0 

m 

*

9.66 1.34
D

+  
1.5 

K 23.53 2.66log( ) (log( ))* *10 D D− + −  
0.025 

Fgr,cr 

*

0.23 0.14
D

+  
0.17 

Οι αρχικές τιμές των συντελεστών που υπεισέρχονται στη σχέση των Ackers & White δίνονται στον 
ανωτέρω Πίνακα. Σημειώνεται ότι νεώτεροι ερευνητές έχουν τροποποιήσει τους εν λόγω συντελεστές. 
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 Yang (1972,1973) 

Βάση της θεωρίας του Yang το ολικό φορτίο ιζηματομεταφοράς υπολογίζεται βάσει όρων ενέργειας και 
ο ρυθμός μεταφοράς συσχετίζεται με τη θεωρία ροής ρεύματος (stream power theory) [Erosion and 
Sedimentation manual].  
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4. HEC-RAS & ΜΙΚΕ ΒΥ DHI SOFTWARE 

4.1 HEC-RAS 

4.1.1 Εισαγωγή  

Το πρόγραμμα HEC-RAS (Hydrologic Engineering Centers River Analysis System) αναπτύχθηκε από το 
Κέντρο Τεχνικής Υδρολογίας του US Army Corps of Engineers. Σχεδιάστηκε για να πραγματοποιεί 
υδραυλικούς υπολογισμούς μονοδιάστατης ανάλυσης με εφαρμογή σε μεγάλο σύνολο πραγματικών 
και τεχνητών ανοιχτών αγωγών, ενώ εξελίσσεται συνεχώς με την βελτιστοποίηση των εγκατεστημένων 
επιλογών/ παραμέτρων και την προσθήκη νέων.  

Οι υπολογιστικές δυνατότητες μονοδιάστατης ανάλυσης του προγράμματος, στην τρέχουσα έκδοσή 
του, περιλαμβάνουν: 

• Προβλήματα μόνιμης ροής 
• Προσομοίωση ανομοιόμορφης ροής 
• Υπολογισμό ιζηματομεταφοράς με μεταβλητές συνοριακές συνθήκες και 
• Ανάλυση ποιότητας υδάτων 

Κάθε μια από τις παραπάνω δυνατότητες αποτελεί διακεκριμένη υπολογιστική ενότητα, αλλά όλες 
βασίζονται και χρησιμοποιούν το ίδιο γεωμετρικό και υδραυλικό μοντέλο. 

Μέσω του κατάλληλα και φιλικά προς το χρήστη περιβάλλοντος εργασίας, παρέχονται οι ακόλουθες 
λειτουργίες: 

• Διαχείριση αρχείων 
• Εισαγωγή και επεξεργασία δεδομένων 
• Ανάλυση μονοδιάστατης ροής σε ανοιχτό αγωγό - υδατόρεμα 
• Πινακοποίηση και γραφική αναπαράσταση των εισαγόμενων και εξαγόμενων δεδομένων 
• Αναφορά σε δυνατότητες 
• Άμεσα ενεργοποιήσιμη on-line βοήθεια 

4.1.2 Παράμετροι Υδραυλικής Ανάλυσης σε Υδατόρεμα 

Περιγράφονται ακολούθως οι βασικές παράμετροι ανάλυσης ροής σε υδατόρεμα, σύμφωνα με το 
πρόγραμμα HEC-RAS: 
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 Συνθήκες μόνιμης ροής (Steady Flow Water Surface Profiles) 

Η επιλογή αυτή αφορά στον υπολογισμό του προφίλ της υδάτινης επιφάνειας υπό μόνιμη 
σταδιακά μεταβαλλόμενη ροή, παρέχοντας τη δυνατότητα προσομοίωσης υπό υποκρίσιμη, 
υπερκρίσιμη και μικτή ροή. Η υπολογιστική διαδικασία βασίζεται στην επίλυση της 
μονοδιάστατης εξίσωσης ενέργειας. Οι γραμμικές απώλειες ενέργειας αξιολογούνται μέσω της 
τριβής και της εξίσωσης του Manning ενώ επιπλέον απώλειες εισάγονται σε περιοχές 
συστολής/ διαστολής με τη χρήση συντελεστή επί της διαφοράς στην κινητική ενέργεια. Η 
εξίσωση της ορμής χρησιμοποιείται σε περιπτώσεις αιφνίδιων μεταβολών του προφίλ της 
επιφάνειας του νερού. Η επιλογή της μόνιμης ροής έχει σχεδιαστεί ώστε να βρίσκει εφαρμογή 
και σε προσομοιώσεις πλημμύρων, προσφέροντας και τη δυνατότητα προσομοίωσης 
διαφόρων κατασκευών (γέφυρες, φράγματα).  

 Συνθήκες ανομοιόμορφης ροής (Unsteady Flow Simulation) 

Η εν λόγω επιλογή συνθηκών ροής προσφέρει τη δυνατότητα προσομοίωσης μονοδιάστατης 
ανομοιόμορφης ροής σε ένα δίκτυο ανοικτών καναλιών. Η εξίσωση επίλυσης της μη μόνιμης 
ροής υιοθετήθηκε από το μοντέλο UNET του Dr. Robert L. Barkau. Η μη μόνιμη ροή μπορεί να 
είναι είτε υποκρίσιμη είτε μικτή. Όπως και στην επιλογή μόνιμης ροής, έτσι και εδώ παρέχεται 
η δυνατότητα να προσομοιώνονται και να συμπεριλαμβάνονται στις διατομές κατασκευές 
όπως γέφυρες, οχετοί κλπ.  

Επιπλέον προσφέρει τις ακόλουθες δυνατότητες: ανάλυση μετά από θραύση φράγματος, 
αντλιοστάσια, συστήματα αγωγών υπό πίεση κλπ.  

 Ψευδο μη μόνιμη Ροή (Quasi Unsteady Flow (Sediment Analysis)) 

Επιπρόσθετα της μόνιμης και ανομοιόμορφης ροής υπάρχει και η επιλογή της Ψευδο- 
ανομοιόμορφης ροής, η οποία στην ουσία είναι μόνιμη ροή μεταβαλλόμενη ανά συγκεκριμένα 
χρονικά διαστήματα και επιλέγεται μόνο στην περίπτωση που πρόκειται να εκτελεστεί 
ανάλυση ιζηματομεταφοράς  

 Υπολογισμοί Ιζηματομεταφοράς/ Μεταβαλόμενων οριών (Sediment Transport/ Movable 
Boundary Computations) 

Η εν λόγω επιλογή προσφέρει τη δυνατότητα προσομοίωσης μονοδιάστατης 
ιζηματομεταφοράς και υπολογισμό των μετακινούμενων ορίων, ως αποτέλεσμα των 
διεργασιών απόθεσης και διάβρωσης, ανά συγκεκριμένα διαστήματα (έτη ή και μεμονωμένα 
πλημμυρικά γεγονότα). Οι τάσεις ιζηματομεταφοράς υπολογίζονται βάση του μεγέθους των 
κόκκων, επιτρέποντας την προσομοίωση υδραυλικής διαλογής και άρα και τη διαστασιολόγηση 
συστήματος προστασίας έναντι υδραυλικής ροής. Μπορούν να προσομοιωθούν συστήματα 
υδατορευμάτων, καναλιών αποστράγγισης, κλπ. 
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Προσομοιώνονται οι μακροπρόθεσμες τάσεις διάβρωσης ή απόθεσης σε ένα υδατόρεμα, ως 
αποτέλεσμα μεταβολών στην συχνότητα ένταση και διάρκεια της παροχής ή στην γεωμετρία 
του καναλιού, προσφέροντας τη δυνατότητα χρήσης σε περιπτώσεις απόθεσης σε ταμιευτήρες, 
σχεδιασμό όδευσης καναλιών, πρόβλεψη διάβρωσης/ απόθεσης σε κανάλια, εκτίμηση 
μέγιστης διάβρωσης υπό πλημμυρικά γεγονότα κλπ. 

Οι εξισώσεις στερεομεταφοράς μεταξύ των οποίων μπορεί να επιλέξει ο χρήστης είναι οι 
ακόλουθες: 

• Ackers – White 
• Engelund – Hansen 
• Laursen 
• Meyer Peter & Muller 
• Toffaleti 
• Yang. 

 Ανάλυση Ποιότητας υδάτων (Water Quality Analysis) 

Η εν λόγω επιλογή επιτρέπει την εκτέλεση ανάλυσης ποιότητας υδάτων και συγκεκριμένα 
θερμοκρασιακή ανάλυση και παρακολούθηση της μεταφοράς συγκεκριμένων δεικτών 
ποιότητας των υδάτων (άλγες, διαλυμένο οξυγόνο, διαλυμένα φωσφορικά στοιχεία, διαλυμένα 
νιτρικά κλπ). Μελλοντικές εκδόσεις του προγράμματος προβλέπεται να περιλαμβάνουν τη 
δυνατότητα εκτέλεσης και άλλων δεικτών ποιότητας υδάτων. 

 Αποθήκευση & Διαχείριση Δεδομέων (Data Storage and Management) 

Τα δεδομένα που εισάγονται, καταχωρούνται σε διακριτές κατηγορίες ως πληροφορίες για το 
έργο, τη γεωμετρία, τις επιλεγμένες συνθήκες ροής και τις αντίστοιχες παραμέτρους, τα 
δεδομένα ιζηματομεταφοράς κλπ). Τα αποτελέσματα της εκάστοτε ανάλυσης αποθηκεύονται 
ενώ μπορούν να μεταφερθούν αυτόματα σε άλλο πρόγραμμα (π.χ. excel). 

 Γραφήματα & Παραρτήματα 

Τα γραφήματα αφορούν διαγράμματα σε άξονες x-y του συστήματος του υδατορέματος, 
τομών, υδρογραφημάτων, αποτυπώσεων υδραυλικών παραμέτρων κλπ, τα οποία μπορούν να 
παραχθούν και σε πίνακες και να εκτυπωθούν απευθείας ή να μεταφερθούν σε άλλο 
πρόγραμμα. Τα παραρτήματα αφορούν τα εκτυπώσιμα αρχεία των δεδομένων εισόδου καθώς 
και των αποτελεσμάτων. 

4.1.3 Συνοπτική Περιγραφή Δημιουργίας Υδραυλικού Μοντέλου με το HEC RAS 

Στο πρόγραμμα HEC RAS με τον όρο Έργο (Project) εννοείται ένα σύνολο από αρχεία αναφορικά με ένα 
συγκεκριμένο σύστημα υδρατορέματος. Κατά τη διάρκεια της δημιουργίας και ανάλυσης του 
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υδραυλικού μοντέλου μπορούν να διαμορφωθούν διάφορα Σχέδια (Plans), κάθε ένα από τα οποία 
αντιπροσωπεύει ένα συγκεκριμένο σύνολο γεωμετρικών, υδραυλικών, ιζηματολογικών και ποιοτικών 
δεδομένων). 

Το αρχικό (και βασικό) παράθυρο εργασίας παρουσιάζεται ακολούθως και βάση των εμφανιζόμενων 
επιλογών στη γραμμή μενού, καθοδηγείται ο χρήστης στον καθορισμό του υδραυλικού μοντέλου, μέσω 
των ακόλουθων βασικών βημάτων που ακολουθούνται για τη δημιουργία ενός υδραυλικού μοντέλου 
με το HEC-RAS: 

 

1. Ορισμός νέου έργου (όνομα, Ορισμός συστήματος μονάδων) 

Ο χρήστης ορίζει το όνομα του Έργου καθώς και τον φάκελο στον οποίο θα αποθηκευτούν 
όλα τα σχετικά με το υδραυλικό μοντέλο αρχεία (File > New Project). 

Eίναι σημαντικό πριν τον καθορισμό των γεωμετρικών και υδραυλικών στοιχείων να 
καθοριστεί το σύστημα μονάδων που θα χρησιμοποιηθεί για το συγκεκριμένο Έργο (Options 
> Unit System (US Customary / SI …)).   

 

2. Εισαγωγή γεωμετρικών στοιχείων (οριζοντιογραφία, τομές, πιθανές κατασκευές) 

Το 2ο βήμα είναι η εισαγωγή των γεωμετρικών στοιχείων (Edit > Geometric Data) το οποίο 
ανοίγει ένα νέο παράθυρο εργασίας, για τη διαμόρφωση των γεωμετρικών χαρακτηριστικών 
(κάτοψη/ τομές) του υδατορέματος ή του δικτύου υδατορεμάτων καθώς και για την 
εισαγωγή πιθανών κατασκευών που πρέπει θα εισαχθούν στην προσομοίωση.  
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Σε κάθε ποταμό μπορούν να οριστούν από ένα και άνω υδατορέματα (reaches). Αρχικά 
σχεδιάζεται ο άξονας του υδατορέματος από ανάντη προς κατάντη είτε με το χέρι (River 
Reach) είτε πιο εύχρηστα (Edit – Reach Schematic Lines) εισάγοντας συντεταγμένες. Εν 
συνεχεία εισάγονται οι διατομές (Cross Section), οι οποίες ορίζονται από ανάντη προς τα 
κατάντη ανά αποστάσεις, σε χαρακτηριστικά σημεία της οριζοντιογραφίας και της 
μηκοτομής.  
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Σε κάθε διατομή ορίζονται: 

• Όνομα διατομής (συνήθως αριθμός με αύξουσα σειρά)  
• Χιλιομετρική θέση διατομής (απόσταση τρέχουσας διατομής από την κατάντη) 
• Γεωμετρία Διατομής 
• Απώλειες (συντελεστής Manning και συντελεστής διαστολής/ συστολής)  
• Άλλα γεωμετρικά ή υδραυλικά στοιχεία (πλημμυρική κοίτη (Levee) κλπ) 

Πύκνωση των διατομών μπορεί να γίνει εκ των υστέρων με εντολή (Tools > XY Interpolation) 
είτε καθ όλο το υδατόρεμα είτε ανάμεσα σε συγκεκριμένες συντεταγμένες, με γραμμική 
παρεμβολή. 

Αφού ορισθεί η γεωμετρία το αρχείο αποθηκεύεται (File > Save Geometry Data as…). 

3. Καθορισμός ροής (Εισαγωγή υδραυλικών παραμέτρων και καθορισμός συνοριακών 
συνθηκών) 

Η επιλογή των συνθηκών ροής γίνεται από τη γραμμή εργαλείων (ή απευθείας από τα 
αντίστοιχα εικονίδια):  

Edit > Steady Flow Data ή 

 

Edit > Unsteady Flow Data ή  

Edit > Quasi Unsteady Flow (Sediment Analysis) 
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Σημειώνεται ότι η επιλογή της Ψευδο-ανομοιόμορφης ροής (Quasi Unsteady Flow (Sediment 
Analysis)) γίνεται μόνο στην περίπτωση που πρόκειται να εκτελεστεί ανάλυση 
ιζηματομεταφοράς.  

 Μόνιμη Ροή 

Τα δεδομένα που απαιτείται να εισάγει οχρήστης είναι: 

• Παροχή σχεδιασμού  
• Οριακές συνθήκες: Στάθμη νερού 

    Κρίσιμο βάθος 
    Ομοιόμορφο βάθος (δίνεται η κλίση του πυθμένα) 
    Καμπύλη στάθμης παροχής 

 Μη Μόνιμη Ροή 

Τα δεδομένα που απαιτείται να εισάγει ο χρήστης είναι: 

• Οριακές συνθήκες: Υδρογράφημα σχεδιασμού 
    Σταθμηγράφημα σχεδιασμού 
    Καμπύλες στάθμης παροχής 
    Αρχικές συνθήκες ροής 

Αφού εισαχθούν τα δεδομένα ροής του υδατορέματος το αρχείο αποθηκεύεται (File > Save 
Flow Data as…). 

4. Εκτέλεση υδραυλικών υπολογισμών 

Μετά την διαμόρφωση της γεωμετρίας και την εισαγωγή των παραμέτρων ροής δίνεται η 
εντολή για τον υπολογισμό της ροής: 

Run > Steady Flow Analysis ή  

Run > Unsteady Flow Analysis 

Η οποία ανοίγει το αντίστοιχο παράθυρο εργασίας για την εκτέλεση των υδραυλικών 
υπολογισμών, στο οποίο ανάλογα με την επιλογή ροής ζητείται η εισαγωγή επιπλέον 
δεδομένων (όπως η επιλογή συνθηκών ροής για τη μόνιμη ανάλυση και ο ορισμός του 
χρονικού πλαισίου ανάλυσης για τη μη μόνιμη ροή).  

Επιπλέον στην περίπτωση της μη μόνιμης ροής ο χρήστης μπορεί για απομείωση του χρόνου 
ανάλυσης και του όγκου των αποτελεσμάτων να επιλέξει το αντίστοιχο επίπεδο 
αποτελεσμάτων (Output Level), ήτοι να συμπεριλάβει τα δεδομένα μόνο που επιθυμεί στα 
αρχεία εξόδου. 
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5. Προβολή αποτελεσμάτων 

Μετά την ολοκλήρωση της ανάλυσης ο χρήστης έχει τη δυνατότητα άμεσης εποπτείας των 
αποτελεσμάτων μέσω γραφικής απεικόνισης των διατομών, μηκοτομών, καμπυλών 
στάθμης- παροχής, υδρογραφημάτων και τρισδιάστατης απεικόνισης, αλλά και τη 
δυνατότητα πινακοποίησης των αποτελεσμάτων και μεταφοράς του σε άλλο πρόγραμμα 
διαχείρισης δεδομένων.  

Ενδεικτικά αναφέρονται οι ακόλουθες εντολές: 

View > Cross Sections 
View > Profiles 
View > Rating Curves 
View > Stage and Flow Hydrographs 
View > X-Y-Z Perspective Plots 
View > Detailed Output Tables / Profile Summary Table 
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4.2 MIKE by DHI 

4.2.1 Γενικά Στοιχεία 

Το λογισμικό ΜΙΚΕ 21 που δημιουργήθηκε από την εταιρεία DHI προσφέρει τη δυνατότητα 
προσομοίωσης και επίλυσης ποικίλων υδροδυναμικών και υδραυλικών προβλημάτων, κάθε ένα από τα 
οποία αντιμετωπίζεται με εφαρμογή ενός διαφορετικού λογισμικού πακέτου.  

Συγκεκριμένα το MIKE 21 HD είναι ένα υδροδυναμικό λογισμικό πακέτο που προσομοιώνει τη 
δισδιάστατη ροή με ελεύθερη επιφάνεια και περιγράφει υδραυλικές και περιβαλλοντικές διεργασίες 
που λαμβάνουν χώρα σε παράκτιες περιοχές, εκβολές ποταμών, λίμνες, κόλπους και στην ανοιχτή 
θάλασσα. Η ελεύθερη επιφάνεια προσεγγίζεται είτε με ευθύγραμμο ή καμπύλο πλέγμα (grid), είτε με 
τριγωνικά (ή τετραγωνικά) πεπερασμένα στοιχεία (element mesh). 

To MIKE 21 HD αποτελεί το βασικό υδροδυναμικό εργαλείο όλου του πακέτου και την βάση για τα 
διάφορα άλλα συσχετιζόμενα πακέτα, όπως το πακέτο προσομοίωσης διάχυσης Advection-Dispersion 
(AD), ποιότητας υδάτων Water Quality (ECOLab) και ιζηματομεταφοράς συνεκτικών και μη συνεκτικών 
υλικών, Sand Transport (ST) και Mud Transport (MT).  

Το MIKE 21 HD συμπεριλαμβάνει την επίδραση των ακόλουθων φαινομένων: 

• Εξίσωση συνέχειας και κίνησης 
• Διατμητική τάση πυθμένα  
• Διατμητική τάση στην επιφάνεια λόγω ανεμοπνοής 
• Μεταβολές βαρομετρικού πεδίου 
• Δύναμη Coriolis 
• Διασπορά ορμής (μέσω θεωριών όπως οι εξισώσεις Smagorinsky)  
• Κυματογενή ρεύματα 
• Πηγές και καταβόθρες (σε όρους μάζας και ταχύτητας)  
• Εξατμισοδιαπνοή 
• Πλημμύρες και αποστέγνωση 
• Υδραυλικές κατασκευές 

Οι Υδρογραφικές οριακές συνθήκες μπορεί να οριστούν ως σταθερό ή μεταβλητό (στο χώρο και το 
χρόνο) επίπεδο ή προφίλ ροής για τα ανοικτά όρια, ως σταθερή ή μεταβλητή πηγή ή σε οποιοδήποτε 
θέση στο μοντέλο, και ως αρχική ελεύθερη επιφάνεια εφαρμοσμένη στο σύνολο του μοντέλου. 

4.2.2 MIKE 21 Flow Model FM 

Στην παρούσα διπλωματική εργασία χρησιμοποιήθηκε το λογισμικό πακέτο ΜΙΚΕ 21 Flow Model FM 
(finite mesh), στο οποίο γίνεται δισδιάστατη και τρισδιάστατη ανάλυση ενώ προσομοίωση του 
μοντέλου γίνεται με πεπερασμένα στοιχεία.  
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Η εν λόγω επιλογή του ευπροσάρμοστου πλέγματος πεπερασμένων στοιχείων συνιστάται για 
εφαρμογές σε ωκεανογραφικά και παράκτια συστήματα καθώς επίσης και σε συστήματα εκβολής 
ποταμών και σύνθετες γεωμετρίες και για το λόγο αυτό επιλέχθηκε και για την παρούσα διπλωματική.  

Το πακέτο ΜΙΚΕ 21 Flow Model FM περιλαμβάνει τις ακόλουθες ρουτίνες: 

• Flow modules:  Hydrodynamic Module (HD) 
Transport Module (TR) 
Ecology Module (ECO Lab) 
Oil Spill Module (ELOS) 
Sand Transport Module (ST) 
Mud transport Module (MT) 
Particle Tracking Module (PT) 

• Wave module:  Spectral Wave Module 

 

Η ρουτίνα Hydrodynamic Module (HD) είναι η βάση για την ανάλυση προβλημάτων ροής, στην οποία 
βασίζονται οι υπόλοιπες ρουτίνες, ενώ συμπεριλαμβάνει και την επίδραση όλων των φαινομένων που 
αναφέρθηκαν στην §4.2.2. 

Το πακέτο λογισμικού υποστηρίζεται από το αντίστοιχο εργαλείο δημιουργίας του πλέγματος του 
μοντέλου (Mesh Generator) καθώς και με άλλα εργαλεία για την καλύτερη προβολή και απεικόνιση 
των αποτελεσμάτων, τα οποία συμπεριλαμβάνονται στο πακέτο ΜIKE Zero.  
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4.2.3 Θεωρητικό υπόβαθρο 

Οι υπολογισμοί στο ΜΙΚΕ 21 Flow Model FM βασίζονται στην αριθμητική επίλυση των δισδιάστατων ή 
τρισδιάστατων κατά Reynolds εξισώσεων Navier – Stokes, υπό πίεση Boussinesq ή υδροστατική.  

Οι βασικές εξισώσεις που διέπουν το μοντέλο σε Καρτεσιανό Σύστημα Συντεταγμένων είναι: 

• Εξίσωση συνέχειας: 

 

• Εξισώσεις κίνησης κατά x και y 
αντίστοιχα: 

 

 

4.2.4 Δημιουργία Μοντέλου Προσομοίωσης στο ΜΙΚΕ 21 Flow Model FM 

Στην παρούσα παράγραφο θα περιγραφούν συνοπτικά τα κύρια βήματα που ακολουθεί ο χρήστης για 
τη δημιουργίας ενός υδροδυναμικού μοντέλου δισδιάσταστης ανάλυσης πεπερασμένων στοιχείων με 
το ΜΙΚΕ 21 Flow Model FM. 

4.2.4.1 Δημιουργία πλέγματος  

Το 1ο και βασικό βήμα είναι η δημιουργία της βυθομετρίας – τοπογραφίας της περιοχής που θέλουμε 
να προσομοιώσουμε.  

 Βασικές Έννοιες 

Το αρχείο της βυθομετρίας – τοπογραφίας που δημιουργείται περιέχει πληροφορίες για τη 
γεωγραφική θέση (x,y) και το βάθος νερού (z) για κάθε κόμβο (node) του πλέγματος καθώς και 
πληροφορίες για τη συνδεσιμότητα (connectivity) των κόμβων των στοιχείων. 
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Οι βασικές γεωμετρικές έννοιες που χρησιμοποιούνται για τη δημιουργία του πλέγματος 
απεικονίζονται ακολούθως και αφορούν τα ακόλουθα στοιχεία: 

• Κόμβος (node): καθορίζει την αρχή και το πέρας ενός 
τόξου 

• Κορυφή (vertex): ενδιάμεσα σημεία ενός τόξου 
• Τόξο (arc): σύνολο από ένα ή παραπάνω ευθύγραμμα 

τμήματα, αποτελούμενο από μηδέν ή παραπάνω 
κορυφές και έναν (αν είναι κλειστό) ή δυο (αν είναι 
ανοικτό) κόμβους 

• Πολύγωνο (polygon): Κλειστός βρόγχος αποτελούμενος 
από ένα κλειστό τόξο ή δύο και παραπάνω ανοικτά (το 
πολύγωνο δεν σχηματίζεται από το χρήστη αλλα γεννάται 
αυτόματα όταν κλείσει ένα σύνολο τόξων). 

 Παράθυρο Εργασίας 

Η ρουτίνα που δημιουργεί το αρχείο πλέγματος πεπερασμένων στοιχείων που χρησιμοποιεί το ΜΙΚΕ 21 
Flow Model FM ως βάση είναι η Mesh Generator: 

MIKE Zero > File >New > File 

που ανοίγει το ακόλουθo παράθυρο όπου επιλέγεται ΜΙΚΕ Zero > Mesh generator 

 

Εικόνα 4-1: Βασικές γεωμετρικές έννοιες στο 
Mesh generator 
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Αμέσως ζητείται η επιλογή της θέση του έργου βάση συστήματος συντεταγμένων UTM (Universal 
Transverse Mercator coordinate system) και ακολούθως εμφανίζεται το κύριο παράθυρο εργασία του 
Mesh generator.   

 

 Ορισμός περιοχής εργασίας (workspace) 

Ορίζεται η περιοχή εργασίας (workspace) (Options > Workspace) δίνοντας τις συντεταγμένες των δυο 
διαγώνιων γωνιών της περιοχής ενδιαφέροντος 

 Εισαγωγή Βυθομετρίας και Συνοριακών γραμμών 

Τα βασικά στοιχεί που εισάγονται είναι σημεία με συντεταγμένες xyz (Data > Manage Scatter Data) και 
συνοριακές γραμμών (Data > Import Boundary). Τα αρχεία (.xyz files) που περιέχουν τα εν λόγω 
δεδομένα πρέπει να έχουν μια συγκεκριμένη διαμόρφωση ώστε να μπορούν να αναγνωστούν από το 
πρόγραμμα, ήτοι x y z για απλά σημεία και x y z συνδεσιμότητα για τα σημεία των κλειστών 
συνοριακών συνθηκών.  

Η συνδεσιμότητα (connectivity) ορίζεται ως αριθμός ίσος με: 

• 1 για το όριο ξηράς/ νερού 
• >1  για ανοικτά όρια 

Ορίζεται ο ίδιος αριθμός για κάθε σημείο του ορίου, πλην του τελευταίου σημείου στο οποίο δίδεται η 
τιμή 0. Στο ίδιο αρχείο μπορεί να δίνονται πάνω από ένα τόξο (arc) για τις συνοριακές συνθήκες. 
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 Δημιουργία πλέγματος (Generate mesh) 

Πριν την έναρξη δημιουργίας του πλέγματος ο χρήστης πρέπει να επιβεβαιώσει τα άκρα των ανοικτών 
και κλειστών ορίων, ώστε να ορίζεται επακριβώς η περιοχή στην οποία θα δημιουργηθεί το πλέγμα.  

Τα στοιχεία που επιλέγονται για τη δημιουργία του πλέγματος είναι τριγωνικά (εν συνεχεία υπάρχει και 
επιλογή για τετραγωνικά) (Mesh > Generate Mesh) 

 

 Εξομάλυνση πλέγματος (Smoothing) 

Μετά τη δημιουργία του πλέγματος συστήνεται η 
«εξομάλυνση του πλέγματος» ώστε οι κόμβοι του 
πλέγματος να κατανεμηθούν πιο ομοιόμορφα και 
να αποφευχθούν κατά το δυνατό οι μικρές γωνίες. 
Η διαδικασία αυτή μπορεί να εφαρμοστεί πάνω 
από μια φορές. 

 Ανάλυση πλέγματος (Analyze mesh) 

Αφού έχει εφαρμοστεί η διαδικασία της εξομάλυνση μπορεί να γίνει και ανάλυση του πλέγματος. Στη 
γραμμή εργασίας επιλέγεται η εντολή Analyze Mesh (Mesh> Analyze Mesh ,η οποία ενεργοποιείται 
όταν έχει επιλεγεί το Mesh Editing). Η ανάλυση θα υποδείξει τα στοιχεία με το μικρότερο χρονικό βήμα 
ή με το μικρότερο εμβαδό ή με τη μικρότερη γωνία (κρίσιμο για να μην εμφανίζονται μεγάλοι CLF 
αριθμοί). Ο χρήστης μπορεί εν συνεχεία να «διορθώσει» τα στοιχεία που επιθυμεί.  
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 Παρεμβολή διάσπαρτων στοιχείων (Interpolating Scatter Data) 

Με την εντολή αυτή, το πλέγμα λαμβάνει τιμές βάσει των διάσπαρτων στοιχείων (συνήθως 
βυθομετρίας) που έχουν εισαχθεί. Η παρεμβολή μπορεί να είναι είτε «φυσική γειτνίαση» είτε γραμμική 
παρεμβολή.  
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 Εξαγωγή Πλέγματος (Exporting the Mesh) 

Μετά τη διαμόρφωση του τελικού πλέγματος, αυτό εξάγεται και αποθηκεύεται σε αρχείο μορφής 
.mesh, ώστε να χρησιμοποιηθεί από τις υπολογιστικές ρουτίνες του προγράμματος (Mesh> Export 
Mesh..).  

 Προβολή Πλέγματος (Viewing the Mesh) 

Το τελικό πλέγμα μπορεί να αναπαραχθεί και να προβληθεί με κάποιο από τα ακόλουθα εργαλεία: 
Data Viewer, Data Manager, Plot Composer ή MIKE Animator. 

 
 

 

4.2.4.2 Δημιουργία υδροδυναμικού μοντέλου 

Τα βήματα που ακολουθούνται για τη δημιουργία του υδροδυναμικού μοντέλου στο ΜΙΚΕ 21 Flow 
Model FM αντιστοιχούν στις επιμέρους καρτέλες που επιλέγονται από το βασικό παράθυρο εργασίας 
του μοντέλου και το οποίο καθοδηγεί το χρήστη για τη δημιουργία του μοντέλου. Τα σημαντικότερα 
βήματα περιγράφονται συνοπτικά ακολούθως: 
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1. Καθορισμός περιοχής (Domain): Καθορίζεται το αρχείο .mesh που δημιουργήθηκε με τη βοήθεια 
του Mesh Generator και το οποίο θα χρησιμοποιηθεί για την ανάλυση. 

 

2. Χρόνος (Time): Στην αντίστοιχη καρτέλα καθορίζεται το χρονικό πλαίσιο της ανάλυσης, εισάγοντας 
τον αριθμό των επιμέρους βημάτων, το χρονικό βήμα και την ώρα και ημερομηνία έναρξης για την 
προσομοίωση. 
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3. Επιλογή Μοντέλου (Module Selection): Επιλέγονται επιπλέον του ΜΙΚΕ 21 Flow Model FM οι 

ρουτίνες που απαιτούνται για την εκάστοτε ανάλυση (στην παρούσα διπλωματική θα επιλεγεί 
επιπλέον η ρουτίνα Sand Transport). 

 

4. Παράμετροι υδροδυναμικού μοντέλου (hydrodynamic Module): Η επιλογή Hydrodynamic Module 
εμφανίζει μια αναπτυσσόμενη λίστα με παραμέτρους οι οποίες λαμβάνονται υπόψη στην ανάλυση 
μέσω των αντίστοιχων καρτελών: 

• Τεχνική Επίλυσης (Solution Technique): Επιλέγεται ο αλγόριθμος με τον οποίο θα γίνει η 
αριθμητική επίλυση των εξισώσεων μεταξύ δύο επιλογών που προσφέρουν αντιστρόφως 
ανάλογα στην ταχύτητα εκτέλεσης (Low order) των υπολογισμών και την ακρίβεια (high 
order).  

Επιπλέον επιλέγεται η μέγιστη επιτρεπόμενη τιμή του αριθμού Courant (CLF), η οποία δεν 
πρέπει να ξεπερνάει τη μονάδα. Για μεγαλύτερη ευστάθεια του υπολογιστικού μοντέλου 
προτείνεται να μην ξεπερνάει την τιμή 0.8. 

Δίνονται επίσης για τις προς επίλυσης εξισώσεις το μέγιστο και ελάχιστο χρονικό βήμα 
ολοκλήρωσης τους. 
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• Διόρθωση Βάθους (Depth Correction): Το πρόγραμμα δίνει τη δυνατότητα επιλογής 
«διόρθωσης» όλων των τιμών z του πλέγματος κατά Δz. Η επιλογή αυτή είναι χρήσιμη στην 
περίπτωση που πρέπει να επαναληφθεί κάποια ανάλυση λαμβάνοντας υπόψη αυξημένη ή 
μειωμένη στάθμη θάλασσας.  
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• Πλημμύρα και αποξήρανση (Flood and Dry): Η επιλογή αφορά περιοχές που δυνητικά μπορεί 
να πλημμυρίσουν ή να αποξηρανθούν. Καθορίζεται το βάθος ξήρανσης, το πλημμυρικό βάθος 
και το βάθος διαβροχής. Όταν το βάθος του νερού είναι μικρότερο από το βάθος διαβροχής οι 
εξισώσεις αναδιατυπώνονται και μόνο αν το νέο βάθος νερού είναι μικρότερο από το βάθος 
ξήρανσης απομακρύνεται το στοιχείο από τον υπολογισμό. Το πλημμυρικό βάθος καθορίζει 
πότε ένα στοιχείο πλημμυρίζει και άρα επανεντάσσεται στους υπολογισμούς. 

 

• Πυκνότητα (Density): Επιλέγεται αν η πυκνότητα (θεωρούμενη ως συνάρτηση της αλατότητας 
και της θερμοκρασίας) θα είναι σταθερή (barotropic) ή αν θα μεταβάλλεται κατά τη διάρκεια 
της προσομοίωσης βάση της θερμοκρασίας ή / και της αλατότητας, οπότε η τιμή της θα 
τροποποιείται αυτόματα με την επίλυση των εξισώσεων θερμοκρασίας ή/ και αλατότητας. 

 

• Τραχύτητα πυθμένα (Bed Resistance): Επιλέγεται αν η τραχύτητα του πυθμένα θα αγνοηθεί ή 
θα ληφθεί υπόψη μέσω του συντελεστή Chezy ή του συντελεστή Manning. Σε περίπτωση που 
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η τραχύτητα ληφθεί υπόψη, ο αντίστοιχος συντελεστής που θα εισαχθεί μπορεί να είναι 
σταθερός καθ’ όλη την προσομοίωση ή να μεταβάλλεται (οπότε θα πρέπει να εισαχθεί αρχείο 
με τα δεδομένα μεταβολής του συντελεστή κατά τη διάρκεια της προσομοίωσης).  

 

• Ιξώδες δινών (Eddy Viscosity): Επιλέγεται η χρήση ή όχι σταθερού ή χωρικά μεταβαλλόμενης 
τιμής για το ιξώδες.  
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Το ιξώδες επηρεάζει την εγκάρσια διασπορά της ταχύτητας ροής. Προτείνεται να υιοθετούνται 
μικρές τιμές ιξώδους ώστε να αποφεύγεται η «εξομάλυνση» του πεδίου των ταχυτήτων με 
ενδεικτική τιμή 0.8m2/sec.  

Εναλλακτικά μπορεί να επιλεγεί ο δυναμικός υπολογισμός του ιξώδους με τη σχέση του 
Smagorinsky, οπότε κ εισάγεται ο αντίστοιχος συντελεστής με εύρος τιμών από 0.25 έως 1.0 
και προτεινόμενη τιμή 0.28.  

• Δύναμη Coriolis: H επίδραση της δύναμης Coriolis μπορεί να ληφθεί υπόψη στο υπολογιστικό 
μοντέλο με τρεις τρόπους: να αγνοηθεί, να θεωρηθεί σταθερή ή να θεωρηθεί μεταβλητή. Αν 
επιλεχθεί ως σταθερή, η δύναμη Coriolis θα υπολογιστεί με βάση ένα σταθερό γεωγραφικό 
πλάτος το οποίο ορίζεται από το χρήστη (σε μοίρες). Αν επιλεγεί ότι η δύναμη Coriolis θα είναι 
μεταβλητή, τότε υπολογίζεται αυτόματα βάση του γεωγραφικού πλάτους που έχει 
προεπιλεγεί και των γεωγραφικών πληροφοριών του πλέγματος.  

 

• Ανεμοπνοή: Αν επιλεγεί η εισαγωγή ανεμοπνοής ως εξωτερική δύναμη στο υπολογιστικό 
μοντέλο, τότε αυτή μπορεί να είναι σταθερή στο χώρο και το χρόνο, μεταβλητή στο χρόνο και 
σταθερή στο χώρο ή μεταβλητή στο χρόνο και το χώρο. Στην πρώτη περίπτωση επιλέγεται η 
ένταση (m/s) και η διεύθυνση (deg) ανεμοπνοής (μετρούμενη από το Βορρά).  

Σε κάθε περίπτωση συστήνεται να εισάγεται και ένα «διάστημα σταδιακής έναρξης» (soft start 
interval) κατά τη διάρκεια του οποίου η ένταση της ανεμοπνοής αυξάνεται σταδιακά από 
μηδέν έως το επιθυμητό όριο, ώστε να μην δημιουργηθούν προβλήματα στην υπολογιστική 
διαδικασία λόγω shock wave.  
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Για την εισαγωγή ανεμοπνοής στο υπολογιστικό μοντέλο είναι υποχρεωτική η εισαγωγή και 
του «συντελεστή τριβής ανεμοπνοής» (wind friction), ο οποίος μπορεί να θεωρηθεί είτε 
σταθερός είτε μεταβλητός συναρτήσει της ανεμοπνοής. Στη δεύτερη περίπτωση υπολογίζεται 
αυτόματα με γραμμική παρεμβολή μεταξύ δυο ακραίων τιμών ανεμοπνοής και των 
αντίστοιχων τιμών του συντελεστή, όπως αυτές εισάγονται από το χρήστη. 

 

• Παγοκάλυψη: Δίδεται η δυνατότητα επιλογής παγοκάλυψης στο πεδίο ροής, καθορίζοντας τη 
συγκέντρωση του πάγου, το πάχος του ή και τα δυο μαζί. 
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• Παλιρροϊκό Δυναμικό: Στο υπολογιστικό μοντέλο το παλιρροϊκή δυναμικό είναι μια δύναμη 
που παράγεται από τις διακυμάνσεις στη βαρύτητα, λόγω της σχετικής κίνησης της γης, της 
σελήνης και του ήλιου. Το παλιρροϊκό δυναμικό μπορεί να καθοριστεί είτε από το παράθυρο 
διαλόγου είτε από αρχείο εισόδου δεδομένων. Εν γένει το παλιρροϊκό δυναμικό έχει αδύναμη 
επιρροή στο υπολογιστικό μοντέλο και είναι σημαντικό σε βαθιά νερά και κλειστές θάλασσας 
ή σε μοντέλα μεγάλης κλίμακας, π.χ. στον Ειρηνικό Ωκεανό. 
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• Κατακρήμνιση – εξάτμιση: Η κατακρήμνιση προτείνεται να λαμβάνεται υπόψη σε περιπτώσεις 
όπου η βροχοπτώσεις στην περιοχή είναι σημαντικές. Η κατακρήμνιση μπορεί να ληφθεί 
υπόψη είτε σαν κατακρήμνιση (σταθερή ή μεταβλητή) είτε σαν καθαρή κατακρήμνιση 
(σταθερή ή μεταβλητή) έχοντας αφαιρέσει το ποσοστό που αντιστοιχεί στην εξάτμιση. 
Αντίστοιχα μπορεί να εισαχθεί στους υπολογισμούς η εξάτμιση (εκτός και αν έχει επιλεγεί η 
εισαγωγή της καθαρής κατακρήμνισης) η οποία επίσης μπορεί να είναι μεταβλητή ή σταθερή . 

 

• Κυματική Ακτινοβολία (wave radiation): Οι τάσεις 2ης τάξης λόγω θραύσης κυμάτων μικρής 
περιόδου μπορεί να εισαχθεί στο υπολογιστικό μοντέλο. Εάν ενεργοποιηθεί η εν λόγω 
επιλογή απαιτείται η εισαγωγή αρχείου εισόδου το οποίο παράγεται από τα κυματικά 
μοντέλα MIKE 21 SW, MIKE 21 NSW ή MIKE 21 PMS. Η εν λόγω εφαρμογή δεν συστήνεται στην 
περίπτωση που έχει ενεργοποιηθεί η επιλογή Πλημμύρα και αποξήρανση. 
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• Πηγές: Λαμβάνεται υπόψη η επιρροή στο υδροδυναμικό μοντέλο ενός ποταμού ή σημείου 
λήψης εκβολής υδάτων. Στο παράθυρο Sources> List View – New Source εισάγεται ο 
επιθυμητός αριθμός πηγών, τα χαρακτηριστικά των οποίων καθορίζονται εν συνεχεία (Edit 
Source). Η πηγή μπορεί να είναι απλή πηγή (simple source - καθορίζεται μόνο η παροχή 
(m3/s), τυπική πηγή (standard source - οπότε καθορίζονται επιπλέον και ταχύτητες εισόδου 
κατά x και y), ή συνδεδεμένη πηγή (connected source - η παροχή της συνδέεται με μία άλλη 
πηγή που έχει καθοριστεί και ορίζεται μόνο η ταχύτητα). Σε κάθε περίπτωση τα δεδομένα 
εισόδου (παροχή ή/ και ταχύτητα) μπορεί να είναι σταθερά ή μεταβλητά στο χρόνο (οπότε και 
λαμβάνονται από αντίστοιχο αρχείο εισόδου). Επιπλέον καθορίζονται και τα γεωγραφικά 
χαρακτηριστικά της κάθε πηγής, η οποία εν συνεχεία εμφανίζεται και στο χάρτη (Sources> 
Geographic View). 

 

• Κατασκευές: Οι κατασκευές που δύναται να προσομοιωθούν στο υδραυλικό μοντέλο είναι 
φράγματα, οχετοί, αναχώματα, πύλες, βάθρα και στρόβιλοι ή και συνδυασμοί αυτών. Καθότι 
οι κατασκευές έχουν διαστάσεις κατά πολύ μικρότερες από τις διαστάσεις του κελιού του 
πλέγματος, προσομοιώνονται με μια τεχνική υπο-πλέγματος (η ροή στην κατασκευή 
προσομοιάζεται βάση της επιφάνειας του νερού στα ανάντη και στα κατάντη.  
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• Αρχικές Συνθήκες: Οι αρχικές συνθήκες για τις υδροδυναμικές μεταβλητές μπορεί να ορισθούν 
ως σταθερές, βάση χωρικά μεταβαλλόμενης επιφάνειας ύδατος ή βάση χωρικά 
μεταβολλόμενου βάθους και ταχύτητας. Στην πρώτη περίπτωση ορίζεται ένα αρχικό ύψος της 
ελεύθερης επιφάνειας (συνήθως το ύψος στην αρχική της προσομοίωσης ή ένα μέσο ύψος). 
Στη δεύτερη περίπτωση, οι πληροφορίες για τις αρχικές συνθήκες εισάγονται από κατάλληλα 
αρχεία εισόδου.   

 

• Συνοριακές Συνθήκες: Στο εν λόγω παράθυρο εργασίας καθορίζονται τα χαρακτηριστικά των 
συνοριακών συνθηκών του μοντέλου. Αυτόματα εντοπίζονται από το πρόγραμμα τα 
γεωμετρικά τμήματα με συγκεκριμένους κωδικούς ορίων (πχ. Όριο χερσαίας περιοχής – Land 
boundary) και εμφανίζονται στο χάρτη (Boundary Conditions> Geographic View) και στην 
αντίστοιχη λίστα (Boundary Conditions> List View), μέσω της οποίας θα αποδοθούν στα 
διάφορα τμήμα οι αντίστοιχες συνοριακές συνθήκες.  
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Μπορούν να ορισθούν επτά τύπου συνοριακών συνθηκών για κάθε τμήμα (Boundary 
Conditions> List View> Format): 

• Χερσαία ζώνη (μηδενική κάθετη ταχύτητα) -Land (zero normal velocity): θεωρείται ότι 
ισχύει η full slip συνθήκη, με μηδενική κάθετη ταχύτητα (επιλέγεται αυτόματα για το 
όριο χερσαίας ζώνης) 

• Χερσαία ζώνη (μηδενική ταχύτητα) - Land (zero velocity): θεωρείται ότι ισχύει η no slip 
συνθήκη, με μηδενική κάθετη και εγκάρσια ταχύτητα. 

• Καθορισμένο πεδίο ταχυτήτων 
• Καθορισμένη ροή 
• Καθορισμένο επίπεδο 
• Καθορισμένη απαλλαγή 
• κατάσταση Flather 

Γενικά ή κάθε μια από τις επτά συνοριακές συνθήκες μπορεί να ορισθεί ως: 

• Σταθερή (σε χρόνο και κατά μήκος ορίου) 
• Μεταβλητή στο χρόνο και σταθερή κατά μήκος  
• Μεταβλητή στο χρόνο και κατά μήκος  
• Μια Καμπύλη Αξιολόγησης (Rating Curve) 
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• Τεχνική Αποσύνδεσης (Decoupling): Η τεχνική αποσύνδεσης εφαρμόζεται σε περιπτώσεις που 
το υδροδυναμικό μοντέλο θα χρησιμοποιηθεί σε συνδυασμό με επιπρόσθετα μοντέλα (πχ 
Sand transport) με διαφορετικές παραμέτρους. Τα αποτελέσματα της υπολογιστικής 
διαδικασίας αποθηκεύονται ανά χρονικά βήματα (time step frequency) οδηγώντας έτσι σε 
σημαντική απομείωση του υπολογιστικού χρόνου στην επόμενη ανάλυση.  

 

• Αρχεία Εξόδου (Outputs): Επιλέγεται ο αριθμός των πεδίων εξόδου και εν συνεχεία 
καθορίζονται τα χαρακτηριστικά κάθε αρχείου. Για κάθε επιλεγμένο αρχείο εξόδου πρέπει να 
προσδιορίζονται το είδος του πεδίου (field type), η μορφή του αρχείου εξόδου (output 
format), η αντιμετώπιση της επιλογής πλημμύρα & ξηρασία, το αρχείο εξόδου (όνομα και 
θέση) και το χρονικό βήμα. Ανάλογα με τη μορφή του αρχείου εξόδου πρέπει επίσης να 
διευκρινίζεται η γεωγραφική επέκταση των δεδομένων εξόδου. 

Η μορφή του αρχείου εξόδου προσδιορίζει αν τα αποτελέσματα θα αναφέρονται σε επιφάνεια 
(area series), σε μια γραμμή (line series) ή σε μεμονωμένο σημείο (point series).  
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4.2.4.3 Δημιουργία μοντέλου Στερεομεταφορας (sand transport) 

Έχοντας προεπιλέξει την υπορουτίνα Στερεοπαροχής (Sand Transport Module) στο βήμα 3 – Επιλογή 
Μοντέλου (Module Selection) εμφανίζονται στη λίστα τα σχετικά παράθυρα διαλόγου που καθοδηγούν 
το χρήστη. Τα σημαντικότερα βήματα περιγράφονται θα περιγραφούν αναλυτικά σε ακόλουθη 
παράγραφο καθώς σχετίζονται με την εκάστοτε εφαρμογή.  
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5. ΕΦΑΡΜΟΓΗ ΣΤΟΝ ΠΟΤΑΜΟ ΑΡΑΧΘΟ 

5.1 Εισαγωγή 

Για την εκτίμηση της στερεομεταφοράς κατά μήκος του ποταμού Αράχθου και την εκτίμηση της ολικής 
στερεοπαροχής στην παράκτια ζώνη κρίσιμες παράμετροι είναι κρίσιμη η ορθή προσομοίωση τόσο των 
συνθηκών ροής, όσο και η προσομοίωση ποιοτικά και ποσοτικά της στερεομεταφοράς που λαμβάνει 
χώρα κατά μήκος του ποταμού. Η προσομοίωση των ανωτέρω διεργασιών γίνεται με χρήση του 
προγράμματος HEC RAS και συγκεκριμένα της Ανάλυση Υπολογισμού Στερεομεταφοράς (Sediment 
Transport Analysis). 

Τα βασικά δεδομένα σχεδιασμού είναι η ορθή εισαγωγή της γεωμετρίας του ποταμού, των 
παραμέτρων που θα ληφθούν υπόψη για τη σύσταση και κοκκομετρία των ιζημάτων του πυθμένα αλλά 
και τα δεδομένα παροχών του ποταμού.  

Η προσομοίωση των διεργασιών που έχουν ως αποτέλεσμα την παράκτια στερεομεταφορά που 
παρατηρείται σε μια περιοχή, αποτελείται από τρία διακριτά στάδια, τα οποία περιλαμβάνουν την 
προσομοίωση του κυματικού πεδίου, του υδροδυναμικού πεδίου (ρεύματα κυματογενή αλλά άλλες 
γενεσιουργές αιτίες όπως η εισροή του ποταμού Αράχθου εν προκειμένω) και της στερεομεταφοράς 
(ροή μη συνεκτικών ιζημάτων) αντίστοιχα. Το κάθε ένα από αυτά τα στάδια προσομοιώνεται με την 
κατάλληλη λογισμική μονάδα (module) του πακέτου παράκτιων ομοιωμάτων MIKE21. 

Τα αποτελέσματα της Ανάλυση Υπολογισμού Στερεομεταφοράς, όπως εκτελέστηκε με το πρόγραμμα 
HEC RAS θα εισαχθούν ως πρόσθετη παράμετρος στο πακέτο λογισμικού Mike21.  

5.2 Δεδομένα & Παραδοχές Σχεδιασμού 

5.2.1 Στερεομεταφορά Κατά Μήκος Του Ποταμού Αράχθου 

Τα βασικά δεδομένα σχεδιασμού, όπως αναφέρθηκε και ανωτέρω είναι: 

• Γεωμετρία του ποταμού (κάτοψη του άξονα ροής του ποταμού, διατομές κατά μήκος του 
ποταμού, βασική και πλημμυρική κοίτη), 

• Υδρολογικά δεδομένα (παροχή ποταμού) 
• Κοκκομετρία και Σύσταση των ιζημάτων του πυθμένα.  

5.2.1.1 Γεωμετρία του ποταμού Αράχθου 

Ο ορισμός του άξονα ροής του ποταμού βασίστηκε σε χάρτες του Κτηματολογίου ΑΕ (φωτοληψίες 2007 
– 2009). Οι χάρτες εισήχθησαν σε ψηφιακή μορφή εικόνας στο πρόγραμμα Autocad, βάσει ενιαίου 
συστήματος συντεταγμένων . 
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Εικόνα 5-1: Ψηφιοποιημένος χάρτης περιοχής όδευσης ποταμού Αράχθου (βάση χαρτών κτηματολογίου) 
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Εικόνα 5-2: Άξονας όδευσης και διατομές κατά μήκος του ποταμού Αράχθου  
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Οι διατομές κατά μήκος του άξονα του ποταμού εξήχθησαν από έντυπα σχέδια Διατομών, τα οποία 
συντάχθηκαν στα πλαίσια της «Οριστικής Μελέτης Αντιπλημμυρικών Έργων του π. Αράχθου κατάντη 
των έργων αναριθμήσεων των παροχών του ΥΗΣ Πουρναρίου», το 1984. Σημειώνεται ότι η 
προσομοίωση του υδατορέματος γίνεται κατάντη της περιοχής αβαθών υδάτων που εντοπίζεται 
ακριβώς στα κατάντη του φράγματος Πουρνάρι ΙΙ. 

 

Εικόνα 5-3: Αβαθής περιοχή κατάντη του φράγματος Πουρνάρι ΙΙ - θέση έναρξης όδευσης ΧΘ ποταμού (Δ60)  

Οι διατομές των σχεδίων εισήχθηκαν στο αρχείο Autocad και εν συνεχεία, βάση των φωτογραφιών και 
των διατομών χαράχθηκε ο άξονας ροής του ποταμού. Συνολικά εισήχθησαν 58 διατομές (Δ60-Δ3 από 
ανάντη προς τα κατάντη) με δέκα περίπου σημεία έκαστη. Βάση των εικόνων, οι οποίες είναι και πιο 
πρόσφατες, οι διατομές Δ1 και Δ2 στα κατάντη του ποταμού δεν χρησιμοποιήθηκαν.  

Τα σχέδια του έργου συντάχθηκαν το 1984, ήτοι μετά της κατασκευής του φράγματος Πουρνάρι Ι 
(1981) αλλά προ της κατασκευής του φράγματος Πουρνάρι ΙΙ (1998). Εν τούτοις, συγκρίνοντας τα όρια 
και τα υψόμετρα των ορίων των διατομών με πιο πρόσφατες απεικονίσεις της περιοχής (Google Earth), 
προκύπτει ότι τα δεδομένα συγκλίνουν σε μεγάλο βαθμό και άρα τα εν λόγω Σχέδια Διατομών μπορεί 
να χρησιμοποιηθούν χωρίς να προκύψει ιδιαίτερη απόκλιση στα αποτελέσματα.  

5.2.1.2 Υδραυλικά δεδομένα 

Για την ορθή προσομοίωση των συνθηκών ροής στον ποταμό Άραχθο και άρα της εξαγωγής κατά το 
δυνατό ακριβέστερων ποιοτικών και ποσοτικών πληροφοριών για τη προσχωματική ικανότητα του 
ποταμού απαιτείται η χρήση ρεαλιστικών ιστογραμμάτων παροχής.  

Δ60 
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Σημειώνεται ότι λόγω των Φραγμάτων Πουρνάρι Ι και Πουρνάρι ΙΙ στα ανάντη του ποταμού η παροχή 
στον ποταμό εξαρτάται από τη λειτουργία των φραγμάτων, η οποία σχετίζεται με τις βροχοπτώσεις 
στην ευρύτερη περιοχή. Για το λόγο αυτό η παροχή στο ποταμό εμφανίζει τεράστιες διακυμάνσεις από 
απουσία ροής μέχρι και χειμαρρώδη ροή. 

Κατά συνέπεια η χρήση της μέσης παροχής, η οποία ορίζεται στα 70-60 m3/s, δεν θα έγινε 
αντιπροσωπευτικά αποτελέσματα, καθώς σημαντικό ποσοστό της στερεομεταφοράς εκτελείται και στις 
υψηλές παροχές του ποταμού οπότε και αναπτύσσονται υψηλότερες ταχύτητες ροής.  

Για το λόγο αυτό χρησιμοποιήθηκε αρχείο με τις ημερήσιες εκφορτίσεις από το Πουρνάρι ΙΙ για την 
περίοδο από 2004 μέχρι σήμερα, το οποίο παρασχέθηκε από τον κ. Α. Τσακίρογλου, Διευθυντή του 
Συγκροτήματος Αράχθου. Από το σύνολο των καταγραφών επιλέχθηκε η εξαγωγή στοιχείων για την 
προσομοίωση από τις καταγραφές για το έτος 2009.  

Λόγω περιορισμών στον αριθμό δεδομένων παροχής του προγράμματος HEC RAS και του μεγάλου 
πλήθους των καταγραφών (πάνω από 350) για το έτος 2009, δεν υπήρχε δυνατότητα απευθείας 
εισαγωγής των στοιχείων στο πρόγραμμα. Έτσι κατασκευάστηκε το Υδρογράφημα παροχών του 
ακόλουθου σχήματος, το οποίο και χρησιμοποιήθηκε ως αρχείο εισόδου για την ανάλυση 
στερεομεταφοράς για το πρόγραμμα HEC RAS και άρα σαν δεδομένα σχεδιασμού για την 
προσομοίωση.  

 

Εικόνα 5-4: Δεδομένα παροχής και αντίστοιχο Υδρογράφημα παροχών - χρόνου  
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5.2.1.3 Κοκκομετρία και Σύσταση των ιζημάτων του πυθμένα 

Όπως αναφέρθηκε και ανωτέρω, για την εκτίμηση της σύστασης του υλικού του πυθμένα της κοίτης 
του ποταμού Αράχθου χρησιμοποιούνται οι κοκκομετρίες που προέκυψαν από δειγματοληψίες στα 
κατάντη του ποταμού.  

Βάσει των αποτελεσμάτων ιζηματολογικής ανάλυσης, που παρουσιάζονται στις Εικόνες Εικόνα 2-8 έως 
Εικόνα 2-13, προκύπτουν η ακόλουθη αθροιστική κοκκομετρική καμπύλη. 

Διάμετρος Συγκρατούμενο 
βάρος (gr) 

0Φ 0 
1Φ 13.07 
2Φ 24.46 
3Φ 19.3 
4Φ 29.79 
5Φ 11.2 

ΣΥΝΟΛΟ 97.82 
Πίνακας 5-1: Στατιστική Επεξεργασία Δειγμάτων  

 

Εικόνα 5-5: Κοκκομετρική καμπύλη βάση αποτελεσμάτων ιζηματολογικής ανάλυσης  

Για την εισαγωγή της σύστασης των ιζημάτων πυθμένα στο πρόγραμμα HEC RAS απαιτείται η εισαγωγή 
της αθροιστικής καμπύλης λεπτόκοκκων (%finer) δηλαδή του ποσοστού που είναι μικρότερης 
διαμέτρου, για κάθε κατηγορία κόκκων.  
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Κατά συνέπεια ο Πίνακας της στατιστικής επεξεργασίας των δειγμάτων τροποποιείται κατάλληλα και 
εισάγοντας τα δεδομένα στην καρτέλα του προγράμματος HEC RAS προκύπτει η καμπύλη της Εικόνα 
5-6. 

 
Εικόνα 5-6: Κοκκομετρική καμπύλη λεπτών (% finer) 

5.2.2 Παράκτια Στερεομεταφορά  

5.2.2.1 Γεωμετρία – Βυθομετρία Περιοχής Ενδιαφέροντος  

Από τη συνολική έκταση του Αμβρακικού κόλπου, η περιοχή ενδιαφέροντος περιορίστηκε στην 
εγγύτερη περιοχή των εκβολών του ποταμού Αράχθου, προεκτεινόμενη προς Νότον, από όπου και 
αναμένεται η σημαντικότερη κυματική δράση.  

Το τμήμα του Αμβρακικού κόλπου το οποίο καθορίζεται ως περιοχή μελέτης επισημαίνεται στην Εικόνα 
5-7. Η περιοχή προσομοιώνεται στο μοντέλο του Mike 21 βάση των χαρτών του Garmin Map Source 
(βλ. §2.7.1) και έχει διαστάσεις περίπου 13km x 11km. 

Η περιοχή μελέτης επισημαίνεται στην εικόνα που ακολουθεί.  
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Εικόνα 5-7: Ορισμός περιοχής μελέτης 

 

5.2.2.2 Ανεμολογικά – Κυματικά Στοιχεία 

Για την προσομοίωση του κυματικού πεδίου της περιοχής εισήχθησαν διάφορες κυματικές συνθήκες, 
οι οποίες προέκυψαν από την στατιστική επεξεργασία των ανεμολογικών στοιχείων του σταθμού της 
Ε.Μ.Υ. στην Πρέβεζα (βλ. §2.7.2). Συγκεκριμένα, για την εκλογή του κυματισμού της κάθε διεύθυνσης 
χρησιμοποιήθηκε η έννοια της ροής ενέργειας που προκύπτει από τη συγκεκριμένη διεύθυνση.  

Η έννοια αυτή είναι ανάλογη της στερεομεταφοράς που προκαλείται από μια συγκεκριμένη διεύθυνση 
ανέμου-κυματισμού. Η λεγόμενη ροή ενέργειας δίνεται από το γινόμενο Hi x Ti. Με Hi συμβολίζεται το 
χαρακτηριστικό ύψος κύματος Hs και με Ti η χαρακτηριστική φασματική περίοδος Ts, όπως αυτά 
προέκυψαν με βάση το ανάπτυγμα πελάγους για τις τρεις κρίσιμες διευθύνσεις, Ανατολική, Νότια και 
Δυτική.  

Το ανάπτυγμα πελάγους για κάθε μια από τις τρεις κρίσιμες διευθύνσεις δίνεται στον ακόλουθο 
Πίνακα.  
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Τομέας Ανέμου Ανατολικός 
Α 

Νότιος 
Ν 

Δυτικός 
Δ 

Μήκος 
αναπτύγματος 

(Km) 
7,5 13,2 22,0 

Πίνακας 5-2: Μήκος αναπτύγματος κυματισμού ανά διεύθυνση. 

 

 

Εικόνα 5-8: Ενεργό ανάπτυγμα κυματισμών 

Στους πίνακες που ακολουθούν δίδονται τα μεγέθη του χαρακτηριστικού κύματος σε σχετικά βαθιά 
νερά (χαρακτηριστικό ύψος κύματος Ηs και περίοδος Τs, περίοδος αιχμής Τp και μήκος κύματος Lo) βάση 
της μεθόδου SMB, τα οποία δημιουργούνται από τον άνεμο με τη ταχύτητα σχεδιασμού U10, 
προερχόμενο από τους τομείς ενδιαφέροντος, για κάθε κατηγορία έντασης ανέμου (από 1 έως 11Bf). 
Στον ίδιο πίνακα δίδεται επίσης το ενεργό ανάπτυγμα πελάγους F που αντιστοιχεί σε κάθε διεύθυνση. 
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ΑΝΑΤΟΛΙΚΟΣ ΑΝΕΜΟΣ   Α           
ΕΝΕΡΓΟ 

ΑΝΑΠΤΥΓΜΑ 
ΕΝΤΑΣΗ 

(Βf) 
Συχνότητα 

% Hs Hrms Tm Ts Tp 

7.50 

0 2.770 0.01 0.01 0.33 0.4 0.4 
1 0.066 0.02 0.01 0.54 0.6 0.6 
2 2.093 0.10 0.07 1.11 1.2 1.3 
3 1.622 0.21 0.15 1.64 1.8 2.0 
4 1.063 0.36 0.25 2.10 2.3 2.5 
5 0.493 0.53 0.37 2.53 2.83 3.0 
6 0.208 0.73 0.52 2.94 3.3 3.5 
7 0.066 0.96 0.68 3.33 3.72 4.00 
8 0.022 1.21 0.85 3.70 4.1 4.4 
9 0.011 1.48 1.05 4.06 4.5 4.9 

10 0.000 1.93 1.37 4.57 5.1 5.5 
11 0.000 2.10 1.48 4.74 5.3 5.7 

Πίνακας 5-3: Κυματικά χαρακτηριστικά για ανεμογενή κύματα προερχόμενα από το Ανατολικό τομέα 

 

ΝΟΤΙΟΣ ΑΝΕΜΟΣ  -- Ν           

ΕΝΕΡΓΟ 
ΑΝΑΠΤΥΓΜΑ 

ΕΝΤΑΣΗ 
(Βf) 

Συχνότητα 
% Hs Hrms Tm Ts Tp 

13.20 

0 2.770 0.01 0.01 0.33 0.4 0.4 
1 0.033 0.02 0.02 0.57 0.6 0.7 
2 0.964 0.11 0.08 1.22 1.4 1.5 
3 1.184 0.26 0.18 1.82 2.0 2.2 
4 0.921 0.45 0.31 2.37 2.6 2.8 
5 0.296 0.67 0.47 2.87 3.2 3.4 
6 0.099 0.92 0.65 3.34 3.7 4.0 
7 0.055 1.21 0.85 3.79 4.24 4.55 
8 0.011 1.52 1.08 4.22 4.7 5.1 
9 0.011 1.87 1.32 4.64 5.2 5.6 

10 0.000 2.45 1.73 5.23 5.8 6.3 
11 0.000 2.66 1.88 5.43 6.1 6.5 

Πίνακας 5-4: Κυματικά χαρακτηριστικά για ανεμογενή κύματα προερχόμενα από το Νότιο τομέα 
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ΔΥΤΙΚΟΣ ΑΝΕΜΟΣ  -- Δ           

ΕΝΕΡΓΟ 
ΑΝΑΠΤΥΓΜΑ 

ΕΝΤΑΣΗ 
(Βf) 

Συχνότητα 
% Hs Hrms Tm Ts Tp 

22.00 

0 2.770 0.01 0.01 0.34 0.4 0.4 
1 0.066 0.02 0.02 0.58 0.7 0.7 
2 3.211 0.13 0.09 1.31 1.5 1.6 
3 7.036 0.31 0.22 2.00 2.2 2.4 
4 7.025 0.54 0.38 2.62 2.9 3.1 
5 1.370 0.81 0.58 3.20 3.6 3.8 
6 0.329 1.13 0.80 3.74 4.2 4.5 
7 0.099 1.49 1.05 4.26 4.75 5.11 
8 0.011 1.88 1.33 4.75 5.3 5.7 
9 0.011 2.31 1.64 5.22 5.8 6.3 

10 0.011 3.03 2.14 5.90 6.6 7.1 
11 0.000 3.29 2.33 6.13 6.8 7.4 

Πίνακας 5-5: Κυματικά χαρακτηριστικά για ανεμογενή κύματα προερχόμενα από τον Δυτικό τομέα 

 

Εν συνεχεία, για κάθε κατηγορία έντασης ανέμου υπολογίζονται τα γινόμενα των ροών ενέργειας με τη 

συχνότητα πνοής, σύμφωνα με τον τύπο: 2
i i if H T⋅ ⋅  όπου if  η ετήσια συχνότητα πνοής για την 

ανεμολογική / κυματική κατάσταση i. Ως αντιπροσωπευτικό κύμα για κάθε διεύθυνση ανέμου 
εκλαμβάνεται αυτό που αντιστοιχεί στη μέγιστη ροή ενέργειας κατά τη διεύθυνση αυτή. 

Η συχνότητα ανά έτος που πρέπει να επενεργεί αυτός ο αντιπροσωπευτικός κυματισμός για να 
προκαλέσει την ισοδύναμη στερεομεταφορά με αυτήν που αντιστοιχεί σε όλους τους κυματισμούς της 
διεύθυνσης του, προκύπτει από τον λόγο της συνολικής ροής ενέργειας επί την κάθε συχνότητα πνοής 
(στη συγκεκριμένη διεύθυνση) προς τη μέγιστη ροή ενέργειας. 

Συνεπώς η ζητούμενη συχνότητα του αντιπροσωπευτικού κυματισμού δίνεται από τον τύπο: 

( )2

,max 2
max max

i i i
i

f H T
f

H T

⋅ ⋅
=

⋅

∑
 

Συνεισφορά στο καθεστώς στερεομεταφοράς έχουν οι κυματισμοί που προκύπτουν από εντάσεις 
ανέμου μεγαλύτερες των 3 ΒF. Οι κυματισμοί από ανέμους χαμηλότερων εντάσεων έχουν πολύ χαμηλά 
ενεργειακά χαρακτηριστικά, π.χ. ύψος κύματος κάτω από 0,10 μ και κρίνεται ότι δεν μπορούν να 
προκαλέσουν αξιόλογες μορφολογικές μεταβολές, ενώ δεν παρουσιάζουν και αξιόλογες συχνότητες 
εμφάνισης μέσα στο έτος. Επιπροσθέτως, τα υψηλότερα κυματικά γεγονότα με την περιορισμένη και 
σχεδόν σπάνια διάρκεια εμφάνισης τους δεν σχετίζονται με μέσου επιπέδου μορφολογικές μεταβολές 
στο φυσικό παράκτιο σύστημα. 
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Βάσει των παραπάνω δεδομένων, επελέγη να προσομοιωθούν τα κυματικά επεισόδια που 
αντιστοιχούν σε εντάσεις ανέμου 7BF.  

Έτσι, τα χαρακτηριστικά των αντιπροσωπευτικών κυμάτων ανά διεύθυνση και οι συχνότητες που 
προέκυψαν για το καθένα είναι οι παρακάτω:  

1) Δυτικός κυματισμός ύψους Hs=1,49m και περιόδου Ts=4,75 sec, με ετήσια συχνότητα 5,14% 

(αντιστοιχεί σε ανεμοπνοή 7 Bf).  

2) Νότιος κυματισμός ύψους Hs=1,21 m και περιόδου Ts=4,24 sec, με ετήσια συχνότητα 0,33% 

(αντιστοιχεί σε ανεμοπνοή 7 Bf). 

3) Ανατολικός κυματισμός ύψους Hs=0,96 m και περιόδου Ts=3,72 sec, με ετήσια συχνότητα 0,5% 

(αντιστοιχεί σε ανεμοπνοή 7 Bf).  

Δεδομένου του χρονικού περιορισμού που εισάγεται για την προσομοίωση φαινομένων μεγάλης 
διαρκείας με το πρόγραμμα MIKE21, αντί ολόκληρου του ημερολογιακού έτους, θα προσομοιωθεί το 
χρονικό περιθώριο στο οποίο αντιστοιχεί ο κάθε ένας από τους τρεις αντιπροσωπευτικούς 
κυματισμούς.  

Τα χαρακτηριστικά των κυματισμών σχεδιασμού και η αντίστοιχη χρονική περίοδος, όπως 
παρουσιάζονται στον , θα είναι τα δεδομένα τα οποία θα χρησιμοποιηθούν για την προσομοίωση της 
ετήσιας επιρροής των κυματισμών στην στερεομεταφορά στην ευρύτερη περιοχή των εκβολών του 
ποταμού Αράχθου, σε συνδυασμό με ανεμοπνοή εντάσεως 5Β που θα πνέει από την αντίστοιχη 
κατεύθυνση αλλά και την (μέση) παροχή του ποταμού. 

Διεύθυνση Κυματισμού και Ανέμου Δυτική Νότια Ανατολική 

Ύψος Κύματος, Hs (m) 1,49 1,21 0,96 

Περίοδος Κύματος, Τs (m) 4,75 4,24 3,72 

Ανάπτυγμα πελάγους (km) 22 13,2 7,5 

Μέση Διεύθυνση Ανέμου, ΜWD (o) 270 180 90 

Αντιπροσωπευτική χρονική περίοδος κυματισμού (ημ.) 5,54 1,21 1,82 

Χρονική περίοδος προσομοίωσης (sec.) 100x4450 100x1050 100x1560 
Πίνακας 5-6: Κυματικά χαρακτηριστικά και χρονική περίοδος προσομοίωσης για την παράκτια 

στερεομεταφορά για ένατση ανέμου 7Β 
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5.3 Περιγραφή Ανάλυσης Υπολογισμού Στερεομεταφοράς 

5.3.1 Γενικά 

Η κατασκευή και η ανάλυση του μοντέλου προσομοίωσης του ποταμού Αράχθου, από το φράγμα 
Πουρνάρι ΙΙ στα ανάντη έως και τις εκβολές του ποταμού στον Αμβρακικό κόλπο, ώστε να προκύψουν 
ποσοτικά και ποιοτικά στοιχεία για τη μεταφορά ιζημάτων στην παράκτια ζώνη αποτελείται από 
τέσσερα βασικά βήματα: 

1. Κατασκευή γεωμετρίας μοντέλου προσομοίωσης 
2. Καθορισμός συνθηκών ροής 
3. Καθορισμός στοιχείων ιζηματομεταφοράς 
4. Εκτέλεση Ανάλυσης υπολογισμού στερεομεταφοράς 
5. Εξαγωγή αποτελεσμάτων 

Τα βήματα αυτά περιγράφονται αναλυτικά στις παραγράφους που ακολουθούν. 

5.3.2 Κατασκευή Γεωμετρίας Μοντέλου Προσομοίωσης 

Για την κατασκευή του μοντέλου προσομοίωσης του ποταμού Αράχθου εισάγονται αρχικά οι 
συντεταγμένες των σημείων του άξονα της κοίτης του ποταμού (Edit – Reach Schematic Lines), όπως 
εξήχθησαν από το πρόγραμμα Autocad βάση των χαρτών του Κτηματολογίου (βλ. §5.2.1).  

Το συνολικό μήκος του ποταμού στο μοντέλο είναι περίπου 24500μ.  

Εν συνεχεία εισάγονται οι διατομές (Cross Section) από τη Δ60 έως τη Δ3, από ανάντη προς τα κατάντη 
ανά συγκεκριμένες αποστάσεις. Καθότι ο αριθμός των διατομών σε σχέση με το συνολικό μήκος του 
ποταμού είναι μικρός, χρησιμοποιείται η δυνατότητα που προσφέρει το πρόγραμμα για πύκνωση των 
διατομών, με την οποία δημιουργούνται με γραμμική παρεμβολή μεταξύ των ορισμένων από τον 
χρήστη διατομών, τεχνητές διατομές το πλήθος των οποίων καθορίζεται από το χρήστη.  

Επιλέχθηκε η πύκνωση των διατομών με μέγιστη απόσταση μεταξύ των διατομών 10μ καθ’ όλο το 
μήκος του ποταμού (Geometric Data – Tools – XY interpolation - XY interpolation by Reach). 
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Εικόνα 5-9: Άξονας 
όδευσης και 
διατομές στο 
μοντέλο 
προσοσμοίωση ςτου 
ποταμού Αράχθου. 
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5.3.3 Καθορισμός Συνθηκών Ροής 

Μετά τον καθορισμό των γεωμετρικών 
στοιχείων του μοντέλου προσομοίωσης 
του ποταμού, καθορίζονται οι συνθήκες 
ροής. Για την εκτέλεση Ανάλυσης 
Υπολογισμού Στερεομεταφοράς, οι 
συνθήκες ροής πρέπει να καθοριστούν 
ως Ψευδο- ανομοιόμορφη ροή (Edit - 
Quasi Unsteady Flow (Sediment 
Analysis)), η οποία στην ουσία είναι 
μόνιμη ροή μεταβαλλόμενη ανά 
συγκεκριμένα χρονικά διαστήματα. 

Στην περίπτωση αυτή πρέπει να 
οριστούν οι συνοριακές συνθήκες ροής στις διατομές εισόδου (Δ60) – εξόδου (Δ3). Για την διατομή 
εισόδου επιλέχθηκε ο τύπος συνοριακής συνθήκης Χρονοσειρά Παροχών (Flow Series) ενώ για την 
έξοδο επιλέχθηκε ο τύπος Rating Curve.  

Για τη Χρονοσειρά Παροχών χρησιμοποιήθηκαν τα ομαδοποιημένα στοιχεία παροχών – χρόνου που 
δόθηκαν από τον Υ/Σ Πουρνάρι ΙΙ (βλ. § 5.2.1.2). 

 

Εικόνα 5-10: Εισαγωγή δεδομένων παροχής στο πρόγραμμα HEC RAS και αντίστοιχο Υδογράφημα παροχών - 
χρόνου  
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Παρατηρείται μια μεγάλη κορυφή, με μέγιστη παροχή Qmax=500 m3/s (και δυο –τρεις μικρότερες 
κορυφές με παροχές 250 m3/s έως Q3=200 m3/s, οι οποίες αντιστοιχούν στις περιόδους εκφόρτωσης 
του φράγματος. Λαμβάνοντας υπόψη και τη χρονική διάρκεια του κάθε βήματος, η μέση παροχή 
προκύπτει 75 m3/s , τιμή η οποία συμφωνεί με τις αναφορές στη βιβλιογραφία. 

5.3.4 Καθορισμός Στοιχείων Ιζηματομεταφοράς 

Η εισαγωγή των χαρακτηριστικών των ιζημάτων και η επιλογή των παραμέτρων που θα ληφθούν 
υπόψη για την ανάλυση στερεομεταφοράς δίνονται στην αντίστοιχη καρτέλα (Edit – Sediment Data).  

 

Επιλέγεται αρχικά μια εκ των εξισώσεων υπολογισμού στερεομεταφοράς. Για τη συγκεκριμένη 
ανάλυση επιλέγεται η εξίσωση Αckers-White ως καταλληλότερη καθότι πρόκειται για μια ευρέως 
διαδεδομένη εξίσωση η οποία αποδίδει το Ολικό φορτίο ιζημάτων. 

Εν συνεχεία εισάγονται τα στοιχεία για την παραγωγή της κοκκομετρικής καμπύλης διαβάθμισης του 
ιζήματος (Define / Edit Bed Gradation) (βλ. Εικόνα 5-6: Κοκκομετρική καμπύλη λεπτών (% finer)). 

Έχοντας καθορίσει τη διαβάθμιση του υλικού του πυθμένα, αποδίδεται σε κάθε διατομή μια 
κοκκομετρική καμπύλη (εν προκειμένω η ίδια, το πρόγραμμα όμως δίνει τη δυνατότητα να εισαχθούν 
και να χρησιμοποιηθούν πάνω από μια κοκκομετρικές καμπύλες) καθώς και το βάθος του πυθμένα που 
δύναται να διαβρωθεί (Max Depth). Το εν λόγω βάθος ορίζεται αυθαίρετα ίσο με 3,0μ. 
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Επιπρόσθετα ορίζονται και 
οι συνοριακές συνθήκες 
για τις διατομές εισόδου – 
εξόδου. Ελλείψει 
στοιχείων επιλέγεται το 
Φορτίο Ισορροπίας, στο 
οποίο καθορίζεται το 
φορτίο των εξισώσεων 
στερεομεταφοράς. Στις 
διατομές για τις οποίες 
επιλέγεται αυτή η 
συνοριακή συνθήκη δεν 
προκύπτει απόθεση 
υλικού ή διάβρωση.  

5.3.5 Εκτέλεση Ανάλυσης Υπολογισμού Στερεομεταφοράς 

Έχοντας ολοκλήρωση την κατασκευή του μοντέλου προσομοίωσης του ποταμού Αράχθου, εκτελείται η 
ανάλυση Υπολογισμού Στερεομεταφοράς (Run – Sediment Analysis). 

Στο παράθυρο διαλόγου που εμφανίζεται, δίνεται μεταξύ άλλων, η δυνατότητα ορισμού των στοιχείων 
που θα συμπεριληφθούν στο αρχείο εξόδου (Options – Sediment Output Options). Επιλέγεται το 
«επίπεδο εξόδου» στο οποίο δίνονται πληροφορίες για τη στερεομεταφορά σε όρους μάζας (mass). 

 

Σημειώνεται ότι το χρονικό πλαίσιο της προσομοίωσης πρέπει να είναι το ίδιο (ή μικρότερο) με τα 
χρονικά βήματα για τα οποία δίνονται οι παροχές σχεδιασμού. Στη συγκεκριμένη περίπτωση καλύπτει 
ένα ημερολογιακό έτος από 1η Ιανουαρίου 2009 έως 25 Δεκεμβρίου 2009. 
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5.3.6 Εξαγωγή Αποτελεσμάτων 

Τα αποτελέσματα της ανάλυσης στερεοπαροχής για το μοντέλο προσομοίωσης του ποταμού δίνονται 
είτε για κάθε διατομή (View – Sediment Time Series Plot) (συμπεριλαμβανομένου και των τεχνητών 
διατομών) είτε κατά μήκος της μηκοτομής του ποταμού (View – Sediment Spatial Plot), γραφικά ή σε 
μορφή πίνακα . 

Τα στοιχεία που ενδιαφέρουν για την παρούσα εργασία είναι: 

• Η συνολική παροχή ιζήματος στην έξοδο 
• Η χρονοιστορία παροχής ιζήματος στην έξοδο 
• Η ταχύτητα εκροής. 

Πέραν των ανωτέρω αποτελεσμάτων τα οποία θα χρησιμοποιηθούν ως δεδομένα εισόδου για την 
προσομοίωση της παράκτιας στερεομεταφοράς ελέγχθηκαν και τα αποτελέσματα μεταβολής της 
στάθμης σε διάφορες χαρακτηριστικές διατομές κατά μήκος του ποταμού. Χαρακτηριστικά 
αποτελέσματα της ανάλυσης στερεομεταφοράς παρουσιάζονται στο επόμενο κεφάλαιο της παρούσας 
εργασίας.  

5.4 Περιγραφή Προσομοίωσης Παράκτιας Στερεομεταφοράς 

5.4.1 Γενικά 

Για την εκτίμηση της παράκτιας στερεομεταφοράς στις εκβολές του ποταμού Αράχθου 
χρησιμοποιήθηκε το λογισμικό πακέτο ΜΙΚΕ21 και συγκεκριμένα το υδροδυναμικό μοντέλο 
πεπερασμένων στοιχείων Hydrodynamic Module Finite Mesh.  

Τα φαινόμενα που συνεκτιμούνται στην ανάλυση της παράκτιας στερεομεταφοράς είναι η επιρροή του 
ποταμού Αράχθου, η οποία αποτιμάται με προσομοίωση του ποταμούς το πρόγραμμα HEC RAS όπως 
περιγράφηκε σε προηγούμενες παραγράφους και η ανεμοπνοή και η δράση αντιπροσωπευτικών 
κυματισμών, όπως προσδιορίστηκαν στην § 5.2.2.2. 

Στις παραγράφους που ακολουθούν περιγράφεται η διαδικασία καθορισμού του μοντέλου 
προσομοίωσης και εκτέλεσης των υδροδυναμικών σεναρίων. 

5.4.2 Εισαγωγή Βυθομετρίας Μοντέλου Προσομοίωσης 

Όπως αναφέρθηκε και ανωτέρω για την εισαγωγή της βυθομετρίας του Αμβρακικού Κόλπου 
χρησιμοποιήθηκαν οι χάρτες του συστήματος χαρτογράφησης Garmin Map Source. Αρχικά 
προσομοιώθηκε το σύνολο του Αμβρακικού κόλπου αλλά η περιοχή η οποία προσομοιώθηκε τελικά 
περιορίζεται στην εγγύτερη περιοχή των εκβολών του ποταμού Αράχθου.  
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Η βυθομετρία όπως ορίστηκε με χρήση του αρχείου Mesh Generator παρουσιάζεται στην Εικόνα 5-11: 
Ψηφιοποιημένη βυθομετρία περιφερειακού μοντέλου. 

Στο πλέγμα της βυθομετρίας που κατασκευάστηκε έχουν οριστεί πέντε όρια: 

1. Το όριο ξηράς (Land Boundary) στη ακτογραμμή 

2. Το Ανατολικό όριο 

3. Το Δυτικό όριο 

4. Το Νότιο όριο 

5. Όριο εισροής του ποταμού 

Σε κάθε ένα από αυτά τα όρια θα αποδίδονται και οι κατάλληλες συνοριακές συνθήκες για την ορθή 
προσομοίωση των παράκτιων συνθηκών. 

Σημειώνεται ότι στο μοντέλο βυθομετρίας εισήχθησαν και οι ισοϋψείς +0,5μ, 1,0μ και 2,0μ από ΜΣΘ 
και τα όρια της χερσαίας ζώνης του μοντέλου ορίστηκαν στην ισοϋψή +2,0μ, ώστε να δοθεί η 
δυνατότητα στο πρόγραμμα να επιτρέψει την βύθιση των χαμηλών χερσαίων περιοχών σε περίπτωση 
μεγάλης ροής από τον ποταμό. 
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Εικόνα 5-11: Ψηφιοποιημένη βυθομετρία περιφερειακού μοντέλου 

5.4.3 Υπολογισμός Τάσεων Ακτινοβολίας 

Πέραν της ροής του ποταμού, αξιολογήθηκε και η επίδραση των ανεμογενών κυματισμών στη 
παράκτια ζώνη μελέτης. Για το λόγο αυτό παράχθηκαν οι τάσεις ακτινοβολίας (radiation stresses) για 
τις τρεις κύριες διευθύνσεις προώθησης των κυματισμών, τη Δυτική, τη Νότια και την Ανατολική. 

Τα κυματικά χαρακτηριστικά για κάθε μια από τις τρεις διευθύνσεις προέκυψαν βάσει των 
αντιπροσωπευτικών κυματισμών που προκύπτουν για ανεμοπνοή εντάσεως 7Β, σύμφωνα με τον 
Πίνακας 5-6. 

Για την ανάλυση υπολογισμού των τάσεων ακτινοβολίας χρησιμοποιείται το αρχείο ΜIKE 21 Spectral 
Wave FM. Το μοντέλο χρησιμοποιεί ως αρχεία δεδομένων μόνο το πλέγμα βυθομετρίας που 
παράχθηκε από το αρχείο Mesh Generator.  
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Εικόνα 5-12: Παράθυρο Διαλόγου MIKE 21 Spectral Waves FM 

Tα βήματα που ακολουθούνται για την ανάλυση υπολογισμού των τάσεων ακτινοβολίας είναι: 

 Καθορισμός αρχείου πλέγματος βυθομετρίας (Domain) 

 Καθορισμός χρονικής περιόδου (Τime):  

Η χρονική περίοδος καθορίζεται από ένα συγκεκριμένο πλήθος χρονικών βημάτων και τη 
χρονική διάρκεια του κάθε βήματος. Για τα χρονικά βήματα και τη χρονική διάρκεια των 
βημάτων χρησιμοποιούνται για κάθε κατεύθυνση οι τιμές του Πίνακας 5-6. 

 Οι βασικές εξισώσεις επίλυσης (εφαρμόστηκαν οι προκαθορισμένες εξισώσεις) 

 Άνεμος (Wind Forcing): Εισήχθηκε άνεμος εντάσεως 7Β (15,5m/s) και η αντίστοιχη διεύθυνση, 
ενώ επιλέχθηκε η σχέση υπολογισμού ανεμογενών κυματισμών βάση SPM84. 
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 Καθορισμός αρχικών συνθηκών (Initial Conditions): καθορίστηκαν τα χαρακτηριστικά του 
φάσματος κυματισμών βάσει εμπειρικών σχέσεων από το Shore Protection Manual 1973. Για 
κάθε κατεύθυνση εισάγεται το αντίστοιχο ανάπτυγμα πελάγους ενώ οι συντελεστές του 
φάσματος JONSWAP παραμένουν οι προκαθορισμένοι από το πρόγραμμα. 

 

 Καθορισμός συνοριακών συνθηκών (Boundary Conditions): Καθορίστηκαν οι συνοριακές 
συνθήκες σε κάθε ένα από τα πέντε όρια όπως φαίνονται στην ακόλουθη Εικόνα.  
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Για κάθε ένα από τα όρια πλην του ορίου ξηράς (Land boundary) και του ποταμού (River) 
ορίζεται ως συνοριακή συνθήκη το κύμα στα ανοιχτά για τη διεύθυνση προώθησης που 
εξετάζεται (π.χ. για τον υπολογισμό των τάσεων ακτινοβολίας που προκύπτουν από την 
προώθηση των Δυτικών κυματισμών εισάγονται ως συνοριακές συνθήκες και για τα τρία 
ελεύθερα όρια τα χαρακτηριστικά του Δυτικού κυματισμού στα ανοιχτά).  

 

Ορισμός Αρχείων Εξόδου (Outputs): Για την χρήση των 
υπολογισμών τάσεων ακτινοβολίας από το υδροδυναμικό μοντέλο 
MIKE 21 Flow Model FM θα πρέπει οι τάσεις ακτινοβολίας να 
εξαχθούν για το σύνολο της εξεταζόμενης επιφάνειας, έτσι 
επιλέγεται τύπος αρχείου εξόδου επιφάνειας (Output format – Area 
series). Οι παράμετροι που επιλέγονται να συμπεριληφθούν στο 
αρχείο εξόδου πρέπει οπωσδήποτε να περιλαμβάνουν τις τάσεις 
ακτινοβολίας αλλά και την ταχύτητα των σωματιδίων του νερού, η 
οποία θα χρησιμοποιηθεί για τον καθορισμό των συνοριακών 
συνθηκών στα ανοικτά όρια. 

5.4.4 Καθορισμός Σεναρίων Προσομοίωσης Παράκτιας Ιζηματομεταφοράς 

Έχοντας πλέον καθορίσει τα μεγέθη των δράσεων που επηρεάζουν την παράκτια μεταφορά, ήτοι την 
παροχή του ποταμού και τη δράση των κυματισμών, απομένει ο συνδυασμός του και η εκτίμηση της 
επιρροής της συνδυασμένης δράσης του στην παράκτια στερεομεταφορά. Καθότι όπως 
προαναφέρθηκε δεν είναι δυνατή η προσομοίωση στο MIKE21 ολόκληρου του χρονολογικού έτος, για 
το οποίο υπάρχουν τιμές παροχής, επιλέχθηκε ο συνδυασμός μιας μέσης παροχής (προκύπτει 
75m3/sec σύμφωνα με τα αποτελέσματα του HEC RAS) και των αντιπροσωπευτικών κυματισμών από 
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τις τρεις διευθύνσεις και της μέγιστης παροχής (προκύπτει 500m3/sec σύμφωνα με τα αποτελέσματα 
του HEC RAS με τη συχνότερα εμφανιζόμενη διεύθυνση (τη Δυτική). 

 Σενάριο 1 Σενάριο 2 Σενάριο 3 Σενάριο 4 Σενάριο 5 

Διεύθυνση Κυματισμού και Ανέμου Δυτική Νότια Ανατολική Δυτική Δυτική 

Ένταση ανεμοπνοής (Β) 7Β 7Β 7Β 7Β 7Β 

Ύψος Κύματος, Hs (m) 0,81 0,67 0,81 0,53 0,53 

Περίοδος Κύματος, Τs (m) 3,6 3,2 3,6 2,8 2,8 

Ανάπτυγμα πελάγους (km) 22,0 13,2 22,0 7,5 7,5 

Μέση Διεύθυνση Ανέμου, ΜWD (o) 270 180 270 90 90 

Αντιπροσωπευτική χρονική περίοδος κυματισμού (ημ.) 23,5 5,3 23,5 7,78 7,78 

Παροχή Αράχθου (m3/sec) 75 75 75 500 0 

Χρονική περίοδος προσομοίωσης (sec.) 100x4450 100x1050 100x1560 100x4450 100x4450 
Πίνακας 5-7: Σενάρια συνδυασμένης δράσης κυματισμού και παροχών ποταμού που θα προσομοιωθούν στο 

υδροδυναμικό μοντέλο 

Τα σενάρια συνδυασμένης δράσης κυματισμού και παροχών ποταμού που θα προσομοιωθούν στο 
υδροδυναμικό μοντέλο του MIKE21 παρουσιάζονται στον Πίνακας 5-7. Το Σενάριο 5, στο οποίο 
λαμβάνεται υπόψη η επιρροή μόνο των κυμάτων, ενώ το όριο εκβολής του ποταμού θεωρείται ως 
ξηρά, χρησιμοποιείται για την εκτίμηση της επιρροής αποκλειστικά των κυμάτων στην κίνηση των 
ιζημάτων. Για τα Σενάρια 4 και 5 επιλέχθηκε η προσομοίωση των δυτικών κυματισμών καθώς αυτοί 
είναι οι επικρατέστεροι από άποψη συχνότητας αλλά και οι δυσμενέστεροι από άποψη ενέργειας.  

5.4.5 Εκτέλεση Ανάλυσης 

Έχοντας καθορίσει τη βυθομετρία και τα υδραυλικά (παροχές ποταμού) και υδροδυναμικά (τάσεις 
ακτινοβολίας) φορτία που επιδρούν στην παράκτια περιοχή, κατασκευάζεται το υδροδυναμικό μοντέλο 
MIKE 21 Flow Model FM. 

Τα βασικά βήματα που ακολουθούνται είναι: 

 Καθορισμός αρχείου πλέγματος βυθομετρίας (Domain) 

 Καθορισμός χρονικής περιόδου (Τime):  

Η χρονική περίοδος καθορίζεται από ένα συγκεκριμένο πλήθος χρονικών βημάτων και τη 
χρονική διάρκεια του κάθε βήματος. Για τα χρονικά βήματα και τη χρονική διάρκεια των 
βημάτων χρησιμοποιούνται για κάθε κατεύθυνση οι τιμές του Πίνακας 5-6. 

 Επιλογή μοντέλων (Module Selection) όπου επιλέγεται επιπλέον το μοντέλο Στερεομεταφοράς 
(Sandtransport Module) 

 Καθορισμός Υδροδυναμικού Μοντέλου: 
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• Επιλογή εξισώσεων επίλυσης (Solution Technique): Επιλέγεται ο ταχύτερος αλγόριθμος. 
• Υιοθετούνται οι προκαθορισμές τιμές για το ειδικό βάρος του νερού (Density), το 

ιξώδες και την τραχύτητα πυθμένα, η οποία υπολογίζεται με βάση την εξίσωση 
Manning και συντελεστή Μ=32m1/3/sec. 

• Άνεμος (Wind Forcing): Εισήχθηκε άνεμος εντάσεως 7Β (15,5m/s) και η αντίστοιχη 
διεύθυνση. 

• Τάσεις Ακτινοβολίας: Εισάγονται οι τάσεις ακτινοβολίας (Sxx, Sxy, Syy) που προέκυψαν 
από τον κυματισμό της εξεταζόμενης διεύθυνσης προώθησης. 

 

• Καθορισμός αρχικών συνθηκών (Initial Conditions): Ελλείψει στοιχείων θεωρείται ότι οι 
αρχικές συνθήκες αντιστοιχούν σε κατάσταση ηρεμίας (μηδενική διακύμανση της 
ελεύθερης επιφάνειας και μηδενική ταχύτητα). 

• Καθορισμός συνοριακών συνθηκών (Boundary Conditions): Καθορίζονται οι συνοριακές 
συνθήκες για τα πέντε όρια που έχουν καθοριστεί. Για την ξηρά επιλέγεται ο 
προκαθορισμένος τύπος του «ορίου ξηράς» (με μηδενική ταχύτητα). Για τα ανοιχτά 
όρια στα Ανατολικά, Νότια και Δυτικά όρια επιλέγεται ελλείψη στοιχείων ο τύπος ορίου 
μηδενικής κάθετης ταχύτητας.  

Για το όριο του ποταμού χρησιμοποιείται η συνοριακή συνθήκη καθορισμένης παροχής 
(specified discharge). Καθορίζεται η σταθερή παροχή από το όριο, η οποία τίθεται ίση 
με 75m3/sec για τη περίοδο χαμηλών/μέσων παροχών και 500m3/sec για την περίοδο 
υψηλών παροχών. 
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 Ορισμός Αρχείων Εξόδου (Outputs): Ως αρχεία εξόδου επιλέγονται ένα (1) αρχείο επιφάνειας 
το οποίο καλύπτει την εγγύτερη περιοχή των εκβολών του ποταμού. Τα στοιχεία που 
επιλέχθηκε να εξαχθούν παρουσιάζονται στην ακόλουθη Εικόνα. 
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 Καθορισμός Μοντέλου Στερεομεταφοράς: 

• Καθορίζεται ότι η στερεομεταφορά θα υπολογιστεί έναντι απλού ρεύματος (pure 
current). Επιλέγεται η εξίσωση στερεομεταφοράς κατά van Rijn, καθώς δίνει τη 
δυνατότητα υπολογισμού και του Φορτίου πυθμένα και του φορτίου αιωρήσεως. 

 

 

• Καθορισμός χρονικής περιόδου (Τime): Καθορίζεται η χρονική περίοδος στην οποία θα 
εκκινήσουν οι υπολογισμοί στερεομεταφοράς, η οποία ορίζεται ορισμένα βήματα 
αργότερα από την εκκίνηση της ανάλυσης.  

• Καθορισμός Βασικών Εξισώσεων (Solution Technique): Εφαρμόστηκαν οι 
προκαθορισμένες εξισώσεις, οι οποίες αντιστοιχούν στον γρήγορο αλγόριθμο 
επίλυσης.  

• Καθορισμός φυσικών χαρακτηριστικών ιζημάτων (Sediment Properties): Καθορίζονται 
οι βασικές φυσικές παράμετροι του ιζήματος, ήτοι: 

- Το πορώδες (τέθηκε ίσο με 40%) 

- Η μέση διάμετρος κόκκων (εφαρμόστηκε η μέση διάμετρος κόκκων, η οποία 
σύμφωνα με τις Εικόνες 2-8 έως 2-13 είναι D50=0.125mm) 

- Το ειδικό βάρος των κόκκων (ίσο με 2,65ton/m3) 
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• Καθορισμός αρχικών συνθηκών (Initial Conditions): Θεωρείται ότι το ίζημα είναι σε 
συνθήκες ισορροπίας (Equilibrium conditions) ελλείψει στοιχείων. 

• Καθορισμός συνοριακών συνθηκών (Boundary Conditions): Καθορίζονται οι συνοριακές 
συνθήκες για τα πέντε όρια που έχουν καθοριστεί. Για την ξηρά επιλέγεται ο 
προκαθορισμένος τύπος του «ορίου ξηράς» (με μηδενική ταχύτητα). Για τα ανοιχτά 
όρια στα Ανατολικά, Νότια και Δυτικά όρια επιλέγεται ο τύπος μηδενικής κάθετης 
ταχύτητας, ελλείψη στοιχείων.  
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Για το όριο του ποταμού καθορίζεται συγκεκριμένη τιμή σταθερής παροχής ιζημάτων 
σε μονάδες βάρους ανά όγκο νερού. Συγκεκριμένα: 

• Για την χαμηλή παροχή (75m3/sec) τίθεται  125gr/m3  

 (Q=75m3/sec & Mtr=1,300ton/day) 

• Για την υψηλή παροχή (500m3/sec) τίθεται 765 gr/m3  

 (Q=500m3/sec & Mtr=33,000ton/day) 

 

• Καθορίζεται η μορφολογία του πυθμένα (Morphology): Ορίζεται η μέγιστη πιθανή 
διάβρωση των πρανών της παράκτιας περιοχής.  

• Ορισμός Αρχείων Εξόδου (Outputs): Ως αρχεία εξόδου επιλέγονται ένα (1) αρχείο 
επιφάνειας το οποίο καλύπτει την εγγύτερη περιοχή των εκβολών του ποταμού και ένα 
(1) γραμμικό αρχείο εξόδου, ώστε να αξιολογηθεί η παράκτια στερεομεταφορά στη 
διατομή εξόδου όπου και εντοπίζεται η μέγιστη μεταφορά ιζήματος. 

 

Τα αποτελέσματα από τα δυο υπολογιστικά μοντέλα, το ΜIKE 21 Spectral Wave FM και το 
υδροδυναμικό μοντέλο MIKE 21 Flow Model FM παρουσιάζονται αναλυτικά στο επόμενο κεφάλαιο. 
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Εικόνα 5-13: Γραμμή εξαγωγής αποτελεσμάτων στερεομεταφοράς 

Γραμμή 1 
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6. ΑΠΟΤΕΛΕΣΜΑΤΑ 
 

6.1 Αποτελέσματα Ανάλυσης Υπολογισμού Στερεομεταφοράς 

Όπως αναφέρθηκε και σε προηγούμενη παράγραφο τα αποτελέσματα της Ανάλυσης Υπολογισμού 
Στερεομεταφοράς που εξάγονται από το πρόγραμμα HEC RAS χρησιμοποιούνται ως αρχεία εισόδου για 
το λογισμικό MIKE21 με το οποίο θα γίνει η προσομοίωση της παράκτιας στερεομεταφοράς είναι: 

• Η συνολική παροχή ιζήματος στην έξοδο 
• Η χρονοϊστορία παροχής ιζήματος στην έξοδο 
• Η ταχύτητα εκροής. 

Εξετάζοντας τα αποτελέσματα της ανάλυσης προκύπτει ότι η ροή ομαλοποιείται κοντά στην έξοδο του 
ποταμού λόγω της γεωμετρία της κοίτης και του άξονα του ποταμού στη εν λόγω θέση; ο άξονας 
παραμένει πρακτικά ευθύγραμμος και η κοίτη του ποταμού έχει χονδρικά την ίδια γεωμετρία από τη 
διατομή Δ12 έως και την Δ3. Για το λόγο αυτό και για να αποφυγούν τυχόν αλλοιώσεις των 
αποτελεσμάτων στο όριο τα αποτελέσματα που θα χρησιμοποιηθούν για την εκτίμηση της παράκτιας 
στερεομεταφοράς εξάγονται στη διατομή Δ11, η θέση της οποίας φαίνεται στην Εικόνα που ακολουθεί. 

 

Εικόνα 6-1: Διατομή εξαγωγής αποτελεσμάτων από το πρόγραμμα HEC RAS 
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Στο διάγραμμα που ακολουθεί δίνεται γραφικά η παροχή στην έξοδο του ποταμού Αράχθου 
συναρτήση του χρόνου για το ημερολογιακό έτος 2009. Παρατηρείται μια μεγάλη κορυφή, με μέγιστη 
παροχή Qmax=500 m3/s (η οποία χρησιμοποιείται και στο Σενάριο ροής 4) και δυο –τρεις μικρότερες 
κορυφές με παροχές 250 m3/s έως Q3=200 m3/s, οι οποίες αντιστοιχούν στις περιόδους εκφόρτωσης 
του φράγματος. Χρησιμοποιώντας γραφική μέθοδο η μέση παροχή εκτιμάται περίπου ίση με 100 m3/s 
(χρησιμοποιείται στα Σενάρια 1,2,3).  

Η μέση παροχή αντίστοιχα προκύπτει βάση των συγκεκριμένων καταγραφών ίση με 75 m3/s, παροχή η 
οποία συμπίπτει με την μέση τιμή 70-65 m3/s που εντοπίστηκε σε πολλές βιβλιογραφικές αναφορές. 
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Εικόνα 6-2: Χρονοσειρά παροχής (m3/s) του μοντέλου προσομοίωσης του ποταμού Αράχθου με το πρόγραμμα 
HEC RAS 

Μια άλλη φυσική παράμετρος που ενδιαφέρει για τον έλεγχο του μοντέλου προσομοίωσης του 
ποταμού Αράχθου αλλά και για την προσομοίωση της παράκτιας μεταφοράς είναι η ταχύτητα στη 
εκβολή του ποταμού. Τα αποτελέσματα της ανάλυσης παρουσιάζονται στην Εικόνα 6-3, για τη Δ11. 

Όπως αναμενόταν, τα διαγράμματα της παροχής και της ταχύτητας ταυτίζουν τις αιχμές του χρονικά 
χρονικά, παρουσιάζοντας τη μέγιστη τιμή, 0,86m/s για την μέγιστη παροχή Qmax και δυο - τρεις 
μικρότερες αιχμές με ταχύτητες 0,60- 0,5m/s. Η μέση ταχύτητα εκτιμάται γραφικά ίση με 0,18m/s. 

Η πιο κρίσιμη παράμετρος που εξάγεται από το μοντέλο προσομοίωσης και θα αποτελέσει πρακτικά το 
βασικό δεδομένο εισόδου για την προσομοίωση της παράκτιας στερεομεταφοράς είναι ο όγκος των 
ιζημάτων που μεταφέρονται από τον ποταμό στις εκβολές του και εν συνεχεία στην παράκτια περιοχή.  
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Εικόνα 6-3: Χρονοσειρά ταχύτητας (m/s) του μοντέλου προσομοίωσης του ποταμού Αράχθου με το πρόγραμμα 
HEC RAS στη Δ11. 
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Εικόνα 6-4: Χρονοσειρά μεταφορικής ικανότητας ιζήματος στη διατομή 11 (m3/s) του μοντέλου προσομοίωσης 
του ποταμού Αράχθου με το πρόγραμμα HEC RAS 
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Η φυσική παράμετρος η οποία εκφράζει το μέγεθος των ιζημάτων που μεταφέρονται είναι η 
μεταφορική ικανότητα (transport capacity). Το πρόγραμμα αποδίδει την μεταφορική ικανότητα του 
ποταμού σε μονάδες tons/ day για κάθε διατομή. Τα αποτελέσματα που θα χρησιμοποιηθούν 
εξάγονται από τη διατομή Δ11 και παρουσιάζονται στο Παράρτημα Ι ενώ αποσπασματικά 
(χαρακτηριστικές ροές) στην Εικόνα 6-4. 

Χρονική Στιγμή Παροχή 
(m3/s) 

Ταχύτητα  
(m/s) 

Αθροιστική Ολική μάζα 
που διέρχεται από τη 

διατομή 
(Mass Out Cum: All) 

(tons) 

Ολική μεταφορική 
Ικανότητα 

(Mass Capacity: All) 
(tons/day) 

248 11/14/2009 9:00 500.00 0.86 759,935.00 33,104.90 
249 11/15/2009 9:00 500.00 0.86 804,827.00 32,682.80 
250 11/16/2009 9:00 500.00 0.86 849,528.10 33,903.80 
251 11/16/2009 17:00 200.00 0.47 852,817.30 4,087.80 
252 11/17/2009 1:00 200.00 0.47 856,467.90 4,476.30 
253 11/17/2009 9:00 200.00 0.47 860,208.10 4,903.50 
254 11/18/2009 17:00 100.00 0.27 862,919.10 948.80 
255 11/20/2009 1:00 100.00 0.27 865,702.50 1,024.60 
256 11/21/2009 9:00 100.00 0.27 868,606.60 1,083.30 
257 11/22/2009 1:00 50.00 0.15 868,769.80 138.00 
258 11/22/2009 17:00 50.00 0.15 868,936.10 139.00 
259 11/23/2009 9:00 50.00 0.15 869,103.30 140.00 
276 12/17/2009 1:00 50.00 0.15 882,674.80 165.00 
277 12/17/2009 9:00 50.00 0.15 882,759.80 165.40 
278 12/18/2009 1:00 100.00 0.27 884,382.10 1,287.70 
279 12/18/2009 17:00 100.00 0.27 886,049.00 1,293.90 
280 12/19/2009 9:00 100.00 0.27 887,715.00 1,304.40 
281 12/19/2009 17:00 150.00 0.38 890,050.60 3,687.90 
282 12/20/2009 1:00 150.00 0.38 892,353.20 3,711.60 
283 12/20/2009 9:00 150.00 0.38 894,676.20 3,714.70 

Πίνακας 6-1: Στοιχεία ροής στη Δ11 για το ημερολογιακό έτος 2009 από τα αποτελέσματα του προγράμματος 
HEC RAS 

Δεδομένου των χρονικών περιορισμών που υπεισέρχονται στην προσομοίωση μακράς διαρκείας 
χρονικών περιόδων με το λογισμικό πακέτο MIKE 21, οι οποίοι δεν επιτρέπουν την προσομοίωση 
ολόκληρου του ημερολογιακού έτους, επιλέχθηκε η προσομοίωση δύο αντιπροσωπευτικών χρονικών 
περιόδων χαμηλής και υψηλής ροής αντίστοιχα.  

Οι χρονικές περίοδοι υψηλής ροής που επιλέχθηκαν να προσομοιωθούν στο μοντέλο παράκτιας 
ιζηματομεταφοράς έχουν επισημανθεί με μπλε χρώμα στον Πίνακας 6-1.  
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Για τον υπολογισμό της μεταφορικής ικανότητας της μέσης ροής (75m3/s) κατασκευάστηκε καμπύλη 
παροχής – μεταφορικής ικανότητας και παράχθηκε η καμπύλη που προσεγγίζει την κατανομή. 
Επιλέχθηκε καμπύλη πολυωνύμου 2ας τάξης, όπως φαίνεται και στο σχήμα που ακολουθεί.  

 

Εικόνα 6-5: Καμπύλη μεταφορικής ικανότητας ιζήματος στη διατομή 11 (m3/s) του μοντέλου προσομοίωσης 
του ποταμού Αράχθου με το πρόγραμμα HEC RAS 

Βάση της σχέσης που εξάχθηκε υπολογίστηκε ότι η στερεομεταφορά που αντιστοιχεί στη μέση παροχή 
των 75m3/s είναι περίπου 805ton/day = 125 gr/sec. 

 

6.2 Αποτελέσματα Προσομοίωσης Παράκτιας Στερεομεταφοράς 
 

6.2.1 Αποτελέσματα ανάλυσης τάσεων ακτινοβολίας 

Τα αποτελέσματα της ανάλυσης υπολογισμού των τάσεων ακτινοβολίας, που εισάγονται κατάλληλα 
στο υδροδυναμικό μοντέλο παράκτιας στερεομεταφοράς παρουσιάζονται ακολούθως. Η παράμετρος 
που παρουσιάζεται γραφικά είναι το ύψος κύματος, για κάθε μια από τις τρεις κρίσιμες διευθύνσεις. 
Επίσης εξάγονται και διαγράμματα που παρουσιάζουν το ύψος κύματος σε έξι χαρακτηριστικά σημεία, 
όπως φαίνονται στην εικόνα που ακολουθεί. 
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Εικόνα 6-6: Βυθομετρία υπολογιστικού μοντέλου και επισήμανση των έξι σημείων ελέγχου 

 

Εικόνα 6-7: Χρονοιστορία χαρακτηριστικού κύματος σε έξι σημεία για την Ανατολική διεύθυνση 
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Εικόνα 6-8: Χρονοιστορία χαρακτηριστικού κύματος σε έξι σημεία για την Νότια διεύθυνση 

 

Εικόνα 6-9: Χρονοιστορία χαρακτηριστικού κύματος σε έξι σημεία για την Δυτική διεύθυνση 
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Παρατηρούμε ότι, όπως αναμενόταν λόγω των σταθερών συνθηκών που γενούν του κυματισμούς στην 
προσομοίωση, από μια χρονική στιγμή και μετά, τα κυματικά χαρακτηριστικά σε κάθε σημείο του 
πλέγματος σταθεροποιούνται.  

Σημείο 
Βάθος 

(m) 
Ύψος Κύματος 

Ανατολική Διεύθυνση Νότια Διεύθυνση Δυτική Διεύθυνση 
1 -0,5 0,07 0,05 0,125 
2 -1,0 0,24 0,28 0,25 
3 -3,0 0,65 0,94 0,74 
4 -8,0 0,92 1,20 0,85 
5 -30,0 1,08 1,28 1,30 
6 -38,0 1,10 1,30 1,40 
Πίνακας 6-2: Ύψη κύματος κοντά στις εκβολές του ποταμού, συναρτήση του βάθους και της διεύθυνσης 

προώθησης 

Λόγω και των αρχικών κυματικών συνθηκών δυσμενέστερη διεύθυνση είναι η Δυτική η οποία λόγω του 
μεγαλύτερου αναπτύγματος πελάγους σε σχέση με τις άλλες δυο κύριες διευθύνσεις παρουσιάζει και 
το δυσμενέστερο κύματα στα βαθειά νερά και μετά την προώθηση στην περιοχή εκβολής του ποταμού.  

Εν γένει όμως οι κυματισμοί είναι ιδιαιτέρως χαμηλοί, οριακά άνω του 1,0μ ύψους κύματος για βάθη 
μικρότερα από 10μ, όπου και αναμένεται ο κύριος όγκος στερεομεταφοράς, οπότε αναμένεται να 
έχουν μικρή επίδραση στην παράκτια ιζηματομεταφορά.  
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Εικόνα 6-10: Προώθηση Ανατολικών Κυματισμών στην παράκτια περιοχή εκβολών του ποταμού 

Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 
Ανατολική 7Β 
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Εικόνα 6-11: Προώθηση Νότιων Κυματισμών στην παράκτια περιοχή εκβολών του ποταμού 

Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 
Νότια 7Β 
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Εικόνα 6-12: Προώθηση Δυτικών Κυματισμών στην παράκτια περιοχή εκβολών του ποταμού 

Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 
Δυτική 7Β 

 

 

Σημειώνεται ότι στα ανωτέρω γραφήματα, οι περιοχές με γκρι χρώμα εντός των ορίων της βυθομετρίας 
αντιστοιχούν σε χερσαίες περιοχές με χαμηλό υψόμετρο και όχι σε υπολογιστική αδυναμία του 
προγράμματος.  
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6.2.2 Αποτελέσματα ανάλυσης παράκτιας στερεομεταφοράς 

Η διαδικασία κατασκευής του μοντέλου προσομοίωσης της παράκτιας στερεομεταφοράς περιγράφηκε 
αναλυτικά σε προηγούμενη παράγραφο. Στην παρούσα παράγραφο παρουσιάζονται τα αποτελέσματα 
της υπολογιστικής διαδικασίας για τα τέσσερα σενάρια υδροδυναμικών και υδραυλικών συνθηκών, 
όπως παρουσιάστηκαν στον Πίνακας 5-7, ήτοι: 

• Σενάριο 1: Συνδυασμένη δράση Δυτικών κυματισμών και μέσης παροχής ποταμού 
• Σενάριο 2: Συνδυασμένη δράση Νότιων κυματισμών και μέσης παροχής ποταμού 
• Σενάριο 3: Συνδυασμένη δράση Ανατολικών κυματισμών και μέσης παροχής ποταμού 
• Σενάριο 4: Συνδυασμένη δράση Δυτικών κυματισμών και μέγιστης παροχής ποταμού 
• Σενάριο 5: Δράση μόνο Δυτικών κυματισμών 

Τα αποτελέσματα παρουσιάζονται σε μορφή γραφικής απεικόνισης της περιοχής εκβολής σε κάτοψη, 
ενώ εξάγονται και πληροφορίες για συγκεκριμένα σημεία κοντά στην εκβολή ώστε να γίνει σύγκριση 
της επιρροής της κάθε κυματικής διεύθυνσης. 

Τα αποτελέσματα που παρουσιάζονται αφορούν τις ακόλουθες παραμέτρους: 

 Μεταβολή πυθμένα 
 Ολικό Ίζημα (m3/s /m) 

Τα αποτελέσματα των ανωτέρω παραμέτρων εξάγονται στο τελικό βήμα της χρονικής προσομοίωσης. 
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Σενάριο 1 Παροχή υδατορέματος: Μέση 
Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 

Δυτική 7Β 
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Εικόνα 6-14: Στερεομεταφορά στην παράκτια περιοχή εκβολών του ποταμού –Σενάριο 2 

Σενάριο 2 Παροχή υδατορέματος: Μέση 
Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 

Νότια 7Β 
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Εικόνα 6-15: Στερεομεταφορά στην παράκτια περιοχή εκβολών του ποταμού –Σενάριο 3 

Σενάριο 3 Παροχή υδατορέματος: Μέση 
Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 

Ανατολική 7Β 

 
 

   111 από 128 



Εκτίμηση της Στερεοπαροχής Κατά Μήκος του Ποταμού Αράχθου και των Επιπτώσεων στην Παράκτια Ζώνη 
 

 

Εικόνα 6-16: Στερεομεταφορά στην παράκτια περιοχή εκβολών του ποταμού –Σενάριο 4 

Σενάριο 4 Παροχή υδατορέματος: Μέγιστη 
Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 

Δυτική 7Β 
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Εικόνα 6-17: Στερεομεταφορά στην παράκτια περιοχή εκβολών του ποταμού –Σενάριο 5 

Σενάριο 5 Παροχή υδατορέματος: - 
Διεύθυνση Προώθησης Κυματισμού: Ένταση ανεμοπνοής 

Δυτική 7Β 
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7. ΣΥΜΠΕΡΑΣΜΑΤΑ 

7.1 Γενικά 

Αντικείμενο της παρούσης εργασίας ήταν η διερεύνηση της στερεομεταφοράς κατά μήκος του ποταμού 
Αράχθου αλλά και στην εγγύτερη παράκτια περιοχή και η συνεκτίμηση των φυσικών παραγόντων που 
την επηρεάζουν. 

Η διαδικασία προσομοίωσης χωρίστηκε σε δύο στάδια: 

 Στη προσομοίωση του ποταμού Αράχθου, ώστε να προσεγγιστεί η στερεομεταφορά κατά μήκος 
του ποταμού και να υπολογιστούν τα υδραυλικά φορτία που εισάγει στην παράκτια ζώνη, αλλά 
και το συνολικό φορτίο που μεταφέρεται στην παράκτια περιοχή. 

 Στην προσομοίωση της παράκτιας περιοχής, ώστε να εκτιμηθεί η επιρροή και η αλληλεπίδραση 
των φυσικών δράσεων των ανεμογενών κυμάτων και της εισροής του ποταμού στην κίνηση των 
ιζημάτων τόσο του φυσικού πυθμένα όσο και αυτών που μεταφέρονται από το ποταμό. 

Ακολούθως γίνεται σχολιασμός των αποτελεσμάτων στα δύο στάδια και σύγκρισή τους με σχετικές 
αναφορές σε βιβλιογραφικές πηγές. 

7.2 Προσομοίωση κατά μήκος του ποταμού Αράχθου 

Συγκρίνοντας τα αποτελέσματα της υπολογιστικής διαδικασίας εκτίμησης της στερεοπαροχής κατά 
μήκος του ποταμού Αράχθου και της συμβολής του στην τροφοδοσία της παράκτιας περιοχής 
παρατηρούμε καταρχάς ότι τα αποτελέσματα που προέκυψαν προσεγγίζουν σε ικανοποιητικό βαθμό.  

Χαρακτηριστικές τιμές ροής νερού και ιζήματος δίνονται στον Πίνακα που ακολουθεί [Poulos S.E. 2005] 

Μέση ετήσια παροχή νερού (m3/sec) 70 
Μέγιστη Μηνιαία παροχή (m3/sec) 167 (Δεκ) 
Ελάχιστη Μηνιαία παροχή (m3/sec) 4 (Αυγ) 
Μέση ετήσια ροή αιωρούμενων ιζημάτων (106t) 7,31 

Πίνακας 7-1: Ροή νερού και ιζήματος κατά μήκος του ποταμού Αράχθου (θέση μετρήσεων: γεφύρι της Άρτας) 
[Poulos 2005] 

Η μέση ετήσια παροχή νερού προέκυψε ίση με 75m3/sec, τιμή η οποία συνάδει με αυτή που προκύπτει 
από τη βιβλιογραφία. Η διακύμανση στην παροχή είναι από 7m3/s (οικολογική παροχή) έως 500m3/sec, 
διαφορά η οποία αποδίδεται στην μεγάλη ανομοιομορφία της ροής που παρουσιάζει ο ποταμός 
Άραχθος λόγω της λειτουργίας του Φράγματος Πουρναρίου. 
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Η ετήσια παροχή αιωρούμενων ιζημάτων όπως παρουσιάζεται στον Πίνακα 7-1 είναι κατά πολύ 
μεγαλύτερη αυτής που υπολογίζεται στην έξοδο του ποταμού. Σημειώνεται όμως ότι καθότι η θέση 
μετρήσεων είναι στα ανάντη της εκβολής και μάλιστα πολύ κοντά στην αρχή της κοίτης του ποταμού 
κατάντη του φράγματος Πουρναρίου, σημαντικό ποσοστό αυτών των ιζημάτων αποτίθεται και στην 
κοίτη του ποταμού, η οποία παρουσιάζει μεγάλες προσχωματικές περιοχές.  

Επίσης σε άλλη βιβλιογραφική πηγή [Χαλκιά Χ. 2012] γίνεται αναφορά στο σύνολο των φερτών υλών 
που αποτίθενται «στη χαμηλή προσχωματική περιοχή, το Δέλτα και τον Αμβρακικό κόλπο», το οποίο 
αποτιμάται περί τα 700,000m3/έτος, δηλαδή περίπου 1,855,000tons/έτος. Η τιμή αυτή συμπίπτει σε 
μεγάλο βαθμό με αυτή που προέκυψε από την υπολογιστική διαδικασία, σύμφωνα με την οποία η 
συνολική μεταφερόμενη μάζα στην διατομή εξόδου εντός του έτους 2009 είναι 951,601.1tons.  

Σημειώνεται ότι σε διατομές στα ανάντη, η συνολική μεταφερόμενη μάζα ανέρχεται σε 7,577,112.0 
tons (Δ45 κοντά στο φράγμα Πουρναρίου) τιμή η οποία συνάδει και με αυτή που δίνεται στον Πίνακα 
7-1. 
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Εικόνα 7-1: Συνολική μεταφερόμενη μάζα από τη διατομή Δ45 για το ημερολογιακό έτος 2009βάση του 

μοντέλου προσομοίωσης του ποταμού Αράχθου με το πρόγραμμα HEC RAS 

Κατά συνέπεια η προσομοίωση με το πρόγραμμα HEC RAS θεωρείται ότι προσεγγίζει σε ικανοποιητικό 
βαθμό την πραγματική στερεομεταφορά κατά μήκος του ποταμού, δεδομένης και της έλλειψης πιο 
συγκεκριμένων στοιχείων εισόδου, της έντονης ανομοιομορφίας στη ροή του ποταμού αλλά και την 
ελλιπή βιβλιογραφία σχετικά με τη μάζα ιζημάτων που τελικά προσφέρεται στον Αμβρακικό κόλπο.  
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Σημειώνεται επίσης η μεγάλη απόκλιση των αποτελεσμάτων σε σχέση με την επιλεγμένη εξίσωση 
υπολογισμού της στερεομεταφοράς (βλ. § 3.4.3), η οποία ούτως ή άλλως επισημαίνεται και στη διεθνή 
βιβλιογραφία παρατηρήθηκε και στην πορεία εξέλιξης της παρούσας εργασίας.  

Οι μεγάλες διαφορές που παρουσιάζουν τα αποτελέσματα της κάθε μεθόδου καθιστούν απαραίτητη τη 
σύγκριση με μετρήσεις (αν υπάρχουν) ή οποιουδήποτε είδους έμμεσες καταγραφές στερεοπαροχών ή 
απεικονίσεις εξέλιξης την κοίτης και των ορίων των διατομών του ποταμού.  

7.3 Προσομοίωση στερεομεταφοράς στην παράκτια περιοχή 

Τα αποτελέσματα της προσομοίωσης της παράκτιας ιζηματομεταφοράς αποτυπώνουν γεγονότα μικρής 
χρονικής διάρκειας (μερικές μέρες), λόγω χρονικών περιορισμών που εισάγει η ταχύτητα υπολογισμού 
του λογισμικού πακέτου MIKE21, οπότε δεν ήταν δυνατή η προσομοίωση ολόκληρου του χρονολογικού 
έτους, όπως με το πρόγραμμα HEC RAS. Κατά συνέπεια τα συμπεράσματα σχετικά με την παράκτια 
κίνηση των ιζημάτων είναι περισσότερο ποιοτικά παρά ποσοτικά. 

Η παρατήρησης των αποτελεσμάτων της κίνησης των ιζημάτων στην παράκτια περιοχή κοντά στις 
εκβολές του ποταμού Αράχθου, όπως αυτή παρουσιάζεται στις Εικόνες 6-13 με 6-17, οδηγεί στα εξής 
συμπεράσματα: 

1. Η κίνηση των ιζημάτων αφορά κατά κύριο λόγο τα ιζήματα που προσφέρονται από τον ποταμό 
Άραχθο και όχι αυτά που δημιουργούνται από διάβρωση λόγω κυματικής δράσης. 

2. Η επιρροή των κυματισμών στην παράκτια στερεομεταφορά είναι πολύ μικρή.  

Αυτό οφείλεται σε μεγάλο βαθμό στην πολύ μικρή ενέργεια των προωθούμενων κυματισμών, 
κυρίως λόγω των μικρών αναπτυγμάτων πελάγους αλλά και του ότι οι καταγραφές 
ανεμοπνοών οριακά φθάνουν τα 10Β (για τη Δυτική διεύθυνση). 

3. Η Ανατολική και η Νότια διεύθυνση φαίνεται να επηρεάζουν σε μικρό βέβαια βαθμό, τη 
στερεομεταφορά στην παράκτια περιοχή καθότι στις Εικόνα 6-14 και Εικόνα 6-15 όπου 
συνυπολογίζεται η ροή του ποταμού, παρουσιάζεται απόθεση ιζήματος και σε περιοχές μακριά 
από την εκβολή του ποταμού, συγκεκριμένα στα νότια και νοτιοανατολικά αντίστοιχα. 

Αντίθετα η Δυτική διεύθυνση, λόγω των πιο ισχυρών ενεργειακών χαρακτηριστικών, οδηγεί και 
σε μικρή διάβρωση του πυθμένα στα νοτιοδυτικά.  

4. Η προσφορά ιζήματος από τον ποταμό Άραχθο φαίνεται περιορισμένη, ειδικά σε περιόδους 
μέσων και χαμηλών παροχών και περιορίζεται μόνο τοπικά, στην εκβολή του ποταμού.  

5. Αντίθετα σε περιόδους υψηλών παροχών, οι οποίες όμως εμφανίζονται 1-3 φορές το χρόνο 
(σύμφωνα με τις καταγραφές που παρασχέθηκαν), αποτίθεται στην περιοχή εκβολής 
σημαντική ποσότητα ιζήματος.  
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Ειδικότερα για την μέγιστη παροχή των 500m3/s, τοπικά η απόθεση του ιζήματος ξεπερνά την 
επιφάνεια της θάλασσας δημιουργώντας χερσαία περιοχή (μεταβολή στάθμης πυθμένα έως 
και 2,5μ τοπικά) κάτι που ουσιαστικά οδηγεί σε αναδιαμόρφωση της εκβολής και σε 
επιμήκυνση του δελταϊκού λοβού, τουλάχιστον μέχρι να δράσουν και πάλι οι κυματικές 
δυνάμεις.  

 

Εν κατακλείδι, τα αποτελέσματα της παρούσας εργασίας συνάδουν με τις αναφορές σε βιβλιογραφικές 
πηγές οι οποίες αναφέρουν ότι ο δελταϊκός λοβός τείνει να στρέφεται προς τα ανατολικά, λόγω των 
δυσμενών δυτικών κυματισμών και ότι η προσφορά ιζήματος είναι πολύ μικρή και δεν συνεισφέρει 
στην προέλαση της ακτής. Αντίθετα φαίνεται να υπάρχει σχετική ισορροπία μεταξύ της τάσης 
απόθεσης λόγω του ποταμού και των δυνάμεων διάβρωσης από την κυματική δράση.  
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ΠΑΡΑΡΤΗΜΑ Ι: Στοιχεία ροής στη Δ11 για το ημερολογιακό έτος 2009 
από τα αποτελέσματα του προγράμματος HEC RAS 
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Time 
Flow 
(m3/s) Velocity (m/s) Mass Out Cum: All (tons) Mass Capacity: All (tons/day) 

1 1/1/2009 10:00 250.00 0.55 0.00 8,045.50 
2 1/2/2009 18:00 250.00 0.55 19,989.49 8,045.50 
3 1/4/2009 2:00 250.00 0.55 40,334.08 9,134.70 
4 1/5/2009 9:00 250.00 0.55 60,363.23 9,015.60 
5 1/7/2009 17:00 150.00 0.38 72,199.45 2,871.10 
6 1/10/2009 1:00 150.00 0.38 84,072.66 3,150.40 
7 1/12/2009 9:00 150.00 0.38 96,022.25 3,266.80 
8 1/13/2009 1:00 100.00 0.27 97,424.75 1,135.20 
9 1/13/2009 17:00 100.00 0.27 98,900.48 1,113.20 

10 1/14/2009 9:00 100.00 0.27 100,442.10 1,105.30 
11 1/17/2009 1:00 50.00 0.15 101,030.70 137.50 
12 1/19/2009 17:00 50.00 0.15 101,632.20 141.00 
13 1/22/2009 9:00 50.00 0.15 102,246.20 143.00 
14 1/23/2009 1:00 100.00 0.27 103,843.00 1,155.80 
15 1/23/2009 17:00 100.00 0.27 105,473.30 1,156.10 
16 1/24/2009 9:00 100.00 0.27 107,106.30 1,164.60 
17 1/25/2009 1:00 200.00 0.47 114,658.10 6,511.20 
18 1/25/2009 17:00 200.00 0.47 121,787.00 6,682.80 
19 1/26/2009 9:00 200.00 0.47 129,117.40 6,513.00 
20 1/26/2009 17:00 150.00 0.38 131,284.80 2,762.50 
21 1/27/2009 1:00 150.00 0.38 133,609.70 2,749.80 
22 1/27/2009 9:00 150.00 0.38 135,917.20 2,874.40 
23 1/28/2009 9:00 300.00 0.62 158,751.00 13,489.20 
24 1/29/2009 9:00 300.00 0.62 181,062.90 13,656.80 
25 1/30/2009 9:00 300.00 0.62 203,106.10 14,368.80 
26 1/30/2009 17:00 200.00 0.47 207,054.40 5,815.00 
27 1/31/2009 1:00 200.00 0.47 211,114.90 6,663.70 
28 1/31/2009 9:00 200.00 0.47 215,243.30 6,825.80 
29 1/31/2009 17:00 100.00 0.27 216,032.20 1,257.50 
30 2/1/2009 1:00 100.00 0.27 216,843.00 1,262.10 
31 2/1/2009 9:00 100.00 0.27 217,654.70 1,270.00 
32 2/2/2009 1:00 200.00 0.47 225,292.30 6,906.40 
33 2/2/2009 17:00 200.00 0.47 232,836.80 5,478.80 
34 2/3/2009 9:00 200.00 0.47 240,274.90 6,149.80 
35 2/5/2009 9:00 150.00 0.38 250,717.20 3,376.70 
36 2/7/2009 9:00 150.00 0.38 261,065.10 2,990.40 
37 2/9/2009 9:00 150.00 0.38 271,378.10 3,139.30 
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38 2/9/2009 17:00 200.00 0.47 275,309.30 6,112.60 
39 2/10/2009 1:00 200.00 0.47 279,454.00 6,148.10 
40 2/10/2009 9:00 200.00 0.47 283,628.30 6,340.30 
41 2/10/2009 17:00 100.00 0.27 284,428.20 1,180.20 
42 2/11/2009 1:00 100.00 0.27 285,244.90 1,196.80 
43 2/11/2009 9:00 100.00 0.27 286,069.60 1,214.20 
44 2/12/2009 17:00 200.00 0.47 300,009.10 5,729.00 
45 2/14/2009 1:00 200.00 0.47 313,554.80 6,124.00 
46 2/15/2009 9:00 200.00 0.47 327,034.60 6,065.30 
47 2/16/2009 17:00 150.00 0.38 334,281.80 3,172.50 
48 2/18/2009 1:00 150.00 0.38 341,671.20 3,311.70 
49 2/19/2009 9:00 150.00 0.38 349,096.10 3,455.00 
50 2/20/2009 17:00 100.00 0.27 351,932.90 1,246.00 
51 2/22/2009 1:00 100.00 0.27 354,871.80 1,271.70 
52 2/23/2009 9:00 100.00 0.27 357,869.80 1,288.80 
53 2/24/2009 9:00 50.00 0.15 358,122.90 165.00 
54 2/25/2009 9:00 50.00 0.15 358,378.80 165.90 
55 2/26/2009 9:00 50.00 0.15 358,636.50 165.90 
56 2/26/2009 17:00 10.00 0.03 358,636.50 0.00 
57 2/27/2009 1:00 10.00 0.03 358,636.50 0.00 
58 2/27/2009 9:00 10.00 0.03 358,636.50 0.00 
59 2/27/2009 17:00 50.00 0.15 358,722.50 166.00 
60 2/28/2009 1:00 50.00 0.15 358,809.50 166.20 
61 2/28/2009 9:00 50.00 0.15 358,897.40 167.00 
62 3/2/2009 1:00 10.00 0.03 358,897.40 0.00 
63 3/3/2009 17:00 10.00 0.03 358,897.40 0.00 
64 3/5/2009 9:00 10.00 0.03 358,897.40 0.00 
65 3/5/2009 17:00 50.00 0.15 358,984.50 167.00 
66 3/6/2009 1:00 50.00 0.15 359,071.60 166.90 
67 3/6/2009 9:00 50.00 0.15 359,160.00 167.40 
68 3/7/2009 17:00 200.00 0.47 373,240.90 5,585.60 
69 3/9/2009 1:00 200.00 0.47 386,496.50 6,067.50 
70 3/10/2009 9:00 200.00 0.47 399,752.30 6,053.10 
71 3/10/2009 17:00 250.00 0.55 405,816.40 9,656.50 
72 3/11/2009 1:00 250.00 0.55 412,014.60 10,092.00 
73 3/11/2009 9:00 250.00 0.55 418,219.20 10,631.70 
74 3/11/2009 17:00 200.00 0.47 422,334.60 6,834.30 
75 3/12/2009 1:00 200.00 0.47 426,506.50 6,904.10 
76 3/12/2009 9:00 200.00 0.47 430,694.80 6,933.70 
77 3/13/2009 9:00 150.00 0.38 436,564.40 3,600.30 
78 3/14/2009 9:00 150.00 0.38 442,367.30 3,595.70 
79 3/15/2009 9:00 150.00 0.38 448,188.80 3,592.30 
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80 3/15/2009 17:00 200.00 0.47 452,242.40 6,928.50 
81 3/16/2009 1:00 200.00 0.47 456,421.00 6,941.40 
82 3/16/2009 9:00 200.00 0.47 460,589.90 6,947.90 
83 3/16/2009 17:00 100.00 0.27 461,380.30 1,283.10 
84 3/17/2009 1:00 100.00 0.27 462,190.80 1,283.30 
85 3/17/2009 9:00 100.00 0.27 463,008.30 1,287.10 
86 3/17/2009 17:00 50.00 0.15 463,091.90 163.00 
87 3/18/2009 1:00 50.00 0.15 463,176.60 163.00 
88 3/18/2009 9:00 50.00 0.15 463,261.50 163.00 
89 3/18/2009 17:00 100.00 0.27 464,096.00 1,293.80 
90 3/19/2009 1:00 100.00 0.27 464,923.90 1,301.20 
91 3/19/2009 9:00 100.00 0.27 465,760.00 1,306.00 
92 3/19/2009 17:00 50.00 0.15 465,847.80 167.00 
93 3/20/2009 1:00 50.00 0.15 465,934.80 167.20 
94 3/20/2009 9:00 50.00 0.15 466,022.00 167.80 
95 3/20/2009 17:00 100.00 0.27 466,856.10 1,310.50 
96 3/21/2009 1:00 100.00 0.27 467,692.90 1,312.30 
97 3/21/2009 9:00 100.00 0.27 468,530.00 1,313.70 
98 3/21/2009 17:00 50.00 0.15 468,618.20 167.60 
99 3/22/2009 1:00 50.00 0.15 468,706.90 167.80 

100 3/22/2009 9:00 50.00 0.15 468,796.20 167.80 
101 3/24/2009 17:00 100.00 0.27 473,638.20 1,309.30 
102 3/27/2009 1:00 100.00 0.27 478,334.20 1,304.20 
103 3/29/2009 9:00 100.00 0.27 483,087.40 1,304.80 
104 3/29/2009 17:00 150.00 0.38 485,305.00 3,658.00 
105 3/30/2009 1:00 150.00 0.38 487,607.00 3,658.80 
106 3/30/2009 9:00 150.00 0.38 489,845.20 3,661.00 
107 4/1/2009 17:00 100.00 0.27 494,699.80 1,306.30 
108 4/4/2009 1:00 100.00 0.27 499,522.20 1,305.80 
109 4/6/2009 9:00 100.00 0.27 504,363.50 1,304.60 
110 4/6/2009 17:00 50.00 0.15 504,446.10 166.00 
111 4/7/2009 1:00 50.00 0.15 504,529.20 166.00 
112 4/7/2009 9:00 50.00 0.15 504,613.20 166.00 
113 4/7/2009 17:00 150.00 0.38 506,921.20 3,661.30 
114 4/8/2009 1:00 150.00 0.38 509,215.40 3,665.50 
115 4/8/2009 9:00 150.00 0.38 511,507.20 3,670.60 
116 4/9/2009 9:00 50.00 0.15 511,761.40 167.20 
117 4/10/2009 9:00 50.00 0.15 512,015.60 167.90 
118 4/11/2009 9:00 50.00 0.15 512,273.30 167.90 
119 4/12/2009 1:00 10.00 0.03 512,273.30 0.00 
120 4/12/2009 17:00 10.00 0.03 512,273.30 0.00 
121 4/13/2009 9:00 10.00 0.03 512,273.30 0.00 
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122 4/13/2009 17:00 100.00 0.27 513,078.70 1,316.20 
123 4/14/2009 1:00 100.00 0.27 513,891.60 1,318.60 
124 4/14/2009 9:00 100.00 0.27 514,701.60 1,321.50 
125 4/15/2009 17:00 50.00 0.15 515,046.10 168.20 
126 4/17/2009 1:00 50.00 0.15 515,394.10 168.60 
127 4/18/2009 9:00 50.00 0.15 515,745.50 168.80 
128 4/19/2009 1:00 10.00 0.03 515,745.50 0.00 
129 4/19/2009 17:00 10.00 0.03 515,745.50 0.00 
130 4/20/2009 9:00 10.00 0.03 515,745.50 0.00 
131 4/21/2009 1:00 50.00 0.15 515,920.20 168.10 
132 4/21/2009 17:00 50.00 0.15 516,095.70 168.50 
133 4/22/2009 9:00 50.00 0.15 516,271.40 169.00 
134 4/22/2009 17:00 100.00 0.27 517,091.80 1,327.50 
135 4/23/2009 1:00 100.00 0.27 517,892.80 1,329.90 
136 4/23/2009 9:00 100.00 0.27 518,702.40 1,327.80 
137 4/23/2009 17:00 50.00 0.15 518,790.00 169.20 
138 4/24/2009 1:00 50.00 0.15 518,875.70 169.50 
139 4/24/2009 9:00 50.00 0.15 518,961.70 169.30 
140 4/25/2009 1:00 10.00 0.03 518,961.70 0.00 
141 4/25/2009 17:00 10.00 0.03 518,961.70 0.00 
142 4/26/2009 9:00 10.00 0.03 518,961.70 0.00 
143 4/27/2009 1:00 50.00 0.15 519,133.30 168.70 
144 4/27/2009 17:00 50.00 0.15 519,308.30 168.90 
145 4/28/2009 9:00 50.00 0.15 519,483.30 168.70 
146 4/30/2009 1:00 10.00 0.03 519,483.30 0.00 
147 5/1/2009 17:00 10.00 0.03 519,483.30 0.00 
148 5/3/2009 9:00 10.00 0.03 519,483.30 0.00 
149 5/3/2009 17:00 50.00 0.15 519,570.00 169.20 
150 5/4/2009 1:00 50.00 0.15 519,656.70 169.70 
151 5/4/2009 9:00 50.00 0.15 519,744.70 169.70 
152 5/5/2009 1:00 100.00 0.27 521,398.90 1,323.80 
153 5/5/2009 17:00 100.00 0.27 523,095.90 1,324.00 
154 5/6/2009 9:00 100.00 0.27 524,787.60 1,325.30 
155 5/6/2009 17:00 50.00 0.15 524,878.80 169.50 
156 5/7/2009 1:00 50.00 0.15 524,966.50 169.60 
157 5/7/2009 9:00 50.00 0.15 525,053.30 169.70 
158 5/7/2009 17:00 10.00 0.03 525,053.30 0.00 
159 5/8/2009 1:00 10.00 0.03 525,053.30 0.00 
160 5/8/2009 9:00 10.00 0.03 525,053.30 0.00 
161 5/9/2009 1:00 50.00 0.15 525,224.40 169.20 
162 5/9/2009 17:00 50.00 0.15 525,395.10 169.40 
163 5/10/2009 9:00 50.00 0.15 525,565.10 169.00 
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164 5/12/2009 1:00 10.00 0.03 525,565.10 0.00 
165 5/13/2009 17:00 10.00 0.03 525,565.10 0.00 
166 5/15/2009 9:00 10.00 0.03 525,565.10 0.00 
167 5/15/2009 17:00 50.00 0.15 525,649.20 169.00 
168 5/16/2009 1:00 50.00 0.15 525,733.30 169.00 
169 5/16/2009 9:00 50.00 0.15 525,817.90 169.50 
170 5/17/2009 1:00 10.00 0.03 525,817.90 0.00 
171 5/17/2009 17:00 10.00 0.03 525,817.90 0.00 
172 5/18/2009 9:00 10.00 0.03 525,817.90 0.00 
173 5/19/2009 1:00 50.00 0.15 525,987.60 170.00 
174 5/19/2009 17:00 50.00 0.15 526,159.20 170.00 
175 5/20/2009 9:00 50.00 0.15 526,331.10 170.00 
176 5/21/2009 17:00 10.00 0.03 526,331.10 0.00 
177 5/23/2009 1:00 10.00 0.03 526,331.10 0.00 
178 5/24/2009 9:00 10.00 0.03 526,331.10 0.00 
179 5/25/2009 9:00 50.00 0.15 526,591.00 170.00 
180 5/26/2009 9:00 50.00 0.15 526,852.60 170.30 
181 5/27/2009 9:00 50.00 0.15 527,115.60 171.00 
182 5/29/2009 9:00 10.00 0.03 527,115.60 0.00 
183 5/31/2009 9:00 10.00 0.03 527,115.60 0.00 
184 6/2/2009 9:00 10.00 0.03 527,115.60 0.00 
185 6/2/2009 17:00 100.00 0.27 527,893.90 1,340.60 
186 6/3/2009 1:00 100.00 0.27 528,665.90 1,340.40 
187 6/3/2009 9:00 100.00 0.27 529,439.10 1,334.90 
188 6/4/2009 9:00 10.00 0.03 529,439.10 0.00 
189 6/5/2009 9:00 10.00 0.03 529,439.10 0.00 
190 6/6/2009 9:00 10.00 0.03 529,439.10 0.00 
191 6/6/2009 17:00 50.00 0.15 529,522.90 170.60 
192 6/7/2009 1:00 50.00 0.15 529,607.00 170.00 
193 6/7/2009 9:00 50.00 0.15 529,691.50 169.90 
194 6/7/2009 17:00 100.00 0.27 530,487.70 1,322.30 
195 6/8/2009 1:00 100.00 0.27 531,276.10 1,318.70 
196 6/8/2009 9:00 100.00 0.27 532,078.20 1,315.50 
197 6/9/2009 1:00 50.00 0.15 532,254.30 168.70 
198 6/9/2009 17:00 50.00 0.15 532,427.80 168.20 
199 6/10/2009 9:00 50.00 0.15 532,601.80 166.80 
200 6/15/2009 1:00 10.00 0.03 532,601.80 0.00 
201 6/19/2009 17:00 10.00 0.03 532,601.80 0.00 
202 6/24/2009 9:00 10.00 0.03 532,601.80 0.00 
203 6/25/2009 1:00 50.00 0.15 532,775.40 166.00 
204 6/25/2009 17:00 50.00 0.15 532,950.30 166.10 
205 6/26/2009 9:00 50.00 0.15 533,126.40 166.50 
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206 6/28/2009 17:00 10.00 0.03 533,126.40 0.00 
207 7/1/2009 1:00 10.00 0.03 533,126.40 0.00 
208 7/3/2009 9:00 10.00 0.03 533,126.40 0.00 
209 7/7/2009 17:00 50.00 0.15 534,216.50 167.60 
210 7/12/2009 1:00 50.00 0.15 535,312.80 169.60 
211 7/16/2009 9:00 50.00 0.15 536,421.20 170.30 
212 7/30/2009 9:00 10.00 0.03 536,421.20 0.00 
213 8/13/2009 9:00 10.00 0.03 536,421.20 0.00 
214 8/27/2009 9:00 10.00 0.03 536,421.30 0.00 
215 8/30/2009 1:00 50.00 0.15 537,110.10 173.10 
216 9/1/2009 17:00 50.00 0.15 537,801.20 173.60 
217 9/4/2009 9:00 50.00 0.15 538,491.30 173.50 
218 9/4/2009 17:00 150.00 0.38 540,679.70 2,631.80 
219 9/5/2009 1:00 150.00 0.38 542,929.10 2,566.70 
220 9/5/2009 9:00 150.00 0.38 545,217.10 2,662.40 
221 9/11/2009 9:00 10.00 0.03 545,217.10 0.00 
222 9/17/2009 9:00 10.00 0.03 545,217.10 0.00 
223 9/23/2009 9:00 10.00 0.03 545,217.10 0.00 
224 10/4/2009 17:00 50.00 0.15 547,472.60 119.40 
225 10/16/2009 1:00 50.00 0.15 549,780.00 131.20 
226 10/27/2009 9:00 50.00 0.15 552,201.40 138.30 
227 10/29/2009 1:00 100.00 0.27 555,664.60 1,148.90 
228 10/30/2009 17:00 100.00 0.27 559,209.20 1,171.30 
229 11/1/2009 9:00 100.00 0.27 562,738.10 1,223.20 
230 11/1/2009 17:00 10.00 0.03 562,738.10 0.00 
231 11/2/2009 1:00 10.00 0.03 562,738.10 0.00 
232 11/2/2009 9:00 10.00 0.03 562,738.10 0.00 
233 11/3/2009 9:00 100.00 0.27 565,027.80 1,274.40 
234 11/4/2009 9:00 100.00 0.27 567,331.10 1,302.10 
235 11/5/2009 9:00 100.00 0.27 569,638.60 1,311.80 
236 11/6/2009 9:00 50.00 0.15 569,897.90 167.20 
237 11/7/2009 9:00 50.00 0.15 570,162.20 167.50 
238 11/8/2009 9:00 50.00 0.15 570,428.40 167.20 
239 11/9/2009 1:00 150.00 0.38 574,677.30 3,656.10 
240 11/9/2009 17:00 150.00 0.38 578,844.60 3,636.10 
241 11/10/2009 9:00 150.00 0.38 583,014.10 3,631.10 
242 11/10/2009 17:00 400.00 0.75 597,183.80 23,228.50 
243 11/11/2009 1:00 400.00 0.75 610,235.40 25,522.20 
244 11/11/2009 9:00 400.00 0.75 623,503.20 24,218.60 
245 11/12/2009 1:00 450.00 0.81 653,536.30 29,695.60 
246 11/12/2009 17:00 450.00 0.81 683,593.40 29,096.50 
247 11/13/2009 9:00 450.00 0.81 713,730.30 29,270.90 
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248 11/14/2009 9:00 500.00 0.86 759,935.00 33,104.90 
249 11/15/2009 9:00 500.00 0.86 804,827.00 32,682.80 
250 11/16/2009 9:00 500.00 0.86 849,528.10 33,903.80 
251 11/16/2009 17:00 200.00 0.47 852,817.30 4,087.80 
252 11/17/2009 1:00 200.00 0.47 856,467.90 4,476.30 
253 11/17/2009 9:00 200.00 0.47 860,208.10 4,903.50 
254 11/18/2009 17:00 100.00 0.27 862,919.10 948.80 
255 11/20/2009 1:00 100.00 0.27 865,702.50 1,024.60 
256 11/21/2009 9:00 100.00 0.27 868,606.60 1,083.30 
257 11/22/2009 1:00 50.00 0.15 868,769.80 138.00 
258 11/22/2009 17:00 50.00 0.15 868,936.10 139.00 
259 11/23/2009 9:00 50.00 0.15 869,103.30 140.00 
260 11/24/2009 9:00 100.00 0.27 871,468.80 1,135.50 
261 11/25/2009 9:00 100.00 0.27 873,854.00 1,169.80 
262 11/26/2009 9:00 100.00 0.27 876,200.60 1,207.50 
263 12/1/2009 17:00 50.00 0.15 877,446.50 156.80 
264 12/7/2009 1:00 50.00 0.15 878,661.90 160.10 
265 12/12/2009 9:00 50.00 0.15 879,912.20 163.70 
266 12/13/2009 1:00 10.00 0.03 879,912.20 0.00 
267 12/13/2009 17:00 10.00 0.03 879,912.20 0.00 
268 12/14/2009 9:00 10.00 0.03 879,912.20 0.00 
269 12/14/2009 17:00 50.00 0.15 879,994.40 166.00 
270 12/15/2009 1:00 50.00 0.15 880,078.30 166.00 
271 12/15/2009 9:00 50.00 0.15 880,163.10 165.00 
272 12/15/2009 17:00 100.00 0.27 880,949.80 1,293.10 
273 12/16/2009 1:00 100.00 0.27 881,726.10 1,292.80 
274 12/16/2009 9:00 100.00 0.27 882,506.90 1,289.80 
275 12/16/2009 17:00 50.00 0.15 882,590.40 164.50 
276 12/17/2009 1:00 50.00 0.15 882,674.80 165.00 
277 12/17/2009 9:00 50.00 0.15 882,759.80 165.40 
278 12/18/2009 1:00 100.00 0.27 884,382.10 1,287.70 
279 12/18/2009 17:00 100.00 0.27 886,049.00 1,293.90 
280 12/19/2009 9:00 100.00 0.27 887,715.00 1,304.40 
281 12/19/2009 17:00 150.00 0.38 890,050.60 3,687.90 
282 12/20/2009 1:00 150.00 0.38 892,353.20 3,711.60 
283 12/20/2009 9:00 150.00 0.38 894,676.20 3,714.70 
284 12/20/2009 17:00 300.00 0.62 903,421.00 12,674.90 
285 12/21/2009 1:00 300.00 0.62 911,793.60 14,011.60 
286 12/21/2009 9:00 300.00 0.62 920,117.90 15,345.90 
287 12/22/2009 1:00 150.00 0.38 924,188.10 3,467.40 
288 12/22/2009 17:00 150.00 0.38 928,392.20 3,550.50 
289 12/23/2009 9:00 150.00 0.38 932,533.30 3,598.10 
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290 12/23/2009 17:00 200.00 0.47 936,577.90 6,961.20 
291 12/24/2009 1:00 200.00 0.47 940,703.80 6,970.70 
292 12/24/2009 9:00 200.00 0.47 944,839.50 6,982.60 
293 12/24/2009 17:00 150.00 0.38 947,084.60 3,633.20 
294 12/25/2009 1:00 150.00 0.38 949,334.60 3,643.10 
295 12/25/2009 9:00 150.00 0.38 951,601.10 3,653.70 
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